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Chapter 1 – Introduction to Excel 2019 Advanced Course
Video: Prerequisites of the Course and Version of Excel
Deborah: Hello and you’re very welcome to our course on Microsoft Excel 2019 Advanced. My
name’s Deborah and I’m your instructor on this course.
Now I’ve been using Excel for over 20 years and during that time I’ve used a number of different
versions of Excel in my role as a MOS Certified IT trainer and Microsoft subject matter expert.
I’ve been involved in a number of large scale projects that utilize Excel and Excel is used widely
across different industries and business, in particular finance but Excel has a much wider reach
than that. Many people use it at home to help manage household budgets and personal finances
also.
Now it is true to say that whilst applications like Google Sheets are becoming more and more
popular Excel is still the most widely used spreadsheet software in the world. And Excel 2019 is
the latest on premise release from Microsoft and it differs from Office 365 by the way that it’s
not a subscription offering.
Office 2019 is a one time purchase desktop application for those who haven’t chosen to
subscribe to Office 365 and who prefer to purchase the software and essentially own the software
on their PC. I like to liken it to property. So Office 365 is for renters. You pay a monthly fee to
rent the software from Microsoft and Office 2019 is like purchasing a house. You buy it once
and it’s yours forever.
Now with that in mind if you’re coming to this course having used Office 365 previously you’re
probably not going to notice too much of a difference at all. All of the updates to Excel 2019
have been available in Office 365 for a while. However if you’re coming to Excel 2019 from a
much older version there will be lots of new stuff in this course for you to sink your teeth into.
Now in this first section I need to cover a little bit of housekeeping. I need to make you aware
that this is not a beginner course. This is an advanced course. If you are a beginner in Excel then
you might want to take a look at our beginner’s course on our website. If you’ve used a much
earlier version of Excel, let’s say before 2007 but you’re a pretty advanced user you probably
should still go through at least some of the elements of our basic course to get up to speed with
the Ribbon and some of the more recent developments in Microsoft Excel. If you are an
accomplished user of 2007 or certainly Excel 2010, 2013 or 2016 you probably have a good
enough foundation to cover this course.
I’m not going to repeat a lot of the basic information in this course but I will occasionally do a
quick summary of what I’m expecting you to know. If I do a do quick summary at the beginning
of the section and you think to yourself, “Hmm. I didn’t know that” you can always go back to
the basic course and review the information that you’re not familiar with.
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Now one important aspect of this is that throughout the life of Excel many of the basic aspects of
it haven’t really changed that much. The Ribbon was introduced in 2007 but a lot of the basic
aspects of what Excel actually does as a spreadsheet package haven’t changed a great deal since
the very beginning. However, many things have been added and in areas such as Charts and
Graphs if you’re only familiar with an older version of Excel you’re probably going to be quite
amazed at the different types of charts you can build and the things that you can do.
Another thing I want to talk to you about is the version of Excel that this course is based on. This
course is entirely based on the installed version of Excel 2019 desktop application.
Now as I mentioned previously Excel 2019 or Office 2019 differs from Office 365 by the way
that it’s not a subscription. So if you want Excel 2019 or Office 2019 you will need to download
it. And I would refer you to this page on the Microsoft Support site which goes through the
instructions of how you can actually install Office 2019 on a PC or Mac. And I would pay
particular attention to the information that we have in the gray box just here.
Another thing I’d like to mention is that this course will be completed almost exclusively using a
keyboard and a mouse. We won’t be using touch mode at all. Now touch mode works very well
in Excel now on a tablet device. So it might be that you want to work through this course using
touch and that’s entirely up to you. The instructions for enabling touch mode in Excel 2019 are
basically the same as enabling touch mode in Excel 2016 or Excel 2013. And there is a page on
Office.com that you can see here explaining how to do this. It only covers Excel 2013 but as I
said it’s pretty much the same process for Excel 2019.
The last point I need to make here is that although I’m based in the UK I’m going to be using
U.S. locale throughout this course. And this will include not only U.S. dollars as the currency but
also adopting things like U.S. data format and the U.S. Spellchecker. If you want to work along
with me as closely as possible then you may want to adopt that approach too. However, if you
would prefer to use your own locale, your own currency, your own date and time then you
should be able to adapt all of the workbooks that I’m providing you with so that you can work
with them using your own settings.
Now as this is an advanced course I’m going to assume you know where in the settings you need
to set these things up. But for example, if I click on Language as I have here, you’ll see that I
usually work with two languages, English United States and English United Kingdom. For the
purpose of this course English United States is going to be my default.
So that’s an introduction to the course. I am of course assuming now that you have Excel 2019
installed and ready to use. In the next section I just need to run through with you the course
materials supplied with the course and just explain that in the light of the structure of the course.
That’s where we’re going to next. I’ll see you there.
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Video: Course Structure
Deborah: Hello again and welcome back to our course. In this video I’m going to talk a little bit
about the structure of the course and give you some important information about how best to
follow the course.
Now first of all this course should ideally be covered in sequence and I have prepared the course
on that basis. However, this is an advanced course and if you need to cover a topic that’s later on
in the course right away there shouldn’t be any reason why you can’t do that. I’ve tried to make
the parts of the course as standalone as possible and each of them should have limited reference
to earlier parts of the course, but you can go back if you need to.
The course is arranged into chapters and each chapter comprises one or more sections. Each
section consists of a single video and typically a single video is 15 minutes or less in length.
Possibly one or two of them are slightly longer but I try not to go too much over 15 minutes.
Now apart from the videos themselves there is a folder containing the course files and this has
most of the files that I use during the course so that if you want to work along with me or try a
variation of what I’ve done then you have access to those files here.
Some of the very small simple workbooks are not included but where the workbook has any
significant content I’ve tried to include it in this folder. I suggest that you make sure you know
where your course files folder is and maybe take a backup copy, particularly if you’re working
along with me. You might break something and need to recover those original files.
There’s also an Exercise Files folder. In most cases this folder includes the starter point for each
exercise as well as my sample answer for the exercise as well. So once again it’s important to
know where these files are and take a backup copy of the folder.
Now for a couple of important general points. In Excel there are many ways of doing things and
in order to keep the length of the course not too long I will show you one or two ways of doing
things but I do appreciate that there are many ways to do the same thing in Excel and alternative
methods that you may prefer. So I do suggest that you experiment and find the way that suites
you most.
Now there are one or two things that I generally try to avoid and one of them in particular that
you might be surprised by is that I generally don’t use keyboard shortcuts. Now there will be a
few instances where I do and when I do I will tell you that’s what I’m doing. And the main
reason I don’t use keyboard shortcuts is that you won’t see me doing that on the screen. And
generally speaking I like to click something on the screen so you can see me doing it. And I will
often highlight or outline where I’m clicking to make it clear. Again, I do appreciate that in many
situations you’ll probably use a keyboard shortcut instead of clicking on the screen.
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One other important point, the case studies we’re going to be using in this course are very often
in quite specialized areas, such as in statistics and finance. Some of these areas might be areas
that you’re not familiar with and you might be a little concerned that I will be talking about
aspects of these that you really don’t understand. Where this might happen I will try to explain
all of the things that you need to know about a particular area or activity in order to demonstrate
and understand what’s going on. For example, you may not know a lot about finance or statistics
then I’ll explain a few key points you need to know in each situation and hopefully that will
make sense in relation to each case study.
So that’s it. That’s the outline to the course structure and a few important points to bear in mind
as we work through it. So I think it’s time to get started. And we’re going to start by taking a
look at some general aspects of the use of functions. That’s in the next section. I will see you
there.
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Chapter 2 – Functions
Video: Functions – Part 1
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to start to look at functions and we’re going to spend quite a bit of time looking at
functions as they really do form the backbone of pretty much everything that we do in Excel.
The functions have been very much the main strength of Excel since the beginning. In Excel
2019 the number of available functions has just about passed the 400 mark and I can assure you
don’t worry, we’re not going to be looking at all of them in this course but we are going to look
at quite a few of them. And really I guess the main problem with functions is the sheer number of
them. And that even if you have an idea of the function you want to use you might know what
it’s called or be able to identify easily. So in this first section I’m going to cover a few of the
basics of functions that you might be familiar with but I’m also going to try to extend that into
areas that you may not have used or seen before.
I’m also going to talk to you a little bit about how you find what you need and how to identify
not only what it does but how to use it.
The first thing I’m going to point out is that there is a really good Help topic on functions in
Excel 2019 that’s a pretty good reference point to find out all the information you need about
functions. And here is that Help topic, Excel Functions by Category.
Let’s go into a particular category, like Logical Functions, and within the list of logical functions
some of the functions have a little year number underneath them. So for example, you can see
the If S function is only available in Excel 2016.
If you drill down a bit further into the function by clicking you’ll find a description of what the
function does. There will also be some technical details. That includes information about the
arguments, which ones are required and optional, information about the data types and so on.
And then generally one or more examples of the use of that function.
You also get at the bottom sometimes some common problems that you might encounter and
typical errors that you get and explanations to how to correct those errors that may have
occurred. So this is all very useful if you’re looking for a little bit more information about a
specific function.
Now something that isn’t mentioned here but is important is that some of the functions in Excel
have been improved or advanced and in some cases give what is usually more accurate results
than they used to. So if you have any legacy systems based on Excel or macros you might find
that the results are more accurate than they used to be.
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There are some other useful links towards the bottom of this page but there’s also a link here to
the Excel Functions listed in alphabetical order. And there they are.
And a couple of other things worth bearing in mind is that you can buy or sometimes get for free
functions from third parties. Of course you could always write your own. Both of these are
outside the scope of this course but are well worth bearing in mind for future reference.
What I’m going to do now is a very quick demo of a simple function and I’m going to point out
some of the key features that you’re probably familiar with but possibly a couple of things that
you’re also not familiar with. So let’s start out with a very simple job and just add up these four
numbers.
If I want to total some numbers, as I do here, I can enter a formula anywhere on this sheet. On
this occasion I’m going to write it directly under the list of four numbers. I start with an equal
sign and I’m going to use the Sum function. Now if I hit S it’s going to give me a list of all the
functions that begin with S. Now if I hit U it narrows that list down to all the of the functions that
begin with SU. And of course the one I want on this occasion is Sum. So I’m going to select it by
double clicking and you’ll see that not only do I get rest of the name of the function but I get the
first parentheses. And within the parentheses I’m going to need to enter some arguments. And in
the list of arguments you’ll see the bold arguments are mandatory. So I must have at least one
number in here. And then the nonbold arguments indicated also here by square brackets are
optional arguments.
As you can see in the standard definition of the Sum function the arguments are also separated
by commas. So whatever the function, even in functions that have no arguments you’ll need to
use parentheses. And we’ll look at an example of that in a moment.
In those arguments I don’t have to put cell references. I could put actual constants. So I could
put, for example, SUM and then I could type a 6 and then when I put a comma in you will see
that Excel is telling me that the next argument is mandatory as it’s highlighted in bold. I could
then add 8, comma, 10, so on and so forth. And it continues until I close those parentheses.
When I’ve finished entering the argument I can either hit Enter or I can tick the tick on the
formula bar and I’m going to hit the Enter key and I have my total there of 23.
The way I have Excel set up is when I hit the Enter key the cursor moves down to the cell below
the one where I’ve just entered the formula.
And now you can see the full formula in the formula bar using the Sum function and constants.
If instead of using constants for the argument I want to use cell references, so I want to sum the
contents of cell D2, D3, D4, and D5 I can use those cell references instead of the constants. So I
could enter my formula equals, Sum, open bracket, select the first cell reference, comma, second
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cell reference, comma, third cell reference, comma, and then finally and it’s underneath there,
the last cell reference, close the parentheses and hit the Enter key to give me an answer of 75.
So listing the cell references is one possibility. The other possibility of course is to specify a
range. So instead of listing all of those cells separated by a comma I could use a range of cells
instead. And the way that you can indicate a range is by using a colon between the start cell in
the range and the end cell in the range. So let’s do this formula again.
I’m going to delete out and this time we’re going to use the range. So equals, Sum, open bracket,
and I’m just going to drag my mouse down to select the range. Oh, hang on. I think I’ve gone
one too far there so I’m going to make a quick edit, D5, close my parenthesis and hit Enter and I
get the same result.
Now I’m not restricted to using values just on this worksheet alone. I have a second range
located on Sheet3. Let’s go back to Sheet2 and I’m going to double click and I’m just going to
remove my cell range or delete it out.
So what I can do now is jump across to Sheet3 and select the cell range just by highlighting E3 to
I3 and then if I hit Enter you’ll see I get the total of 68. Let’s take a closer look at what exactly
that function is doing. So if we double click so we can see it and you can see it gives the sheet
name, so Sheet3. It then gives an exclamation point or a bang as I like to call them and then it
shows the cell range that we’ve actually selected that’s located on that particular sheet.
There is also nothing to stop me adding the values in cell range D2 to D5 on this sheet to the
values in the range E3 to I3 on Sheet3, which will give me a big, grand total. So I’m going to go
up to the formula bar this time to edit and I’m just going to click before where it says Sheet3. I’m
then going to highlight cells D2 to D5, put in a comma, and I’m going to click the tick this time
instead of hitting Enter and there we go. That gives me a nice answer. All those totals together of
143.
Now partly because of the flexibility within the use of formulae in Excel there are rules that you
need to stick to, such as you don’t have any spaces between function names and parentheses. So
if I was just to add one in here by just adding a space and then clicking on the tick to accept it
you’ll see that Excel pops up an error. And it says we found a typo in your formula and it’s tried
to correct it. And I can just double check to make sure that it’s corrected it correctly, which in
this case it has. And Excel is pretty clever is like that. It can normally work out most of the time
what you’re trying to do and provide you with a suitable correction. So I’m going to say Yes to
accept this correction and my formula is working again.
Now I mentioned earlier that even if a function has no arguments you still need to put it in
parentheses. So let’s look at an example of that.

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved.

Learn Excel 2019 Advanced
So for example, I want to work out the value of Pi so I’m going to enter in equals and I’m going
to type Pi into my cell and you can see there, I just want to draw your attention to that screen tip
that’s popped up. So it says Returns the value of Pi and then it gives me that value of Pi accurate
to 15 digits.
If I click on the tick it will produce an error. So in this case I’m getting a name error. And you
should notice a little marker in the corner there to indicate that there is an error. So if I click it
and see what my options are it’s picked up that it’s invalid name error. I could also go to Help on
this error, show calculation steps, ignore error, edit it in the formula bar, or I can go and modify
my error checking options.
Now this formula contains unrecognized text and it’s given me a link through to the invalid name
error. So I know that there is a problem with the name. So let’s go and edit it in the formula bar.
So I’m going to click up here and this is where I need to add my empty parentheses. So I’m
going to add them in like so. And now when I click on the tick you can see that that formula is
now working and it’s accurate specifically to the format of that particular cell.
The other thing to bear in mind is that you can also nest functions. So if I wanted to add the value
of Pi to the sum of my numbers over here I could do that. So I’m going to go up to the formula
bar again and I’m just going to click within my formula at the end there. I’m going to add
comma, I’m going to add Pi, and I’m going to do my parentheses. And remember when closing
off parentheses you always need to close as many as you’ve opened. And now when I hit Enter I
have my new total of 146.142, and I could change that by just taking down the decimal places or
increasing those decimal places if I wanted to.
One other feature which you may have noticed is the use of color coding to make it easier to
identify arguments on a worksheet. In this case it won’t be particularly helpful but later on in
some of the case studies this color coding can make your life so much easier. So let’s take a look
at it.
I’m just going to double click in my cell and I’m actually going to remove the majority of what
I’ve put in here, just delete that out. And I’m going to type the cell reference D2 and you’ll see it
highlights it so we have a dark blue border with some blue shading. If I do comma, D3 you’ll see
it highlights the next one and it highlights it in the formula that you’re typing and on the actual
worksheet. And it will carry on if I type in D4. We get a highlight in a different color.
In the next section we’re going to continue to look at functions in general, but focus on some of
the more sophisticated utilities, such as the use of the Functions dialog box. So I will meet you
there.
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Video: Functions – Part 2
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to be looking at functions in general and I want to look first at tools that help you
find the functional functions that you need.
Now let’s take a particular example and I know that I need a standard deviation function and
that’s a statistical function. If you look at the Formulas tab you’ll see the Function Library group
and some of the most commonly used categories of function. So you have Financial, Logical,
Text, Date & Time, so on and so forth. Note also there is a category called Recently Used and if
you use a fairly restricted set of functions that’s actually quite a good feature because it makes it
more likely that the function you want has been used recently. And you can see there the top
three functions that I’ve last used.
If you look at the other end of the group there’s a More Functions dropdown. More Functions
gives you access to other categories and one of them is Statistical. The flyout list lists all of the
available statistical functions.
Now it’s worth noting that with each of these as you hover over them you’ll get a screen tip
about that particular function. And underneath that screen tip there is a link to Help. So what you
might do knowing that you need a statistical function is scroll through the list and try and find
the function that you need.
Now if you didn’t find it it might be because you didn’t know the name. Now there is another
option and that is to click on the Insert Function button. The Insert Function dialog here has the
category field preselected at Statistical because I was looking at this before I invoked it.
There’s another way of invoking the Insert dialog box and that is where you can invoke it by
using the fx button on the formula bar.
So once I’ve invoked the Insert Function dialog box I have access to the same list of functions,
that Statistical functions that we were looking at previously.
There are a couple of important differences using this dialog. Notice that as I click on each of
these functions I will see an equivalent of the screen tip information underneath. I also have a
link through to Help on this function. This will open an external window and give me the
information that I need about the specific function.
Another big advantage of the Insert Function dialog box is that if you don’t know the name of
the function that you want you can use the Search facility. Now I know I need standard deviation
so I’m going to type into the Search box Standard Deviation and click Go. And this brings me up
a list of functions that in some way involve standard deviation.
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The first one is STDEV. That’s the old standard deviation function and as you can see there from
the text underneath the list this function is available for is compatible with Excel 2007 and
earlier.
Then we have the current standard deviation options. This one is for calculating a standard
deviation on a sample. And we have various other functions for calculating standard deviation.
So what I’m going to do here is calculate the standard deviation of numbers in cells A1 to A7
and I’m going to put the result in D4. So let’s invoke the Insert Function dialog box and I’m
going to search for Standard Deviation again. And I know that the one that I want to use is this
one just here.
So now I can see my Function Arguments dialog and this is a useful dialog not only because it
will remind you of the arguments you need but it can also help you enter the arguments for the
function. So you can not only type arguments in but you can make selections on a worksheet to
form the arguments for the function.
The cursor is flashing in the first argument field and I could type in there the first number from
the list. So in this case the number that we have in cell A1. I could also put lists of numbers or
ranges, for example. Note the prompt on the right there that tells me a number is expected but if
as in this case the numbers are adjacent I can also select the range of numbers. And now you can
see that my first argument is a range.
If I wanted to add a second range I could put that in as number two or I could put a comma in
between number one and put an additional range in there as well. So it’s very flexible.
Now the Functions Arguments dialog gives me a preview of the formula result and I can just
click on OK and there is my standard deviation.
Now there is another feature that can be very useful and that’s a feature called Formula Auto
Complete. Now in order for this to work you need to make sure your options are set correctly.
The option you need is on the Formulas page in the Working with Formulas section, second
option down, Formula Auto Complete. And as the screen tip shows it shows a list of relevant
functions and defined names when building cell formulas. This functionality can be enabled or
disabled by using the keyboard shortcut Alt plus down arrow when in Formula Editing mode.
Now the reason for giving you that straightforward shortcut is that this function can be both
helpful but a little annoying as well. So let’s suppose that I’m going to put a formula into D4
that’s going to involve one of the amortization functions. I can type in equals to start the formula
and as soon as I type in A I get a list of the functions that start A. You can actually move this
little screen tip out of the way just by clicking and dragging if you’re finding that a little bit
annoying.
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Now let’s say I know it’s AM and I decided it’s probably the first one so when I double click not
only do I get the arguments for that function but the function itself has a link to a Help file with
more information on that particular function. This will give me a full explanation of the function
and usually some examples. So that can be really helpful if you’re trying to work out if this is
actually the correct function.
Depending on the arguments as you start to type in the value, so let’s say the first value I want is
Cost and let’s assume it’s $3,000. Not only does the next argument in the list get highlighted but
if it’s possible what the Formula Auto Complete will do will offer me options or recognize what
I’m typing in that particular argument.
Now my next argument is Date Purchased and in this case Excel won’t be able to recognize
which date I’m going to use, but if this was a name I was typing in it would be able to react to
what I was typing to help me identify the name that I want to include.
Other than that I carry on entering my arguments. Remember optional arguments are in the
square brackets. And that’s it. That’s Formula Auto Complete.
Now in these first two sections I’ve introduced you or recapped for you some of the key features
for using functions in Excel 2019. In the next section I’m going to look at the AutoSum
Functions as they have some rather important and unusual features that’s worth knowing about.
And in subsequent sections of the course as we use some of these functions you’ll see some of
these features I’ve been talking about in action. But that’s it for this section so I’ll see you in the
next one.
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Video: AutoSum
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. We’ve been
looking at functions for the last couple of sections and in this section I’d like to look at the
AutoSum functions, which you’ve probably used before but you might not be aware of some of
the aspects of their use. Let me show you what I mean.
Let’s suppose I wanted to add the numbers in column B. Now you might be temped to select the
numbers in column B and then insert the AutoSum function as part of the formula in B6, but in
fact you don’t need to select the numbers first. If you just click below the column and then go up
to the Ribbon, either the Home tab or the Formulas tab, I’m going to select Home, and the
AutoSum feature is available on both.
So if I click AutoSum you can see that Excel 2019 picks up the numbers listed above and if I just
click the Tick to Confirm and I get my total.
Now if instead of doing that I selected those first four cells and it’s worth noting that I haven’t
selected B6 in this case and then click on the AutoSum button it gives me the same result.
It’s also worth noting that if I select cell B2 all the way down to B6 and click on the AutoSum
button I get the same result once again.
Now let me undo that so I’m going to click the Undo button on my Quick Access Toolbar. Now
this time what I’m going to do is select the cells from B6 to C6 and click AutoSum. In this case it
can sum both of those columns. It puts the formula in B6 for column B and in C6 for column C.
Now this doesn’t just work for columns. If I wanted to deal with rows, let’s click in G2 and
AutoSum, I get the sum from B2 to F2. So it works on rows as well.
Now let’s delete the contents of cell F5 and let’s look at what would happen if I click the
AutoSum button. The answer it gives is the sum from F2 to F4. When AutoSum has the option of
dealing with columns or rows it always give precedents to the columns.
So you might be interested to see what happens if I select cells B2 to B5 and click on AutoSum.
Notice the column totals I get. And of course another way to sum totals that I don’t want you to
forget about is if we make a selection, so C2 to C5, and use the Quick Analysis popup, we have a
Totals tab where we can access the Sum function as well. So when I click that you’ll see it also
puts in my total in cell C6.
And what if I select cells B2 to G6 and click AutoSum. I get all of the totals. And the 150 in the
bottom right hand corner is of course is the sum from B6 to F6.
Another important point here is that Excel 2019 is pretty good at identifying entities that aren’t
part of what you’re trying to do. So for instance, if in B1 I had a header, so let’s pretend that
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these are figures for different months of the year and I’m just going to AutoFill that across. Now
if I wanted to sum B2 to B5 by clicking AutoSum that’s no problem. Excel realizes that B1 is not
part of this and will discard it.
In fact if I select B1 to B5 and click AutoSum Excel 2019 can cope with that as well.
The other point I’d like to make here is that so far I’ve been dealing with Sum functions only, but
of course the same is applicable if we’re doing a count or a Min or a Max or using one of the
other functions. So I’m going to click my AutoSum dropdown and I’m going to do a count.
Excel 2019 makes my selection and I hit Enter and you can see my count is now full. Let’s just
try a Max as well. And press Enter and there we have our Max.
Another point to remember here is that in a specific situation or in fact if in general you find
yourself using a specific function often, so let’s say for example in this case Max as it’s the one
we’ve just used, you also have the option of adding that to the Quick Access Toolbar which will
make it really, really easy for you to access quickly.
And there’s a really quick way of doing that. Again if we go up to the AutoSum dropdown, go
down to Max, right click and select Add to Quick Access Toolbar. And you can see there by
looking at the Quick Access Toolbar we have this little symbol on the end and if I hover over it
does a Max. So let’s just check to make sure that works. And click the icon. There we go. Looks
great. I’m going to hit Enter and there we have our Max for column D.
So that’s a few general points about the AutoSum family of functions. Now in the balance of this
course we’ll be doing a lot of work with functions and we’ll be using quite a few of these general
points as well.
That’s the end of this section. I’ll see you in the next one.
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Chapter 3 – Date and Time Functions
Video: How Date and Time Works
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to start to look at Date and Time Functions in Excel 2019. Now of course the use of
dates and times is fundamental in Excel but for many people there are aspects of dates and times
that are baffling, confusing and can cause all sorts of problems. So what I’m going to do in this
section is explain in detail how dates and times work and then look at some of the main functions
you’re going to need to be familiar with in order to handle any kind of Excel application that
requires the use of dates and times.
Now before we begin let’s start with one of the things that I think is the root of many people’s
problems with dates and times and that is ideally you will have the date and time settings on your
device set correctly before you even begin. Now I don’t mean by that that you have the correct
date and time set but I mean that you have the format set. Although there are some minor
differences in how these default settings are handled in the versions of Windows that Excel 2019
will run fundamentally the approach is the same.
You need to start by going to Control Panel and clicking on Region. And you’ll get this little
dialog box. As I said before my default language is set to English United States and in this
dropdown my selection Match Windows Display Language means that my regional settings
generally will match English United States. In the dropdown where I could choose a different
language to determine the settings, for example let’s scroll down and select English United
Kingdom my short date format will be day, month, year. Whereas if I say, and let’s go back to
our dropdown and scroll back up to the top, Match Windows display language, it is of course
month, day, year.
Now you’re probably familiar with what these little D’s and big M’s mean but I’ll come back to
those in a moment. The important thing to realize is that these are my default settings and if I
don’t change anything else, if I just insert dates, this determines how they will appear. The same
is true of time as well.
Now it may be that in a particular workbook or even a particular cell I need some different
settings and I’m sure you already know how to change the time or the date format in the cell. But
if you find that you’re always having to change the short date format and you think, “Why can’t
this be the way I want it to be?” you will most certainly need to change it in your default settings.
Changing the short date format is easy. You can click the dropdown and select a Short Date
format. And the same could be done for long date. So there are my defaults.
And very importantly down here we have some additional settings. And these give us settings for
time and date.
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Now starting with the date ones, there’s an example Short Date and Long Date. And those are
my date formats.
Not only can I choose these standard defaults but I can click in here like so and edit this if I want
to to any combination of the appropriate symbols. And you will see immediately below that there
is an explanation of what the notation means. So D or DD is the day number, DDD or DDDD is
the day of the week, M is the month, Y is the year, single M will give you a numeric month, long
string of M’s will give you the words for the month.
Also under there is a standard cut off year which determines which century is assumed if you
enter a two digit year. So if I set a year number of 67 it will assume that it’s 1967. Now again
you can change that cutoff year if you want to and you can also change the first day of the week,
which I currently have set to Sunday.
Note the Reset button in the bottom right hand corner.
Now you have a similar set of options for time and an explanation of what those abbreviation
symbols mean.
Now the first thing you need to do before you start dealing with dates and times is to make sure
that you know how these are set and that you are happy with how they’re set. And the second
thing is that when you are working in Excel if you’re annoyed with the fact that you don’t get the
right defaults this is the starting point for setting those defaults.
Now following on from that explanation you might want to take a look at the Help page either
from within Excel 2019, I’ve brought it up in the side pane just here, or on Office.com. And I
searched for Formatted Date the way you want. This basically explains how to set date formats,
how to set custom date formats and so on. I’m not covering these formats on this course because
I’m assuming you’re already fairly familiar with these but if you do have any uncertainty then
this is a good page to look at.
So let’s start doing some things with dates and times. Let’s put a date in cell F5 and I’m going to
put 06/11/78 and hit Enter. So that’s June the 11th 1978. Note that because I only entered the two
digit year it became 1978 because of that cutoff earlier on. Let’s go back into that cell now and
change the cell format. So right click, Format Cells, and I’m going to change it to Number
Format with no decimal places and click OK. So it now becomes a number, 28652. Now this is
something that tends to confuse people. A date in Excel 2019 when formatted as numbers is the
number of days since the first of the 1st 1900. Now when you look at a date in an Excel
worksheet what you’re looking at is a representation of a whole number. In fact times are stored
as fractions of a day. So midday on that date would be 28652.5, 6 a.m. would be 28652.25, so on
and so forth.
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One of the things that Excel is pretty good at is recognizing dates and times. If I start with a new
cell, so H6, and I’m just going to check the formatting on that cell by going to Format Cells and I
can see that has General formatting applied. So no specific format. So let’s put in here 10-Aug
and hit Enter. You can see that Excel has looked at that and decided it’s probably a date so it’s
changed the format of the cell and we can just double check that. So right click and Format Cells
and you can see here it’s selected Custom with this format just here, D-MMM. Now if I change
this back to General format and click on OK I can see that Excel has correctly stored that as a
date. And that’s the number of days in question since the 1st of January 1900.
But what about dates and times? Let’s put in a time into cell H8 of 10:30 and we’ll say a.m. and
hit Enter. Let’s check the formatting on that cell and I can see it selected Custom and it selected
Hours/Minutes with that AM/PM marker.
But what about if we want to put those two things together? So in cell H10 I’m going to combine
the two. So let’s say 10-Aug and Enter. Again Excel has realized it’s a date and time. And if I
change it to Number format and let’s give this quite a few decimal places and click OK you can
see that it’s displaying it as a fraction of a day.
However if I try and put that in a sentence and hit Enter then Excel will not recognize a date or
time combination as part of a sentence. So it’s important to understand how dates and times are
stored in Excel 2019. And it’s also important to understand that Excel will do quite a lot of work
in recognizing dates and times, but that the formatting, apart from the default formatting that
Excel will use, is largely down to you. And it’s important to understand how to use those
formatting codes to get dates and times to display the way you want them to.
It’s also important to understand the various different functions that you can use with dates and
times. For instance, you might want to use a function that will tell you a date 60 days from today
or maybe you want to find a function that will tell you what the time was two-and-a-half hours
ago. These are the types of time and date functions that we’re going to be looking at in the next
section. So please join me for that.
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Video: Basic Date and Time Functions
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at some of the most important aspects of using date and time functions in
Excel 2019. Now we’re not going to look in detail at formatting. I’m going to assume you’re
somewhat familiar with formatting, although there will be examples coming up throughout the
course but I want to take about actual date and time processing first. We’ve looked at storage in
the preceding section and as a first step in this I want to look at one of the examples we’re going
to be developing as we go through the course and that is the creation of a company invoice.
Now let’s suppose that I put an invoice date on my invoice and in fact there are two dates
associated with this invoice. That’s invoice date and due date. Now first of all one way that we
could populate the invoice date field is by using the Today function. And the Today function, as
you would expect, gives the date today.
So we just type in =Today and we have our empty parentheses. So I want you to note that this is
one of those functions that doesn’t need any arguments. Obviously I could also change the
format if I wanted to.
Now the due date could potentially be a date a certain number of days beyond that date. And one
way of doing this would be to say that the due date is 30 days after the invoice date. So how do
you find a date 30 days after the invoice date. Well, remember the invoice date will be stored as
a number of days. So in fact all I really need to do here is put a link to cell C2 and plus 30. And
we can just do a quick visual check and I can see that that does in fact look correct.
As we work through the balance of this course we’re going to continue to develop this invoice
but there are still a few points to make here about dates and times. And the first is that if I click
in C2 the definition of the date there is that it is today. Of course if I was to close this workbook
and open it again tomorrow the date in there would be tomorrow’s date, as it’s always going to
show the current date.
Now what about if you wanted to put in a static date which may well be the case with something
like an invoice? The way you put in a static date is not to use a function. You could either type
the date in to the cell or there’s a handy keyboard shortcut of Control-Semicolon and that will
input a static date into the cell.
Now apart from the Today function which gives you the current date there’s also the Now
function. The Now function gives you the time and the date right now. So let’s type in =Now and
again we have our empty parentheses because this is a function that doesn’t require any
arguments. And you can see there we’ve got our usual string of hashes which just means that we
need to widen that column ever so slightly and make a bit more room. And there you go.
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There’s also another keyboard shortcut that you could use just to input the current time into a cell
and that’s Control-Shift-Semicolon.
So it’s really worth remembering this point. C2 is dynamic and D2 is static.
So having looked at Today and Now let’s look at another important function. Let’s suppose
you’re importing some data from another system and what you have is several dates, such as the
one in D7, but they are text dates. How do you make them into dates? For example, so that you
can store them as regular dates in Excel 2019.
The function you use for that is the Date Value function. So I’m going to go up to Formulas and
I’m going to go to my Date and Time dropdown in my Functions library. And you cans see the
second one down is Date Value. And as my argument I’m going to select cell D7 and click OK.
So Excel has converted that to a number. So I can just go apply some date formatting and I’m
going to select the top one, click on OK and now I have that formatted as a short date.
The next set of Date and Time functions I’d like to look at is a set of six functions that can
separate out for me the year number, the month number, and the day number, down to the second
number of any given date and time.
I’m going to use the date in cell D4. Just bear in mind that a minute or two has now passed since
D4 was last updated. So it’s slightly out of date right now. But if in F4 I use the Year function, so
again I’m going to go up to my Date and Time and it’s right at the bottom. I’m going to select
Year. And I’m going to select cell D4 as my argument, click on OK and it pulls back 2019.
Now I invoked the Year function what actually happened is cell D4 updates. So you’ll see now
that the time has refreshed and it is now the current time. Let me do the same for month. So
again up to Date and Time and select Month. I’m going to use the same cell as my argument, cell
D4. And again watch when I click on OK. You should see that time update and there we go.
Let’s fill out the rest of them so I can show you all six. So we’re going to do up to Date and
Time, we’re going to do Day, select cell D4 again and again you’ll see this update. So those six
functions can be used to isolate the year, month, day, hour, minute, and second. Any change
made to cell values anywhere on this sheet will cause that value to be updated. So if I was just to
add a one in here you’ll see when I hit Enter everything will refresh, and there we go. And
hopefully you saw that that minute changed just there.
Now I’ve already shown you how to get a date from a text date but there is another way that you
can build dates as well. And in fact you can use a similar approach for times, and that is to use
the Date function. And what the Date function does is to build a date from three constituent
parts.
Now what I’m going to do is first invoke the Date function. So again let’s jump up to Date and
Time and Date is the top one. So I’m going to choose a year number. So let’s say 2018. I’m
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going to say the month 11 and the day 10 and click OK. Now I don’t have to use constant values
for those arguments. I could in fact use values from other cells on the worksheet. So for instance,
instead of 2018, and I’m just working up in the Formula bar now, I’m going to double click, I’m
going to delete it and I could say take the year and then specify a cell reference. So I’m going to
select cell D4 and close my parentheses. I’m going to do the same for month. So let’s delete that
out and take it from D4 and then finally we’re going to say Day and take that from D4 like so.
And there we go. Our answer in D11 replicates what we have in D2, which is correct.
Now what about if I wanted to add 30 days to the date in D11? Well all I need to do is click just
before that last parentheses and click plus 30 and hit Enter. And there we go. And we can just do
another visual check and I can see that yes that looks like it’s 30 days. And I can just do a visual
check and I can see that yes this new date in D11 is 30 days beyond the date in D2.
So we’ve looked at some very important Date and Time functions in this section. There are two
or three others I need to go through with you but we’re going to cover those in the next section.
I’ve saved this workbook into the course files folder as Date Functions 1 in case you want to go
in and have a little play around with it. So I will see you in the next section.

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved.

Learn Excel 2019 Advanced

Video: Complex Date and Time Functions
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In the
preceding section we looked at some of the basic functions associated with working with dates
and times and in this section we’re going to look at two or three of the more advanced, more
complex functions that I think you will also find useful.
Before we do that though I did mention that when it comes to building dates from individual
components there is an equivalent set of facilities for time. So just as a way of demonstrating this
let’s run through a quick example.
Now in cell B2 I have the current date and time. If I wanted to add 12 hours to that all I would
need to do would be to write =B2+0.5 and hit Enter to confirm. And I can do a quick visual
check and look and see to make sure that that is correct, which it appears to be. Note that
whenever I update something on the sheet the value of Now is updated also because it’s
dynamic.
Now suppose I wanted to add a much more unusual amount. So for example say 3 hours and 23
minutes. Well ideally what you want to do is add 3 hours and 23 minutes to the date and time in
B2. So let’s type in =B2+, now this time I can use the Time function. And you can see my
arguments underneath. So I can type in the hour which is three, comma, the minute which is 23,
comma and then the second which is zero and close off my parentheses. And I can either hit
Enter, this time I’m going to click the tick to confirm and there we go. And again I can do a
quick visual check and compare F2 to B2 and I can see that yes roughly that time looks roughly
around 3 hours and 23 minutes after.
So as you can see we have the equivalent functions that we have for building dates. Now so far
we’ve been looking at dates with no regard for working days and nonworking days. Sometimes
working days are very important. So for instance you might give someone 30 working days to
pay as opposed to 30 calendar days. Now there is a function in Excel 2019 which is the Workday
function. And the workday function can calculate the number of workdays from a given date,
either in the future or in the past. And it has an added very useful facility where it can take into
account holidays as well.
In the first instance I’m going to demonstrate it without the use of holidays. So I’m going to click
in cell D4 and I’m going to use B4 as my starting date and I’m going to look for a date which is
30 working days beyond the date in B4. So the function I need is Workday. So let’s jump up to
Date and Time and select Workday and we get our function dialog box.
So Start Date, that’s nice and easy. We’re going to select B4 and then we need to specify the
amount of days. So in this case 30. And as I said we have a third argument we could complete
for holidays. We’re not going to do that just at the moment. We will do that in a second. And
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click on OK. And again if I do a quick visual check, and you can check this yourself if you want
to make sure that it’s correct, that is roughly 30 working days in advance of the date in B4.
Now let’s take a look at this holiday feature. If you have a number of holidays, so for example
public holidays, work holidays, etcetera, then you can define those as a list of dates and Excel
2019 will take those into account when it’s doing it’s doing its calculations. Now on this
occasion I’m going to put in a few assorted holiday dates or vacation days.
Now one of the holidays where I live is the August bank holiday and I’ve also included the
Labor day holiday for good measure. So let me go back to my formula in D4. Let’s edit the
formula by jumping up into the Formula bar and just clicking before the last parentheses and I’m
going to add an additional argument. So if I do comma, it now highlights that third argument, the
holidays argument. So all I need to do now is tell Excel where my holiday dates are. So I’m
going to select my range F4 to F5 and hit enter to confirm. And you can see that mine’s jumped
forward a little bit more than that to take in account the weekend. So it’s actually brought it
across into the next week.
Now the other thing about the Workday function is that you can have a negative value for the
number of days. And if I change this to a negative value, so minus-30, and hit Enter it will give
me 30 working days before.
We’re going to look now at something else you might have to do from time to time. And that’s to
find the difference between two dates. Now that sounds like it could be quite straightforward but
there are a couple of interesting quirks to be aware. So let’s start by finding the difference
between the date in B7 and the date in D7 and we’re going to find out first of all how many years
are between those dates.
Now one way of doing that is using the Year function. And if you look up in the Formula bar
you’ll see the function that we’re doing there. So essentially we’re taking the year from D7 and
minus-ing the year from B7. So when I click the tick to confirm we get an answer of one.
Now you may look at that and say, “Well that’s not a whole year.” What Excel is actually doing
is looking at the year number in one date and then the year number in the other date and taking
the difference between them. It’s not really looking at how many totally elapsed years there are
between those two dates.
There is an alternative approach to this and that is to use the Date Diff function. And this
function is designed to show you the difference between two dates.
Now one of the quirks with Date Diff is that you won’t find it listed in the Function library. So if
you look under Date and Time you won’t find the Date Diff function and you won’t find it if you
explore the wider function library either. So you need to type it directly into the cell. So
=DATEDIF, open parentheses.
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The first argument is the start date. So in this case B7, comma. The second argument is the end
date, so D7, comma. And then we need to tell Excel what we want it to extract. So in this case
we’re doing the year. Close parentheses.
So that’s the Date Diff function and you can see it says that there zero years. So essentially
finding the difference using Years is rounding up and finding the difference using Date Diff is
rounding down because there not one full year according to Date Diff.
Let’s now turn our attention to the number of months between those dates. And first of all in G8
I’m going to use the Month function. So up to the Formula bar and I could use this combination
of functions. So Month D7- Month B7, click the tick to confirm. So if we just look at our months
you can see that 7-4 is actually three, so minus-3 in this case.
So let’s see how that works using our Date Diff function again. Up to the Formula bar,
DATEDIF, open parentheses, B7, comma, D7, comma, and then we’re going to specify the
month this time and close our parentheses. Hit Enter to confirm and now you can see we have
the correct answer of 8 if you count from July 2016 to April 2017 then that will give you an
answer. There are eight months in between.
Following on from that the next question might be what is the number of days between those two
dates. And in H9 as you can see I’ve already put in the Date Diff function for the number of
days. However for days there is a much simpler way of doing things. We can simply do =D7-B7,
hit Enter to confirm and you’ll see we get exactly the same as the result using the Date Diff
function.
Now the Date Diff function does a pretty good job but there may be occasions when you wan to
do something which is a little bit outside the scope of what Date Diff is able to do. And it’s very
useful to be able to manipulate functions like year, month and day.
Now we’ve seen quite a few of these date and time functions I will leave you to read up on some
of the ones that we haven’t covered in this section. So you can refer to the Help feature in Excel
and just look for Date and Time functions and you will see all of them listed here. Some useful
ones I’d like to highlight, the Days function, and you can see here that that is available in Excel
2013 and onwards.
Some other functions that I want to draw to your attention that might be worth checking out are
the Network Days function and also the Network Days.intl function. Both of those help you
work out the whole workdays between two dates. So as an additional little exercise you might try
to set up a calculation of the net number of working days between B7 and D7 on the worksheet
on the Data Functions 2 workbook.
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Now as we go through the course we will be referring to dates and times and the associated
functions, but now it’s time to turn our attention towards Text functions. That’s what we’ll be
looking at in the next section so I’ll see you over there.
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Chapter 4 – Text Functions
Video: Using Text Functions – Part 1
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to start to look at Text Functions, but instead of going through the Text Functions
one at a time and demonstrating what each one of them does I’m going to do a very specific
exercise using a range of text functions.
Now I’m going to assume that you’ve used basic text functions before. And I’m also going to
assume you’re familiar with the use of concatenation, either using the ampersand symbol or if
you’re using Excel 2016 or 2019 the Concat function. But some of the functions I’m going to be
using in this section may well be some you haven’t used before.
Now the basis of the exercise I’m going to do is that I’ve been given a long list of employee
details and for each employee I’ve got five pieces of information. And in a text file I’ve got
about 20 employees information, just as sort of a test sample, and I’m going to see if I can use
Excel’s text functions to basically tidy this data up and to reveal the structure in the data.
I’ve opened the data here in Notepad so you can see that text file. And if you look in the first row
there is an employee name, there is a number and I believe that’s the start date, then we have the
salary, and then what I believe is the department he works in, and finally his job title. Now these
five pieces of information are separated by semicolons. What I want to do is use text functions to
split the data up for each employee and I want to end up with the data for this test sample neatly
structured in an Excel workbook.
Now one thing that probably is obvious is you could say, “Well why not just type it all into the
workbook just using this Notepad file?” As I said before this is basically a sample of about 20
people. And let’s assume I have thousands of people and what I want to do is put together a set
of formulae and functions that will work on those thousands of people but I want to test it out on
just this select group first of all.
Now I’m going to close this text file and open it up in Excel. So let’s go to File, Open, and I’m
just going to browse to where I have my Notepad file saved, and there it is. And when I click
Open you’ll see we get the Text Import Wizard.
Now using the Text Import Wizard I could say that this is a delimited file, so the semicolons are
used as delimiters and I could get Excel to split the data up into five constituent fields. Now I
could do that but on this occasion I’m really trying to demonstrate some of the more
sophisticated text functions. So I’m not going to do that on this occasion. What I am going to do
is stick with the default setting and I’m going to stick with the default of Tab Delimiters.
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As you can see from the preview window at the bottom it’s going to treat the contents of each
row as a single field within the row. So it’s not going to split up each row at all for me. Now I
realize of course that under normal circumstances you’d declare that the semicolon is the
delimiter and get Excel to do all the hard work for you, but on this occasion I really want to show
you how to use some of the text functions. And click Finish.
Now what I end up with is a new worksheet and all of the data is in one column. So if I just
widen that out slightly you can see that all the information is within column A.
Now in the early stages of working on this file what I’m going to do is make one or two really
deliberate mistakes. Now before I get started on this if you’re not too familiar with Excel text
functions take a look at Excel 2019 Help. On the Text Functions page you’ll see a list of the
functions which of course include the ones that we’re going to use. And there are three functions
we’re going to look at at the beginning and the first one is Lower, so it’s pretty easy to figure out
what that does. It converts all text to lowercase. The Upper function that converts text to
uppercase, and finally we’re going to look at the Proper function which capitalizes the first letter
in each word of text value.
Now it’s the Proper function that I’m going to demonstrate first and what I’m going to do in
column B is to use the Proper function. So I’m going to type in equals, Proper, open bracket, and
you can see the argument there is Text. So I’m just going to select cell A1, close, and hit Enter
and again if we drag the column out to give it a little bit more room you can see there that Excel
has done a nice job of converting all of those words to proper case. It doesn’t get it right in every
instance but it is normally fairly good at working this out. So you can see here if we just take the
first part where it was Juarez, Jose that those have now been changed to uppercase in column A
to capitalizing the first letter of each word.
Now assuming I’m happy with that, which I am, I’m going to fill it down. So a nice quick way of
doing that is to highlight all the way down and then Control-D to fill that down. And again I can
double click just to widen that column out.
Now I’m going to make the first of those mistakes. And the first mistake I’m going to make is to
say, “Hmm. Okay. That’s much better so now I can delete column A.” But look what happens if
I do that. Let’s just delete column A and you’ll see that immediately I get an Error. That’s
because the formula Proper was referring to values in the cells that we’ve just deleted. And of
course the consequence of that is that column B doesn’t work anymore. So one thing to bear in
mind is to make sure you don’t remove any data that you need.
Now of course there is an alternative to this. What I could do, and let’s just widen out column C,
is I could highlight my data in column B, I could go up and do a Copy, click in column C and
then do Paste Values. And what that does is it essentially throws away those underlying formulas
so I could then go in and delete both columns A and B and that appears to have worked fairly
well.
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Now you may think that’s a much better way of doing it but the problem now is that if this is
something you’re doing as a one off then that’s probably going to be fine, but if what you’re
trying to do is work out a set of formulae and functions which you can use not just on a sample
data of 20 people but on 2,000 people you can’t really lose those intermediate steps. So what we
really need to do here is keep the columns as we work our way through all of our data.
Now normally what I would do instead of deleting the columns out is I would hide those
columns. So I’m going to right click and I’m going to select Hide instead.
Now the next part of the job is going to be to start to split up the information about each
employee. And the first thing I’m going to do is separate the name from the rest of the
information. The key to this is to locate the first semicolon character in the data in column C.
And to find a particular character in a text string we use the Find function. So in D1 I’m going to
put a formula and it’s going to be equals, Find, open parentheses. So now I’m going to say I’m
finding the semicolon and that goes within quotation marks, comma, within cell C1, close
parentheses. And hit Enter. So what I now have in cell D1 is the location of that first semicolon.
So I can see that it’s the 14th character.
The other thing I need to know is the total number of characters in cell C1. So I need to know the
length of the string in C1 and the text function I use for that is the LEN function. So let’s do that
in column E. Let’s make it a bit wider. And we’re going to type in equals, LEN, select cell C1,
and that’s all we need to do.
So now what I want to do is to get the two separate parts of C1 into separate fields. So in F1
what I want is the string of characters up to the first semicolon. To do that I can use the Left
function, which gives you the left most characters in a string. So equals, Left, the text string I
want to take the characters from is C1, comma, and the number I want isn’t actually 14 in this
case because that would include the semicolon. So it’s the value minus one. And hit Enter to
confirm. And I can see that that is now working perfectly.
Now what I want to do is put the remaining text that’s in column C into column G. Now you
might be able to guess what goes into cell G1 because there is also a Right function. So again
what text string am I looking at? Well we’re going to be looking at the text string in C1. So let’s
type in equals, Right, select cell C1, comma. So how many characters do I want from the right of
the text string? Well it’s the length of the whole string, so E1, minus D1. And hit Enter to
confirm. And again I can just do a quick visual check and I can see now that yes the rest of that
information has now populated in column G. And of course we could do exactly the same and
fill all of these details down. So let’s highlight and remember you have that Control-D shortcut
or you can select Fill and Fill Down from the Home Ribbon. And if I look through all of those I
should see that it’s worked successfully.
Now once you’ve completed that step you might look at column G and say, “Okay. Well I can
work on column G and separate out the first field in column G in a similar way. and in fact that’s
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one of the things we’re going to do in the next section. But I have a few other things to explain at
the start of the next section about what we’ve done so far and about a couple of alternatives that
you need to be aware of.
So the final thing I’m going to do is save my file as an Excel workbook. Now when you’re
working on this kind of conversion not only is it a good idea to frequently save your work but
you might want to take a copy of the worksheet so that if everything goes wrong you can get
back to your original starting point. I’m going to save this as a workbook now and I’ll see you in
the next section.
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Video: Using Text Functions – Part 2
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to continue looking at text functions and I want to start by reviewing a couple of
tasks we completed in the previous section.
Now we’ve started to split up the employee data that we had into five fields. The first field is
here in column E and the balance of the information about each employee is in column F. Now
in a moment I’m going to split what’s in column F a little bit further, but before we do I’d like to
review an aspect of what we’ve been doing so far and it in order to do that I’m going to look at
E2.
Now in E2 we have a formula, Left, B2, C2-1, and B2 is the text string and C2 is the value 14.
Now if I click on C2 I can see that it’s actually itself a formula, Find, semicolon in B2. Now if I
take that Find and copy it to the clipboard and now select E2 what I can do is replace C2 with the
function that I’ve just copied to the clipboard. So what I’ve done there is to replace C2 with Find,
which eliminates any reference to column C from column E. Now I realize I’ve only done it in
the case of row 2 but I could of course fill down to cover the other rows.
Also notice that in the formula equals Left I have two references to B2. Now what is B2? Now
B2 is Proper. What I could do, and let me copy Proper to the clipboard, now I’m going to go into
E2 and wherever I have B2 I’m going to put Proper. And copy down. Now if I carry on doing
this and if I did the same to the formula in column F I could eventually get to the point where I
have no references to the columns B, C or D. And I could in fact find that columns B, C and D
are totally unnecessary because what I’ve done there is to create formulas with nested functions.
And each function within its arguments may have references to other functions and its arguments
and so on. So I could finish up in a situation where ultimately each of my five columns with
individual fields is really just a formula which only refers to what’s in column A. So I find that
all the other columns that I’ve introduced for the purpose of developing this system step by step I
could finish up with a situation where I could just do the whole thing with those five formulae.
Certainly when I’m showing people how to do this for the first time I break it down into steps,
but if you can understand the use of formulae in functions and if long formulae don’t cause you a
problem then clearly not having these intermediate columns can be an advantage.
If you find all of this a little bit confusing at this stage it’s probably best to stick with the
approach I’m using here of building the whole thing up column by column.
So I put E2 back to the way it was and what I’m going to do now is to develop column by
column a breakdown into the four remaining fields for the contents of column F. Now I don’t
really think there’s a whole lot of point you watching me do this. In fact what would be a good
idea is that I’m going to save this version as Text Functions 1 and if you want to try doing the
next bit yourself, this isn’t one of the exercises, but you can try it this way anyway. We’ll then
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pick up immediately after this with Text Functions 2 where you’ll see the breakdown of what
I’ve done.
So what I’ve done here is to continue to break up the information about each of the employees
and I’ve put headers on the five columns that have the five pieces of information about each
employee. So we have Name, Start Date, Salary, Department, and Position. So what I’m going to
do now is hide the working columns and bring back column A and talk about some of the other
issues with the work that we’ve done here.
Now if you consider our starting point you might think we’ve made some pretty good progress
here because we’ve split up the information into five columns but there are still a few things that
need our attention. And of course the first thing to note is that in the case of Start Date and
Salary both of those are coming across as text and you can normally tell that because they are left
justified in the cell. So starting with Start Date it’s clear that Excel 2019 hasn’t realized it’s a
date field we’re dealing with and hasn’t realized that these are numbers.
Now there are various ways of dealing with this. One of them is equals, Left. And if I want to
convert text to a number I can use the Value function. So equals, Value, open parentheses, close
parentheses, and Enter to confirm. And it now becomes a number. I can then select my whole
column and fill down with Control-D. Now column I contains numbers so all I need to do is
format as a date.
Now it looks as though the contents of the salary column are also text, so let’s turn those into
numbers. Now in order to format that as currency and I’m going to use U.S. dollars, I can pretty
much do that the same way as I formatted the Start Date column by selecting the whole column
and formatting the cells. However there is an alternative option and that’s the Dollar function.
And it’s definitely one worth looking at. So equals, Dollar, open parentheses. And you can see
Dollar has two arguments, the value you want to turn into the dollar amount and then the second
argument is the number of decimal places. So I’m going to move across to the end because we
have our number, that’s the formula there, comma, and I’m going to say zero decimal places, and
close my parentheses. Hit Enter to confirm. Note that when I do that I finish up with a dollar
amount as a text value because it’s still left aligned. So I’m going to undo that one and fill down
the Value function. Control-D to fill down. And I’m going to format that column as currency
with zero decimal places. And there we go.
Now something that you may have noticed is that the names of these employees in many places
have additional trailing places after them. For example, if you look in cell A2, if you remember
the position of the semicolon is position 14 in the string, which implies that there are 13
characters before it. But if you add up the characters it only comes to 12. The 13th character is the
space. And you can see that between the E in Jose and the semicolon you can see that there is a
space. Now generally speaking trailing leading spaces, double spaces, etcetera, in many cases
they can cause a problem but there is an Excel function to cope with this and it’s called the Trim
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function. And it trims leading and trailing spaces and also multiple spaces. So where there’s
supposed to be a space within a string it reduces it to a single space.
So equals, Trim, and press Enter. Now of course there won’t be any visible affect on what you
can see in column E but those spaces will be removed once I fill this formula down.
Finally I’d like to look at one more text function in this section. If you look at the Department
column, department name includes Mktg, M-K-T-G, which is here in cell Q8. We’ve also got
R&D, etcetera. So let’s suppose that some of the data you are processing has abbreviations but
you’d like to make it into Marketing, Research & Development. Now one way you can do this is
to use the Substitute function. Now I’m going to demonstrate the Substitute function here. It’s
not necessarily a particularly good way of doing this, for reasons that will become apparent in a
moment.
So in Q2 is the formula =Left(N2,O2-1). Let’s introduced the Substitute function. So equals,
Substitute. Now notice what it says there in the screen tip it replaces existing text with new text
in a text string. So open parentheses. Our first argument is we need the text. So that is our
function, our left function just there. So I’m going to click at the end, comma. We now need to
say what is the old text. So we’re going to substitute Marketing, MKTG. So we’re going to put it
in quote marks and we’re going to say MKTG, close our quotes, comma, and now the new text
that we want to substitute it with, so again in quotes, we’re going to replace it with Marketing,
close quotes, and close our parentheses. And press Enter to confirm. Now again in this particular
case it has no affect whatsoever on cell Q2 that we’ve applied this formula to. However when we
copy it down if you keep your eye on cell Q8 you should see it change. So let’s highlight,
Control-D to copy down, and there we go. It’s been replaced or substituted with the word
Marketing.
Now that’s fine but it only did one substitution of marketing and if I wanted to do a substitution
of R&D as well, well I’d have to use the Substitute function twice within each formula within
column Q. And so that starts to get a little bit messy. And there is a much better way of doing
that which we’re going to look at later on in this course.
Now the example I’ve just shown you you probably wouldn’t do it that way. Really only if you
have one instance of something. You’d more or less treat it as correcting an error. There are one
or two text functions that we’re going to come across later in the course and we’ll cover those as
well.
I suggest you do go through the Help on text functions but that’s it for this section. Please join
me in the next one.
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Chapter 5 – Logical Functions
Video: Using Logical Functions
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at Logical functions. Now you’ve probably used the If function before. You
might also be familiar with the Boolean Logical functions, so And, Or, Not, etcetera. And there
are one or two newer functions introduced, such as the If S function and also the Switch function
and those have been introduced in Excel 2016.
The Logical functions although they’re quite a small group in number they are very important
and they are particularly important as your Excel workbooks start to get more complex. And the
key important points about the use of Logical functions is that they enable you to evaluate values
of cells. And they help you ascertain what to do in any given situation on the basis of
circumstances that might vary. So rather than always doing a particular thing, you might for
instance compare a few values on a worksheet and put a number in another cell, perhaps maybe
you’ll compare whether one value is bigger than another, and in its most basic form we will use
the If function for this purpose. And it’s the If function that I’m going to demonstrate first.
Now as a very straightforward example what I’m going to do is put a word in the cell C3 that
says whether John’s birthday is earlier than Jane’s birthday or later than Jane’s birthday. So all I
need to do is use the If function here. So let’s type. Equals, If and I have basically three
arguments. The first argument is the logical test itself. And the test I’m going to do in this
scenario is, is B3 less than D3. If that’s true I’m going to say Earlier. If that’s false I’m going to
say Later. Close parentheses, click the tick to confirm and you can see that I have that answer of
Later in cell C3.
Now if I change Jane’s birthday from 1990 to 92 and press Enter you can see that it now changes
to Earlier. So that’s the If function. That’s pretty straightforward. Now whilst that was very
simple it does have some problems. What would happen if the birthdays were the same? Now in
the past what would have happened is that you would have constructed a more complex If
statement. For example, going back to cell C3 here we might first of all say If B3 equals D3 then
put the Same or leave C3 empty. Then if it’s not true we would put the If statement we have
now. But in Excel 2019 we now have the option of using an If S statement. So I’m going to
delete out what I have in cell C3 and we’re going to type equals, If S, open parentheses. So our
first logical condition is Is B3 equal to D3? If that’s true we’re going to input the word Twins
into cell C3. Then we’re going to do our second logical test. So If B3 is less than D3 input the
word Earlier into cell C3. And our third logical test, if B3 is greater than D3 we’re going to input
the word Later into cell C3. Close parentheses and click the tick to confirm. So there we are. So
that should start with Earlier of course. And if I put Jane’s birthday back to 1990 you’ll see I get
the result of Later. If I make both the birthdays the same, so let’s change John’s birthday, I get
the result of Twins.
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Now as you can see there in C3 we have an If S statement with three alternative conditions.
Equals, Less Than, and Greater Than. You can have up to 127 pairs of conditions and values
there. It probably starts to become a bit unwieldy once you have quite a few but you can
certainly put many different conditions in there. But it’s still not really quite right because if I
hadn’t have entered John or Jane’s birthday what would happen? So let me delete out John’s
birthday and you’ll see I still get the result of Earlier in C3, which isn’t quite correct.
So what I really need to do to make this accurate is I need to check that both of those cells have
values before I construct my formula. So that’s what I’m going to do next. I’m going to build in
a little check that will check if there is a value in cell B3 and in cell D3 before running the
function.
Now I’m going to stick with my If S statement but what I’m going to do is embed it in an If
statement itself. And what we’re going to say is that it’s only going to apply the If S function if
there are valid dates in both B3 and D3. So I’m looking at both B3 and D3 containing numbers
greater than zero. So let’s do that. Let’s wrap this If S statement in an If condition. And we’re
also going to use the And function in here as well.
So If, open parentheses, and now we’re going to use that And function. And first we’re going to
check that B3 is greater than zero. And our next check is that D3 is greater than zero. Now if
that’s true, so if both B3 and D3 are greater than zero then we’ll run our If S function. So the If S
is essentially the condition of the value if true. So what’s our value if false? Let’s jump across to
the end, comma, and if that’s false, so if B3 or D3 doesn’t have a number greater than zero in it I
just want it to put a blank. So we’re just going to put a space within quotation marks on the end.
Press Enter to confirm. So now because I don’t have anything in John’s birthday, so essentially
cell B3 is blank, I’m getting nothing in C3, which is correct. Let’s pop John’s birthday back in
and I get the answer of Later. So I can see that that formula is actually working correctly.
Now let’s look at one of the other new logical functions. This is the Switch function. It’s quite
similar to If S in some ways. The main difference is that we’re only looking at the value of one
thing. And in order to demonstrate the use of the Switch function we’re going to look at the
values in the Q column in our Imported Employee Data.
Now I’m going to work on cell S2 and I’m going to say that the formula is equals, Switch, and
the value I’m going to test is the value in cell Q2. Now the first value I’m going to look for is the
value Admin. And if I see the value Admin what I’m going to do is put into S2 Administration.
The next value I’m going to look for is MKTG, or M-K-T-G. And where I find that value I’m
going to replace it with Marketing. The next value I’m going to look for is R&D and I’m going
to replace that with Research & Development.
Now right at the end having identified the three cases where in effect I want to change the
department to the full name of the department what do I put as my default. Well if I don’t find
any of those the value I’m going to put in Q2 is just whatever is currently in Q2. So Admin,
© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved.

Learn Excel 2019 Advanced
Engineering, Sales, Marketing, whatever that might be. So my final argument is just Q2. And
click the tick to confirm. And if I copy down you should see that formula in action. So wherever
we have Admin in column Q we now have Administration, wherever we have MKTG we now
have Marketing, and wherever we have R&D in column Q we now have Research &
Development in column S.
So there we are. We’ve looked at a couple of the basic logical functions, If and And, and I’ve
also looked at two new logical functions, the If S and the Switch. And in the coming sections of
the course we’re going to be using logical functions quite a bit. And so the first way we’re going
to use them is in Exercise 01, which is in the next section, so please join me for that.

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved.

Learn Excel 2019 Advanced

Video: Exercise 01
Deborah: Welcome back to our course on Excel 2019 Advanced. It’s time now for Exercise 01.
And in Exercise 01 I want you to set up a very straightforward John’s birthday, Jane’s birthday
pair here. I’d like you to make a few improvements to the version that you saw during the
previous section though.
One of the improvements is that I want you to be specific about missing birthdays. So in this
case I’ve got neither birthday in there so it says Please enter John’s birthday. So let me put his
birthday in there and now it says Please enter Jane’s birthday. So let’s add that in as well. We’ve
got both now and I have the question Are they twins? Let me change John’s birthday and now it
says John’s birthday is 373 days later than Jane’s birthday. And obviously if I made Jane’s
birthday later it would be able to cope with that in days as well.
Now that’s basically it with Exercise 01, but I would like to go back to a point I made earlier in
the course. When we’re talking about difference in years, months and days and I made the point
that sometimes when you’re doing these calculations you need to address issues like whether a
particular date is earlier or later in the month than another date. Well using the logical functions
you can perform this type of test. So you can look at a date and look at the day number and the
month and look at another date and look at the day number and month and work out pretty much
to any level of accuracy what the difference in years, months, days, etcetera is between the dates.
So it’s using these logical functions that you can address these issues with date calculations.
So that’s it for this section. Please join me in the next one.
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Chapter 6 – Lookup Functions
Video: HLOOKUP Function
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to take a look at Lookup and Reference functions, and in particular we’re going to
start looking at Lookup functions.
Now as the name implies what we’re doing with a Lookup function is looking up a value in some
kind of index or list and using the returned or identified value. Now I’m going to demonstrate
first a very simple lookup function, which is the Choose function. It really is quite limited in
what you can do but you may come across situations where it does the job for you.
Now by the way of a very straightforward example let’s suppose that I have some responses to
some survey types of questions and the people give a numeric response in the range of one to
five. And each of those numbers corresponds to a phrase. And in a particular situation I not only
want to show the response as a number but the particular phrase it’s equivalent to.
Now the way I can do that in this case is I’m going to put my phrases in column D and I can
accomplish that by using the Choose function.
Now I can either start to type =Choose or I could go to the Lookup and Reference functions and
select the Choose function from there. And the first argument is the index number. So this is the
number that we’re going to look at and use as the basis of our choice. Now for D3 the number
I’m going to be looking at is the number in C3.
The next argument is the value I’m going to put into D3 if the value in C3 is one. And we must
always start at one. So I’m going to say that one corresponds to Strongly Agree. Now I put in the
next value. A value of two corresponds to Agree, a value of three corresponds to Neither Agree
or Disagree, a value of four Disagree, and a value of five Strongly Disagree. Now I can put up to
2,504 values there. So at the moment I’ve put in five values which means in this case I can
accommodate numerical values in C3 from one to five. Now any time there is nothing there I’m
going to get an error message. So in this case #Value. Let me put a number into C3. So let’s try
two. And now it says Agree. Let’s change it to four and we get Disagree. Now as you can see
that’s pretty straightforward.
Now Choose always works with positive integer values starting with one on a continuous scale.
In fact in the response there if I put something like 3.6 what Excel 2019 does is round that down
and it will give me the equivalent of if I’d put three in there. And if it comes out below one, so
I’d put say 0.8 I’d get an error. At the same time if I put value outside of the range that we’ve
specified, so six I’ll also get an error. So that’s basically how the Choose function works, but it
also presents us with another issue.
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If I’m setting up something like this is there a way to avoid getting error values like the one you
can see on the screen? Now there are a couple of very good ways that you can deal with
situations like this one. For example, you want to put a formula into several cells but you know
that until some other cells have some values in them that the formula is actually going to return
an error. So for instance you could actually test to see if the response was in the range one to five
and if it isn’t you could prompt the user to enter a value of one to five. But the easiest way of
dealing with this is to use the If Error function. So let’s add into our formula If Error.
Now with the If Error function what I would do in this case is evaluate my formula using Choose
and if there is no error I will get the value that Choose is going to deliver to me. But if I do get an
error what I do is the second argument in the If Error function. Note that there is a screen tip
there. And I can say here what I would like to appear in D3 if there is an error. Now I might want
to put a message in there such as Response must be in the range of one to five, or if I’m
anticipating that I’m going to fill D3 down to D12 with this formula and therefore I’m going to
get that message everywhere I might just choose to leave column D empty. So I could use a
blank, which is what I’m going to do in this case. So I’m going to say quote mark, space, quote
mark, close parentheses. So now if I do get an error there’s going to be nothing in the cell. Let’s
see if that works. And you can see there I have six as my response but that’s outside of our range,
but instead of getting an error I now have a blank. What happens if I copy that formula down?
Let’s double click and I get nothing. Let’s put a three in here and maybe a one and also a zero.
And you can see that that’s working nicely.
Now as I say, you might want to combine this with a more complex arrangement whereby you
say if in fact there is a response in column C but it’s not in the range of one to five you might
want it to say to the user that you must enter a value in the range of one to five. And you can just
add that onto the end there instead of having just the quote mark, space, quote mark. But as you
can probably tell you can build this up to be as complex as you want it to be.
So to quickly run over that again, looking at D4 note the use of the Choose function there. My
index value is my value in C4 and the Choose function will return values for an index value of
one, two, three, four, up to the number of alternative values I’ve specified.
The five options I have are all text values but I could have had numbers in there, I could have put
cell references, I could have put functions, formulas, names, there are many possibilities of what
you can put in.
Now next we’re going to look at one of the most popular Lookup functions and actually it’s a
pair of functions, HLOOKUP and VLOOKUP. And in this section we’re going to look at
HLOOKUP or Horizontal Lookup and then in the next session we’re going to look at a more
complex example of VLOOKUP or Vertical Lookup.
So what we have here are some scores in a quiz and I have scores for around 20 students. And
what I want to do is determine which Quartile each student’s score puts them in.
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Now the lowest score in this list is for Parker, Hector who’s down here in row 12 and he has a
score of 43. We’ve got some very high scores in there as well. We have a 98 and so on. So what
I’m going to do is use a very straightforward statistical function to calculate the quartiles. Now
let me explain to you first what quartiles are.
If you have a set of results like this think of it as slicing them up into four even bits. So I actually
have 19 students but let’s call it 20 roughly. You’re going to say what range of scores covers the
first five, then the next five, then the next five, and so on. So you’re really dividing the class up
into four quarters.
Now the first thing I need to do here is evaluate the quartiles. There are values that divide my
results into four even sets. Now if you’ve not used the Quartile function before let me just
demonstrate something I mentioned on earlier in the course.
You might need a statistical function but you’re not sure which function it is so you might start
to type in something like Quartile and ah, look, there is a whole set of them. The first two are
effectively the same. Quartile is the original Quartile function and Quartile.inc replaces it
because there is a distinction between Quartile.inc and Quartile.exc. Now I’m not going to go
into that too much and there is a distinction between the two and it’s an important distinction and
it really has to do with the use to which the quartile is being put. But for the purpose of
demonstrating Lookup functions we’re going to stick with Quartile.inc.
And we have two arguments. Which array of numbers are we going to find the quartile of? So in
this case it’s B2 to B20. And I want the first quartile. So this will be the score below which the
first quarter of students would be positioned. So this is if you like the weakest quarter of the
class. And I find that that score is 72.5.
Now what I need to be able to do is evaluate the other quartiles and I’m going to arrange them
horizontally. And if I select the three cells to the right and use the Control-R keyboard shortcut I
get errors. And the reason I get an error is because if I look at the formula in G2 I’m now looking
at the scores in C2 to C20, which is definitely wrong. So of course when I specified the array
from which the quartile scores are going to be calculated I need to use absolute references, so let
me go in and do that. Now I can right fill and of course I will get the first quartile in all of those
cells. But all I really have to do is go back and edit those to get the second and subsequent
quartiles. And very importantly at the beginning of my set of scores is the score of zero.
Now the function we’re going to use in order to decide which quartile each score is in is the
HLOOKUP function. And the way that the HLOOKUP function will work is that I will tell it
where the list is and for each student’s score, so let’s start with John Beale who has a score of 82
it will read along that list horizontally and it will basically compare 82 to each of these figures.
So it will say is 82 bigger than zero? Yes. Is 82 bigger than that? Yes. Is 82 bigger than 76? Yes.
And then oh no I’m not bigger than 87 and therefore the score of 76 in this case denotes the start
of the third quartile, the score of 72.5 denotes the start of the second quartile and zero denotes the
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start of the first quartile. So obviously that means 87 denotes the fourth quartile and 98 is the
highest score. The high score is also going to be in the fourth quartile as well. So basically as
HLOOKUP works its way along there it waits until it gets to a score that is too big, in this case
87, and says, “Okay, well John must be in the category that begins with a score of 76.” And in
this case that’s the third quartile. So we’re all set to work out our quartiles using the HLOOKUP
Function.
The first argument is the value we’re going to look up. So the value is B2. The table array that
we’re going to look in is E2 to I3. Now remember there we need to make these absolute as we’re
going to fill down. The row index number, this is which row gives us the value we want. So in
this case it’s the second row. We want it to tell us which quartile these values are in. So the row
number is two. If we wanted to match the values exactly, so if we were looking for exactly 72.5
or exactly 76 we would set the range lookup to false, but we want it to be true. And click on OK
and it correctly says that John Beale is in quartile three. Let’s do a fill down now and see what
we get for those other scores. And yep I think those all look to be correct.
I suggest that you check those for yourself and I will see you in the next section.
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Video: VLOOKUP Function
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. We’re going to
continue looking at Lookup functions and in particular we’re going to look at the VLOOKUP
function.
The principle on which this VLOOKUP function works is pretty much the same as HLOOKUP,
except that instead of looking horizontally across a list of values it looks for a vertical list of
values to look up.
Now one of the reasons I’m devoting an entire section to this function is that I’m also going to
try and make the Lookup function functionality here considerably more complex. And the way
that we’re going to use the VLOOKUP function is to do some more work on developing an
invoicing system.
At the moment in Lookup Functions 3 here I have a few headings on a sheet and apart from a
date and those headings there’s not too much other information currently, but the general
principle is that I’m going to put together a system whereby I can take an order from a client, list
the details of the order and prepare an invoice.
Now basically in the body of the order, in this part here, I’m going to specify the number of an
item that the client wants, a part number, and a description associated with that part number.
There will then be a unit price, a discount where applicable, a discounted price, and a total price,
and then a grand total for the order down in cell H12.
Now the first thing you might say is where is all this information coming from? Well on the
second sheet in this workbook I have a catalog. Now it’s a relatively small catalog but it will
demonstrate what I’m trying to do very well. And it’s a catalog of parts and these are actually
plumbing, bathroom fitting parts. And each part has a part number in column A, a description in
column B, and a dollar price undiscounted in column C. So basically what we need to do is when
we put a part number into column C on the first sheet, the first thing we’re going to do is look up
the description. Now if somebody puts a part number in there that doesn’t correspond to an item
in the catalog we’ll want to put a relevant message in there and we will also need to deal with
some other complications as we go along.
Now the first thing I’m going to do is give all of the parts catalog name. So I’m going to select
the entire catalog, click of Formulas, and in the Defined Names group in the middle there I’m
going to select Define Name. And the name I’m going to give this is Parts Catalog. The scope of
the name is Workbook so I can reference it on a different sheet, so that’s fine, and I’ll click OK.
Now let me go back to Sheet 1 and we’ll implement our first VLOOKUP.
Now what I actually want to do is to get the description to show the description for the part that’s
specified in column C. We currently don’t have a part number in there but we will do eventually.
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So I’m going to do that by using the VLOOKUP function. The arguments start with the lookup
value, which will be C7. So when that part number is entered in C7 that’s what we’re going to
use to lookup the description. The table array will of course be the name of our parts catalog. So
I need to select the range, so it’s Parts Catalog. Now the column index number, which column
are we trying to pull information back for? So we’re trying to pull back information on the
description which is column 2. And finally the range lookup. Here if you’re looking for values in
a range, say between two part numbers, you would set this to true, but that’s not what we need in
this case. We’re looking for an exact match. So in this case the range lookup value is false and
click OK. And of course we get an Error message. Now that’s because we don’t have a part
number in C7 as yet. So all we’re getting is a N/A message.
Now I can overcome that using a similar approach to the one we used in the preceding section
for cases where we get an error message because there is an If N/A function. So what I’m going
to do is embed that VLOOKUP in an If N/A function.
The first argument is the value to assign. So there we have our VLOOKUP as our first argument
and the second argument is where we want to put what we want to happen if the value is N/A. So
in this case I’m just going to set it to be an empty string again. So I’m going to do just a space in
double quotes, close parentheses, Enter. So let’s try that out now by selecting a number from the
parts catalog and I’m just going to grab this one in A3. I’m just going to copy it. I’m going to
paste it into cell C7 and there we go. It pulls back the description.
Now I want to do one more thing to this to make it a little more helpful and informative. So let’s
fill this formula down to D11 and let me say put a part number in C9 that doesn’t exist in the
database. So I’m just going to go with 1234. Now notice that in this case what has happened is
different from the situation where the part number is just left blank. I actually show the text there
Not Found. And if you look at the version of the formula that I have in here, I still have the If
N/A and the VLOOKUP and of course if the VLOOKUP works and the part number is found
then the description is shown. But if it doesn’t in the second argument for the If N/A I’ve put an
If statement. And in that If statement I’ve said if you trim the part number, in this case C9, and
it’s blank then that means that the user hasn’t entered a part number. So therefore the fact the
lookup didn’t work is fine because the user didn’t specify a part number. So in D9 just put a
blank. That’s what the double-double quote is. But if when trimming C9 there’s something there
but I still don’t find a description, so the VLOOKUP still essentially doesn’t work then I’ve got a
situation where the part number is not found and in that case the message I’m going to put in cell
D9 is Not Found. So that draws a distinction between the case where the user has entered a value
in the relevant cell in column C and where they haven’t. So that’s quite a helpful change to
make.
So armed with VLOOKUP and a couple of the other things I’ve explained recently I think we
can do quite a bit more work on this invoice. And to be more specific I think you can do quite a
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bit more work on this invoice. And you’re going to do quite a bit more in Exercise 02, which is
coming up next so I’ll see you then.
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Video: Exercise 02
Deborah: Welcome back to our course Excel 2019 Advanced. It’s time now for Exercise 02 and
with Exercise 02 I’m going to set you quite a few things to do with this invoice we’re
developing. The starting point is the Exercise 02 file and my answer will be in the Exercise 02
Answer.
There are several steps to this exercise so I’m going to work through it in front of you without
actually showing you exactly how I’m doing each step because that is going to be for you to
figure out.
So the point at which we left this was that we set up VLOOKUP to determine descriptions for
entered part numbers and we’ve put in some handling for situations where there was a missing
part number or in situations where the part number was not entered in column C. Now ultimately
we might want to make the number of line items in this worksheet variable but right now I’m
happy to leave it at five line items.
Now the first thing I want you to do is pick up the unit price from the catalog. And having picked
up the unit price make sure that the quantity column, column B, allows just numeric whole
numbers. In this case the customer is ordering just three door handles. But then I want you to
apply a discount. And the rule for the discount is that the discount is generally zero unless the
item being ordered has door handle in the description. So we’re doing a special offer on door
handles at the moment and you get a special 10% discount for door handles.
So this is the next step for me. I now have two line items in the order. The first line item, part
number 19232, is in fact for some door handles. And as you can see the discount of 10% is
shown in column F. And the discounted price is shown in column G, whereas the second line
item these are not door handles so there is no discount and the discounted price is the same as the
unit price. I’ve then multiplied the quantity by the discounted price and got a total price. And
I’ve then got a grand total at the bottom there, $88.47. I’ve also put into cell B12 the total
number of items in the order.
So in Exercise 02 this is what you’re headed for but there are some features that are not
immediately apparent and I want to talk about those next.
In rows 10 and 11, that’s the fourth and fifth line items, note that there is nothing shown at all,
but in fact the required formulae are in the various columns. So all of this is set up in such a way
that these cells are empty every time there is no valid part displayed. Note that in row 9, that is
the third line item, because we have a part that doesn’t exist in the catalog we don’t get a price or
a discount, etcetera. So one of the tricky things about these formulae is that you have to set them
up in such a way that these cells are left blank when there is no valid value to show. You don’t
want an error message or an N/A. So that’s one of the tricky things to do.
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Another tricky thing to do is this. Let me put in another part number here and I’m going to put in
75664. Now note that is not a door handle so there is a 0% discount. I get the unit price okay, I
get the discounted price okay, the total price is zero because I haven’t put in a quantity let. So
let’s suppose that I want four of those, and that’s fine.
Now let me put in one other part number, 51609. And we’re going to have two of those. Now
note 10% discount because this part is a door handle. Note that in this case the H on Handle is in
lowercase. Still the way that I’ve done this detects the fact this is a door handle part and if you’ve
been using the Find function you may want to look at alternatives for that. Or you may want to
think a little more laterally about what you would need as a description to look for door handle in
it, whether or not it had capital letters and indeed whether or not it was a door handle or door
handles.
So a little bit more detailed thinking to do there. Quite often when you’re setting up relatively
complex workbooks in Excel some of these details take quite a little bit of head scratching to sort
out.
And I guess the only other thing I might say is that if you come up with a solution which is pretty
much different to mine but works it’s equally valid to mine. There isn’t one right way to do this
and lots of wrong ways. You’re just looking for a way that works to the level that I’ve described
here.
Now to be fair there are probably one or two ways in which what I’ve done wouldn’t quite work
in an ideal way. I probably have a bit more work to do to sort out the remaining glitches but
don’t look to match what I’ve done in terms of how I’ve done it. Just find something that works.
That’s it for this section. I will see you in the next.
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Chapter 7 – Financial Functions
Video: Financial Functions and Terminology
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to start to look at financial functions and there are a very large number of financial
functions in Excel and some of them are used for personal finance, some for professional finance
used in commerce and industry, and some can be used in either. There are some aspects of using
financial functions that can take a little bit of getting used to. And in this section I’m going to
demonstrate and explain one of the most commonly used financial functions. And in doing that I
will explain some of the terminology and other issues that you need to be aware of when you’re
working with these types of functions.
Now the first function I’m going to work through today is PMT or the Payment function. And
basically we generally use the PMT function to work out the payments on a loan. Now it’s a little
more powerful than that and there are quite a few options that are associated with the Payment
function and again I’m going to use this section as an opportunity to explain these.
One of the first things that takes some getting used to is some of the terminology. So what I have
set up here on this first sheet to begin with is a set of five things in cells B2 to B6. We have Rate,
NPER, PV, FV, and Type and I’m going to explain what all of those are and then subject to what
I’m going to explain we’re going to be able to calculate a payment.
Now one other term you might see from time to time when you’re working with financial
functions is the term Amortization and many people don’t know what this actually means.
Amortization in a general sense is spreading something out, in this case payments on a loan, or
it’s effectively the schedule of repayment for a loan. It can also be used elsewhere in finance for
things like how you spread out over a period of time the depreciation on an asset, but don’t let
the term Amortization confuse you. It just means a schedule of payments, or in this case a loan
and how you spread those out over time.
Now what I’m going to do first is click in cell C8 here and I’m going to introduce you to the
Payment function. So it’s PMT and you can see that there are actually five arguments and those
arguments correspond to the terms I’ve listed in cells B2 to B6. And in order to explain each of
these let’s bring up useful Functions dialog box.
Now the first term is Rate and this is the interest rate period for the loan. And one important
thing to bear in mind with Excel and the Payment function is that it doesn’t always have to work
in years or any other specific unit. So if you’re trying to work out monthly payments you need to
put in here the monthly interest rate. And look at the example there. You use 6% divided by 4 for
quarterly payments at 6% APR. So that’s how you can enter an interest rate for the period other
than an annual period.
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Next we have NPER. This is the total number of payments for the loan. So on a five year loan on
monthly payments that would be 60. PV is the Prevent Value. Now in this case the explanation
there is probably a little confusing. If you’re thinking of a loan, in the case of a loan that would
be the principle amount or the capital amount of the loan. So if we were borrowing $5,000 we
would put $5,000 in there. And if the intention is to pay off a loan completely the future value,
the value you want to be left with is zero. Now it may be that what you really want to do is
reduce the amount that you owe somebody so you’re not going to go down to zero in this case.
You’d put a nonzero value in here, but we will go into that in more detail later.
And then the fifth item, Type. This is a logical value. It’s one or a zero. If it’s a one you’re going
to make the payments at the beginning of the period and if it’s zero you’re going to make the
payments at the end of the period. The significance there of course is that if you make a payment
at the beginning of the period you’re not going to incur interest on the amount of that payment
through the period, whereas if you wait to the end of that period you’ll be accruing interest on
the amount you haven’t paid until the end of the period.
So let’s work through an example of this. Let’s suppose we want to borrow $5,000 and I’m
going to pay that loan off so the future value will be zero and I’m going to make the payments at
the start of each period. The payments are going to be monthly payments over the course of five
years. So there will be 60 payments and with a 5% annual interest rate. Let’s now work out what
the payments are.
So the rate is C2 divided by 12. This will give me a monthly rate. The number of periods is C3
and the present value is C4. The future value, C5, and the type is C6. Let’s see what that comes
up with. So I have currently a monthly payment of $93.96. Note that the payment is showing in
red and that means it’s a negative amount. And all that basically indicates is that the money is
going out. So that’s a very straightforward example of the use of the PMT function.
Now let’s take a look at one or two changes to some of these arguments. What do you think
would happen if I changed the type from one to zero? So instead of making payments at the start
of the month I make them at the end of the month. Would that increase or decrease the payment?
Well based on the fact that there would be interest to pay on the monthly payment amount, which
I would be hanging on to for the month, if I change this to zero $93.96 will go up and in fact it’s
become $94.36. So that’s about $0.40 a month extra if I make the payments at the end of the
month.
Now what about looking at that figure $94.36 and thinking, “Well I can’t really afford that much
each month.” What about trying it over 10 years? So let’s try 120 months. Well that reduces the
payments to just over $50.00. so with this arrangement it’s very easy to adjust each of those
arguments and see the consequences in terms of how much you’d need to pay for this loan.
Now one other thing I would like to show you, which is something that tends to confuse people
quite a bit. What if my intention was not to pay off this loan but to finish up with a reduced loan?
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So I want to reduce it from $5,000 to $1,000. I’m currently planning to pay $53 a month to
completely pay off the loan but what if I didn’t want to completely pay it off but just reduce the
loan to $1,000? Now what I’m going to do here is for future value I’m going to change it from
zero to $1,000 in the mistaken belief that it means I still owe $1,000. It’s not $1,000 though. It
must be minus-$1,000. The value to me is minus-$1,000 because I still owe $1,000. And you’ll
see that now my monthly payments have gone down to $46.59 a month.
So having looked at the Payment function we’re going to move on in subsequent sections to look
at other financial functions. That’s the end of the section folks. I will see you in the next.
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Video: Personal Financial Functions
Deborah: Hello again and welcome back to our course Excel 2019 Advanced. In this section
we’re going to continue to look at financial functions and we’re going to start here by looking at
another personal financial function. The function we’re going to look at is the FV or Future
Value function. And it’s more or less the opposite of the PMT function. What the FV function
basically does is to work out the future value of a saving or investment based on payments made
over a period of time. Although we’re starting this section with the FV function I in general like
to combine it with some other topics that we’ve covered earlier on in the course and head
towards making a pretty useful retirement planner. So, let’s start with the FV function.
I’m going to put the FV of a saving or investment in C8 of this worksheet. So it’ equals, FV, and
you can see the arguments there. Let’s bring up the Functions Arguments dialog. And you should
be pretty familiar with what all of these terms are now. First off there is the rate and the rate is
going to be the value in cell C2. Now that’s an annual rate and I’m going to work on the
principle that this is a monthly savings. So I’m actually going to put in there C2 divided by 12.
NPER is the total number of payment periods. So that’s going to be cell C3. The monthly
payment is cell C4. The PV is the Present Value so that’s going to be in cell C5. And then the
type is going to be one or zero. So that’s cell C6. So that’s my FV function. Let’s do click to
confirm and of course I get a value of zero because we haven’t added any values into the
worksheet as yet.
Let’s put in an interest rate of 3% over a period of ten years, so that’s 120 months, and a payment
of $200. Now don’t forget this is a payment so this is going to be minus-$200. Let’s assume
we’re starting with nothing and we’ll go for the default type of payment which is zero, which
means payment at the end of the period. That gives us an FV for the saving of $27,948.28. So as
far as that goes it’s fine but what I would like to do is turn this into a retirement planner.
If I were developing a retirement planner, generally speaking, I would ask someone what is your
date of birth and what age do you plan to retire and then work out based on a monthly payment
the value of a pension fund that had been accumulated by that retirement date. Now clearly the
amount, the future value of that particular type of saving, will depend on how many months there
are between the time the saving plan starts and that retirement date. So what we really need
Excel to calculate is the number of periods from now to the date that somebody is going to retire.
So let’s add a couple of extra rows into this worksheet and I’m going to add into the top here
Date of Birth and Retirement Age into cells B2 and B3.
So the calculation we have to do here is that given a date of birth and a retirement age we need to
work out how many months between today and the retirement date of the potential client. Now
first let’s work out what the retirement date is. I’m going to put the retirement date here in cell
E2 as a temporary measure. Generally speaking when I am developing more complex formulae I
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do tend to do them a step at a time and I do tend to use part of the workbook as a scratch area and
then delete the work afterwards.
I’m going to work out the retirement date and store it temporarily in cell E2. Now let’s suppose
that this person’s date of birth is December 24, 1969 and they want to retire at the age of 55.
Now the way that I add 55 years, and you should remember how to do this from earlier on in the
course, so there we are. So it’s basically the same date as C2 but I’m adding C3 years to the year.
So that’s going to give me a date of December 24, 2024, which looks about right to me.
Now the number of months between today and that date is going to go in here in cell C5. And
again you should be able to remember how to do that from earlier on in the course. So the result
of that is actually 70 months.
So what I do now to remove my temp working is to go to E2 and take from the formula bar that
function there and I’m going to just highlight it and copy it to my clipboard, Control-C, and then
I’m going to cancel clicking the red cross and then I’m going to go down to the NPER, so cell
C5, and in that formula where we have the reference to cell E2 I’m just going to replace it with
my function that I have stored on the clipboard. So Control-V to paste in there and press Enter.
And then what that means is that we can then safely delete and clear everything from cell E2.
So now I have a working retirement planner. If somebody comes to me with a very different date
of birth not only do I find out how many months until they retire but I get a future value for them
based on their agreed monthly payment.
Now I saved this particular example as Personal Financial Functions 2 in the course files folder.
One other thing to mention here and that is to do with PV. Let’s suppose that before somebody
started saving for retirement they already had a certain amount of money in their pension pot and
wanted to include it in here as a starting point. Of course remember in that starting pot if it’s
invested at the same rate of interest that will grow in value as well.
So let’s assume this particular saver already has $100,000 as a starting pot and that would go into
PV as a negative value. So that’s an amount going into the pension pot and that would increase
the future value of the pension pot to just over $335,000.
So it’s a good point to remember when you are doing calculations such as this one that the
amounts that are being paid or have been paid are recorded as negative numbers. The future
value, which is the amount coming back is a negative number.
Now I just wanted to talk about two other personal financial functions. So I’ll point you at the
Help for those. One of those is the RRI function. And with the RRI function what you do is give
the starting value of an invest and a future value of an investment, the number of periods that the
investment has been in place, and it returns the equivalent interest rate for the growth of an
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investment. So if you have savings the RRI function will tell you what the equivalent interest
rate is.
Another very useful one in the personal finance arena is the P Duration function. And with the P
Duration function you basically say I have an investment and I would like it to grow to this
amount of money and I can get this interest rate, how long it will take, what will the duration of
the investment be. Again, that’s a very useful function and with both of those functions there are
examples and I strongly suggest that you work through a quick example of these yourself.
In the next section we’re going to turn our attention to professional financial functions. That’s
what we’re going to cover next. I’ll see you then.
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Video: Professional Financial Functions
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. We’re now
going to turn our attention to some more advanced aspects of financial functions and many of the
functions that come into the category of advanced are ones that are used more in a professional
context then they are personally. Having said that, many of them can be used for personal
finance and the first case that we’re going to look at relates again to loans, but in this case I’m
going to do something that business often needs to do and that is to split the payments on a loan
between principle repayments and the interest repayments to understand what part of a loan falls
into each category.
Now I’ve set up a very straightforward example here. The table of values is in B2 to C6. So I
have a rate, a number of periods, the amount of the loan, FV or Future Value is zero, and the
monthly payment calculated using the PMT function is $1,109.53. And what I want to do is
determine how much of that payment is principle and how much of it is interest and I’m going to
use two specific Excel functions to calculate those amounts.
Now as I’m sure you’re aware when you’re paying off a loan and this loan is being paid off over
180 months each month the split of the payment between principle and interest varies. Generally
speaking the amount of the payment which goes to paying off the principle increases and the
amount of interest decreases. So what we need to do now is put in a facility that will calculate the
spread of the payment for each of these 180 monthly payments.
So what I’m going to do in column E is to put in a period number. So we’re going to put one and
two and I’m going to use the Fill option and select Series. It’s going to be by columns. It’s going
to be linear. The step value is going to be one and the stop value is going to be 180 and there we
go. I now have my 180 periods listed out.
The next step is to put in a column that shows the principle payment. Now there is a specific
function in Excel that calculates the principle payment in a monthly payment on a loan and it’s
called the PPMT function. So what I’m going to do here is type in equals, PPMT, and the first
argument is the rate per period. So remember it’s monthly payments. So we want the annual rate
divided by twelve. The period number is actually E2, the number of periods is C3, the principle
value is in C4, and the future value is currently at zero but it’s in C5, and click OK. So that
means that in the first period the principle payment is $609.53.
So next I’m going to calculate the interest payment. And the function I use here is IPMT. And
this one has the same argument. So we’re going to say rate divided by 12, PR is E2, and NPER is
C3, present value C4, and future value C5. And you can see that my first interest payment is
$500 for the first month. And of course if you add the principle and the interest together you get
the payment that you can in cell C8.
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Now the next step I did is a deliberate error earlier on and we really don’t need to do deliberate
errors for this type of thing now because as you’ll already realize although I’m going to fill down
all of these values some of those arguments need to be made into absolute. So let’s just bring up
the function arguments again and check which ones.
C2, for example, is always going to be C2, but as the use of this formula goes from F2
downwards C2 isn’t going to vary. Now the only thing that will tend to vary as I drag down is
the row number. So technically all I really need to do is to make the row numbers absolute. So
let’s go through and for NPER, present value, and future value. We’re fine to leave E2 as it is
and click OK. Let’s do the same for our IPMT function that we have in G2. And now I’m just
going to fill both of those down. And you’ll notice in the very last payment at the bottom the
interest payment is only $3.69, whereas the principle payment is $1,105.85.
Now just as an interesting exercise having selected those two columns what about an AutoSum?
Now hopefully you won’t be too surprised to learn that the total amount of principle paid, the last
figure in F182, is $150,000, but you can also see exactly how much interest has been paid over
the entire period.
Now make sure to familiarize yourself with the list of financial functions. Many of them are very
specialized but there are some which you’re going to be able to use in many different situations.
And one of the popular uses of these function is in looking at depreciation of assets. So in the
next section I’m going to demonstrate a very simple depreciation function and then I’m going to
set you Exercise 03, which is also about depreciation but things do get a little bit more complex.
But that’s it for this section. I’ll see you in the next one.
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Video: Depreciation
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to take a look at depreciation. And in business in particular if an organization buys a
piece of equipment it will normally be the case that they will plan for that piece of equipment to
have a certain life and a certain value at the end of the life. And rather than show the cost of the
equipment at the point of purchase they will normally write off the cost of the purchase over the
life of the equipment.
Now in order to demonstrate this we’re going to consider we’ve bought a piece of equipment and
it’s cost $100,000. That’s the figure you can see there in C2. And we know that at the end of the
useful life of the equipment we can count on a salvage value of $20,000. And we can expect to
write off that piece of equipment over five years.
Now when it comes to calculating the value of that equipment and in particular the depreciation
in value over that time there are a number of different ways of calculating it.
And the simplest way of calculating depreciation is the straight line method whereby basically
what we say is the amount of depreciation over each of those five years, in this case would be the
same. Now of course it’s pretty straightforward mental arithmetic to work out what the
depreciation over those five years would be but we’re going to use an Excel function to help us
out with that.
So what I’m going to do first of all is calculate the depreciation per year for this equipment and
the function I’m going to use is the SLN function. And note there the arguments, cost, salvage
and life. Let’s use the Function Arguments dialog and of course the cost is C2 and we know
that’s not going to vary so we’ll make that absolute and then the salvage value, C3, absolute, and
the life C4, and make that absolute as well.
Now note one important thing here is that because this is straight line depreciation it’s going to
be the same amount of depreciation for each of those five years. So if I was to fill down you can
see that it’s the same.
So let’s now calculate the value at each of those five year ends. Now a bit of a formula challenge
here. The first one is pretty straightforward as it’s just C2 minus F2. The next one on the other
hand is a little bit more complicated. We need to do C2 and make that absolute, minus F2, plus
F3. So that’s getting a little bit messy, isn’t it? So really what we need to do for G3 is to calculate
the total depreciation so far. So I’m going to replace the F2 plus F3 by the Sum function from F2
to F3. Now that’s going to cause me a bit of a problem if I filled that down because the formula
in G4 would be the sum from F3 to F4, which is not right. So what I really need to do here is fix
the start of the range that I’m going to sum. And now if I fill down that looks to be correct. And
of course I can apply the same principle in G2. So instead of just having F2 there what I’m going
to have is the sum from F2 to F2. So it’s only one number that I am adding but then I can apply
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that, fill it all the way down and we’ll get our final figure. So let’s do that. And fill down and
there we go.
So once again there I have emphasized the use of absolute references and one particular reason
for doing that again is to prepare you for Exercise 03, which I’m going to present to you in the
next section. And in Exercise 03 you’re going to apply a couple of different approaches to
depreciation. So please join me for that.
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Video: Exercise 03
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. It’s time now
for Exercise 03 and your starting point for Exercise 03 is a slightly enhanced version of the last
course file you saw with the figures for straight line depreciation in columns F and G.
Column F contains the figures for depreciation and column G the value at year end. And what I
would like you to do is the equivalent calculation for two other types of depreciation. One of
them is declining balance depreciation. And in columns J and K sum of years digits depreciation.
And I’d like you to avoid, if possible, any intermediate columns or values or anything like that.
So as with the work that I did with column G in the preceding section make sure that all of the
workings to calculate the value at year end in this case is in a single formula.
And here is my answer to Exercise 03. One thing to note here in column I, there is a very small
rounding error there. And if you look for help on the fixed declining balance depreciation
function you will see that there is a certain amount of rounding done in the calculation which
explains that slight discrepancy, but you should come out with something similar to what I have
here.
That’s it for Exercise 03. Good luck with that. And I will see you in the next section.
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Chapter 8 – Statistical Functions
Video: Statistical Functions for Description – Part 1
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this and the
next few sections we’re going to look at the use of statistical functions. And statistical functions
are amongst the most numerous in Excel 2019. And many of them are used in relation to pretty
complex statistics. And because this isn’t a specialized course in statistics I’m really going to
look mainly at the most commonly used and in some sense most basic statistical functions. But if
you do have an advanced knowledge of statistics and you need to use statistical functions you’ll
find the ones provided in Excel 2019 are a pretty powerful set.
Now I’m looking at the Excel 2019 Help page here and as I scroll down the list of statistical
functions you’ll see just how many of them there are. And as usual the ones that have been
introduced in the most recent versions of Excel are marked and there is a batch there for
Forecasting, which were introduced in Excel 2016.
Now in my coverage of statistical functions I’m really going to divide the functions and their use
into three main groups. First of all we’re going to look at descriptive functions. These are
functions you can use to describe a set of results, normally one or more samples of results, and
where you are looking at statistics that typify those results or enable you to compare one sample
with another sample. The second set of functions are the ones that are used for prediction or
forecasting and that includes these newer functions that you can see here. And the third set are
the set that are used for statistical inference and these are functions that were based on a sample
you want to infer something. For example, the population where the sample comes. These are
often functions that are used in scientific research, opinion poles and so on.
Now one important point to bear in mind is that there is a very long list of functions and a couple
of the functions here, Quartile.exc and Quartile.inc. We saw the use Quartile.inc earlier in the
course and don’t forget there is also a quartile function and in fact there are quite a few statistical
functions that are still available in Excel 2019 that have been superseded by the ones listed here.
These are kept in Excel 2019 to make sure that older workbooks work for people, but wherever
you possible you should try to use the ones that are used in the current Excel 2019 Help on
functions. Try and avoid using the older ones.
So let’s get started on the descriptive statistics and I’m going to use some data relating to a
branch of an insurance company and the data covers a period from January 2012 through to the
end of December 2015. And there are two columns of numbers. The first column, column B,
represents the number of inquiries made at that branch over time. And the second column shows
the number of policies issued each month.
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Now the data you see here is very typical of a situation where you have a whole mass of numbers
and simply looking at that list of numbers it’s hard to deduce anything from that list of numbers.
You can see that there are generally a lot more inquiries than policies, you can see that the
number of inquiries is usually in the range of 400, 500, 600, and the number of policies issued is
usually around 100, 150, a little bit higher sometimes.
Now when we are doing statistical analysis one of the first things we normally do is calculate a
few standard statistics that enable us to get a good basic picture. So let’s look at the typical kind
of statistics we might calculate. I’m going to be using the numbers in columns B and C quite a
bit so I’m going to define named ranges for inquiries and policies.
Having set up those named ranges let’s calculate a few straightforward statistics. We might, for
instance, look at the minimum number of inquiries.
Now when we use the MIN function note the list of arguments. Now I’ve set up a named range
so I know it begins with the word Branch. So if I just start typing what happens is that
Intellisense will eventually show me my options. So it’s Branch and there you go. I can select
Branch Inquiries. Close my brackets and press Enter. And the lowest value in column B is 418.
And of course it’s a very straightforward job to find the minimum number of policies and the
maximum as well and I’ll do that next.
Now of course we could do a comparison of the figures between a couple of branches based on
these Min and Max numbers but more normally we would do a comparison based on average
measures and measures of spread. Now the three main average measures are the arithmetic mean,
the median and the mode. So I am now going to calculate the mean number of inquiries and the
mean number of policies.
So mean number of inquiries the function we use there is the Average function. And I get
557.6458333. Let’s round that down to a whole number and the mean number of inquiries is 558.
Now the mean number of policies. And again let’s round that down to the nearest whole number.
And so the mean number of policies is 114.
Now the next two main average measures are the median and the mode. And just in case you
aren’t familiar with what a median is and a mode, mode is the value that occurs most frequently.
So if the number of inquiries per month varies quite a bit, as it does here, if there is a particular
number of inquiries that occur most often that will be the modal value. In the case of the median
if you imagine putting the number of inquiries in numerical order, smallest to largest, the median
is the middle one. And if you have an even number of values it’s the average of the middle two.
So I’ve entered the relevant text and formulae for the median and the mode. If you tried mode
yourself you might be somewhat confused by the fact that there are three mode functions.
There’s the old mode function and you also have a pair of newer mode functions, Mode.sngl for
single mode and Mode.mult, which is for multiple modes because a sample of data may have
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more than one mode. There can be more than one value that occurs at the highest frequency. And
in fact for both inquiries and policies here they are multimodal.
What I used here is a function that you might have used before, Mode.sngl, but in fact for the
number of policies there is more than one modal value. And in order to identify these multiple
modal values you need to set up the formula that is currently in F17 as an array formula. Now
I’m going to assume for a moment that you have used array formulas before but I’m going to run
through this example fairly quickly in case you’re a bit rusty on it.
So the first thing I’m going to do is clear the formula in F17. And I’m going to select say half a
dozen or so cells. And having made that selection I’m going to enter a formula and because I’ve
already made a selection that covers more than one cell it will be an array formula. So equals,
Mode, and we’re going to select Mult. And the array that I’m going to look in is of course
Branch Policies. Now what I do is press Control-Shift and Enter. And I will see that there are in
fact two modal values, 99 and 132. And if you check through the data in column C you will see
that both of those occur three times. Note that having made the initial selection and of the cells in
the selection F17 to F24 that are not needed, that don’t contain one of the multiple modes, they
have an N/A there instead. And of course we could apply the same principle to the modal
number of inquiries. And in this case we can see that there are actually four modal values.
So having looked at some of the most important functions for calculating averages in Excel 2019
the Average function in particular, the one that calculates the mean, has a couple of variants that
can be very useful and one of them is AverageIf, whereby you can apply one or more conditions
and find the average of set of numbers subject to a set of conditions.
Now the inquiry and policy figures we have cover the period from January 2012 to December
2015. What if I said, “What’s the average number of inquiries in the second half of 2015?” Well
what I can do in this case is say equals, AverageIf. Now first of all I need to specify the range of
values that I’m going to test for a condition. So this case it’s the range of dates. So that’s A4 to
A51. Now we specify the criteria. In this case the single criteria we’re going to apply is that
we’re talking about inquiries in the second half of 2015. So it’s going to be from July the 1st
onward. So that is greater than or equal to July 1, 2015.
And then finally which are the values we’re going to average? Well they are the values we
identify by the branch inquiries name. And let’s see what we get. Let’s just take those decimal
places down again and we find that for the second half of 2015 the average number of inquiries
per month is just over 461 or 461 if you round down to a whole number.
And it’s also worth noting that there is another arithmetic mean function, AverageIfS, which
enables you to specify multiple criteria.
Just one other thing to mention here, if you take this list of policy sales and select it all the way
down don’t forget the Quick Analysis button. And if you click on Totals, totals include Average,
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Count, Sum, etcetera. So some of the basic statistics that you might be interested in can be
quickly calculated by referring to the Quick Analysis facility there.
So that’s it on averages. In the next section we’re going to be looking at measures of spread so
please join me for that.
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Video: Statistical Functions for Description – Part 2
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In the
preceding section we looked at some averages in relation to statistical samples and in this section
we’re going to look at measures of spread.
Now in order to do an analysis of a statistical sample or indeed to do a comparison with another
statistical sample it’s pretty much always necessary not only to have some kind of averages to
give you an idea of how big or how long or how many of something are associated with that
sample but also to have a good idea as to how spread out the values are, how much variation is
there in this sample.
Now in statistics in general there are quite a few very useful measures of spread and we’re going
to look at the main ones in this section. And we are going to look at alternatives for calculating
them in Excel 2019.
Now as part of that I’m going to need to explain one or two statistical concepts and terms but I’m
going to do that in a pretty straightforward way. So if you’re not too comfortable with statistics I
think you should still have a pretty good idea of what’s going on in this section.
So what I’ve done already is to calculate the median number of inquiries and policies and you
may recall that the way that we calculate the median is that we put the number of inquiries per
month in numerical order and we look for the one that is in the middle. If there are two in the
middle, so we’ve got an even sized sample, we take the average of the middle two. Now if you
did that with the contents of column B, so we’re talking B4 downwards, you would find out that
the median is 574, but of course we used the Median function in Excel 2019 to do that for us.
Now I also mentioned that apart from taking that middle value we could identify the quartiles
and the quartiles lead us to a very good measure of spread. So what I’m going to do now is
calculate the quartiles for the number of inquiries and the number of policies.
I also mentioned earlier on that there are actually two quartile functions, Quartile.inc and
Quartile.exc, and in a moment I’m going to explain the difference between them, but for the
moment let’s just calculate the quartiles and we’re going to start with the Quartile.inc function.
And my array will be Branch Inquiries and we get 418. All I need to do then for the first quartile
is repeat that. Identify the same name for the range of inquiry values and change the quartile
number to one and so on. So I’ll do that next and let’s see where we get to. So there are five
quartile values. If we put our inquiries in sequence the first 25%, the smallest 25% will be
between the zero and first quartiles, between 418 and 493, etcetera.
Now the quartiles are very commonly used in statistics and the measure of spreads that we can
derive from there is called the Interquartile Range. And we calculate it as the difference between
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the first quartile and the third quartile. There is an additional measure of spread that is called the
Semi-Interquartile Range, that is half of the interquartile range. So I’m going to calculate the
interquartile range and the semi-interquartile range. And I’m also going to put in the quartiles for
policies.
Now of course when you open this file in the course files folder you’ll see all of these formulae
and so on, but at this point in this section you may want to try these out for yourself.
So having completed those calculations, including the quartiles for policies I’ve also calculated
the interquartile range and the semi-interquartile range for policy sales. And if you’ve been
working along with this you should have come up with the same figures as the ones that I’ve got
here.
So the use of these ranges is pretty popular in statistics and I’m going to come back to those a
little bit later in this section.
Before I move on to talk about what is probably the most important measure in spread I want to
take a moment to talk about Inc and Exc, as I said I would.
So within the policy sales workbook I’ve included a worksheet called IncExc Demo and this is a
very straightforward demo of the difference between Inc and Exc. The data that we’re finding the
quartiles of are in B2 to I2. So the smallest number is 23 and then in rows four and five I’ve got
the quartiles calculated using Quartile.inc and Quartile.exc. The most notable thing is that if you
use Quartile.exc, so for example that the formula in cell C5, the quartile value of zero is actually
invalid. There isn’t a zero quartile this way. There isn’t a fourth quartile this way either. And in
fact the remaining values and remaining quartiles are calculated in such a way that although the
median is the same as with the Quartile.inc generally speaking the first quartile and the third
quartile will be smaller and larger respectively and therefore will give a larger interquartile
range.
Now I’m not going to go into the reasons for all of these differences. In fact there are many other
ways of calculating quartiles, but there are a couple of pretty good explanations of how these two
methods work. And if you search the web there are a number of papers that discuss the
differences between the two of these.
Now during the rest of this course when I need to use quartiles I tend to use Quartile.inc and
that’s what I will be using going forward throughout this course.
Now the quartiles, the interquartile range, etcetera are very important in descriptive statistics.
Not only are we wanting to describe a sample but we’re wanting to use the values in the sample
to perhaps predict what’s going to happen in the future, maybe to calculate some properties of
the population that we’ve sampled from or maybe to infer something else from that sample. And
in order to do that there is an even more important measure of spread and that’s called Standard
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Deviation. And there is also an associated measure of spread, that’s the Square of Standard
Deviation and that’s called the Variance.
Now in this section I’m going to concentrate on calculating Standard Deviation. And just to
confuse matters a little when you want to calculate standard deviation there are really two
options and it’s very important to understand the difference between them.
If I take a sample such as the number of inquiries over several months in this branch and I work
out the standard deviation of this number of inquiries, which is a measure of how much the
number varies, then I can either calculate that standard deviation as the standard deviation of the
sample or I can calculate it in such a way that I’m trying to estimate the standard deviation of the
population that the sample has come from.
So let’s suppose you were working on a production line in a factory and you were measuring the
length of objects you were making or the weight of objects you were making. If you say took ten
products off of that production line you might either say what’s the standard deviation, how
much do these vary, or you might say using the values from these ten what’s my estimate of the
amount of variation in the underlying population? Now using the correct one of these from a
statistical point of view is very important. And in Excel 2019 there is a function for each. If you
wanted to find the standard deviation of a sample itself the function you use is STDev.p and all
you would need to do in this case is specify the name of the range. So that would be Branch
Inquiries. So let’s do that.
And now we just need to specify our named range and we know it’s Branch Inquiries. I’m going
to show you a little extra tip on how to bring up those named ranges. If you press your F3 key it
will bring up any named ranges you have in the workbook. So let’s select Branch Inquiries and
there we go. Let’s take those decimal places down. So that’s the standard deviation.
If on the other hand I want to calculate this standard deviation and use it as an estimate of the
population standard deviation I use a slightly different function and that is STDev.s, so let’s try
that. And again F3, Branch Inquiries, and let’s roll those decimal places down again. And I’m
going to do the same for policies. Let’s now take a look at a specific example of how we might
use these descriptive statistics.
I now have two sets of sales figures. The first set columns B and C for the Orlando branch and
then second set, columns D and E are for the Tampa branch. And for each case I have details of
the number of inquiries and the number of policies as before. And if you quickly glance down
the list you definitely get an idea that Orlando does a lot more business than Tampa, but it would
be very helpful to be able to actually put some solid figures or some solid evidence together
about the difference in the amount of business they do.
So what I’m going to do is calculate the mean over the allotted period for both branches and I’m
also going to work out the standard deviation and the interquartile range.
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And here you can see the results of these various calculations. I would suggest that you take a
look at Policy Sales 5. Make sure you’re familiar with the formulae that are in use here.
If you really wanted to do an analysis of one of the branches results and in particular if you
wanted to compare the two branches there are various statistical techniques that you could apply,
but just at a very superficial level if you look at the mean values, for example, generally speaking
on average Orlando has about twice as many inquiries and twice as many policies issued as
Tampa. Having said that whereas with Orlando the number of inquiries compared to Tampa is
well over twice, the number of policies is less than twice as many as Tampa, which sort of
implies that Tampa although it’s a branch dealing with less inquiries and less policies they seem
to be more successful at turning their inquiries into policies.
The other thing to note is that if you look at the level of spread in the case of standard deviation
for inquiries for Orlando it’s 64.5, whereas with Tampa it’s 49.25. And given that for inquiries
there are well over twice as many inquiries in Orlando than there are in Tampa there seems to be
relatively speaking more of a spread in Tampa inquiries compared to the actual number of
inquiries. The same is true of policies as well.
It’s also interesting to compare figures like the semi-interquartile range in each case with the
standard deviation. Although as I mentioned earlier on in the section in terms of formal statistical
analysis standard deviation is a measure of spread that is used more frequently than interquartile
range and semi-interquartile range.
So that’s it on the use of statistical functions for description. In the next section we’re going to
look at Forecasting, so please join me for that.
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Video: Statistical Functions for Forecasting – Part 1
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at functions for Forecasting.
Now very often when we’re talking about Forecasting we’re talking about looking at what is
going to happen as opposed to what has happened so far, but also the functions we’re going to be
looking at can work in a more general sense as well and I’m going to look at the more general
sense in this first section because I want to look at a few of the most commonly used functions
without implying that these functions are only used in relation to things that change with time.
Having said that quite a few of the examples we’re going to look at will involve variables that
will change over time.
So let’s start off in a fairly general sense. I’ve got here in columns B and C some values of two
variables, X and Y. And if it helps you to think of the contents of column B as the months of the
year and the contents of column C as say sales figure in a store then that’s probably quite a good
way of thinking of those two columns.
And just to give you an idea of what I mean by Forecasting the question is this. Given those
values in X and Y what value of Y would I get if X were 13? Now you might look at the figures
in column C and say, “Well I don’t really know.” The values of Y tend to be going up but they
don’t seem to be going up in any straight and even fashion. What we need to do is find a function
which will predict or forecast the value of Y when X is 13.
Now there are many possibilities here and what I want to do first of all is explain what I mean by
independent and dependent variables. And in this instance X is an independent variable and Y is
a dependent variable. What we mean by this is that X is something that we can control or
measure directly or we can predict absolutely. So I didn’t have any trouble putting 13 into cell
B15 because X is the independent variable. It’s clearly progressing in an even fashion. Whereas
Y is not progressing in an even and predictable fashion at all.
Now there may be some dependence of X and Y and indeed it may be the case that as X gets
bigger Y gets bigger. But it doesn’t necessarily mean that the increase in the values of X is
causing the increase in the values of Y.
So let me first of all plot a little graph of X against Y of the known values. And there we are.
That shows you the figures for X and Y and if I were trying to predict a value for X=13 one of
the ways I might do this is to look at the existing graph and try to work out what that relationship
is. So we try to model the relationship between X and Y and one of the most common ways to do
this is to look at all the known values and to draw a straight line which basically cuts through the
middle of that graph. And use that straight line to predict a value when X=13. And that’s what
we’re going to do in just a moment.
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Before we do that I’d just like to emphasize something. The forecasting that we’re doing here,
the prediction is of one dependent variable, in this case Y, against one independent variable, in
this case X. But in fact within Excel 2019 there are facilities for performing this regression using
multiple variables.
So we are really only looking at the most straightforward case, although to be fair the most
straightforward case is the case that is used by most people most often.
So let me just delete my chart for the moment and let’s go back to my numeric values and work
out what to put here when X=13.
Now we’re going to look at three different ways of doing this and hopefully all of the different
ways are going to give us the same results. And the first way that we’re going to look at this is
I’m going to take you back to your high school mathematics and talk about the equation for a
straight line.
Now the equation for a straight line is Y=MX+C. And there are two functions in Excel 2019 that
can calculate from a set of values, XY pairs, the values of M and C that best represent that set of
XY pairs.
The first of those functions is the Slope function and this will give us a predicted value for M. so
I’m going to calculate the value of M in cell E4 and I’m going to use the function equals, Slope.
And you’ll notice it has two arguments, known Y’s and known X’s. For the known Y’s it’s going
to be C3 to C14 and I’ll put in the known X’s as well. And let’s use the Functions dialog box. So
there is my value for M. And to find the value of C I use the Intersect function and that function
has the same arguments. So if I wanted now to work out the value of Y when X is 13 all I would
need to do is put in here equals, M, which is essentially cell E4 and let’s make that absolute,
multiplied by X, which is B15, plus C which is cell E5. So my predicted value is 127 using that
method.
Now let me just predict a little further on. Let’s say we’re going to predict five values. So I’m
going to just fill down and there are my predicted values.
Now when I said that I’m going to show you three ways of doing this the second way is different
but actually amounts to doing exactly the same thing as the first thing because in Excel 2019
there has been for some time a forecast function which actually performs the same linear
regression, the same straight line fitting to the available X and Y pairs that we’ve just done by
calculating M and C for the best fit line. But this function forecast bundles the whole operation
into a single function.
Now in Excel 2019 that single function forecast has been superseded by a more specific forecast
function called Forecast.linear. But Forecast.linear basically does what I just described. It
forecasts values of X based on known X’s and Y’s on the assumption that there is a linear
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relationship between X and Y and that you’re using the best fit against the existing X and Y
pairs.
So in C15 what I will type is equals, Forecast and we’re going to select this one, Forecast.linear.
And in this case what I put first is the X value which is B15, then I need my known Y, so that’s
C3 to C14 and then my known X’s, so B3 to B14. And let’s see what we get. Hopefully that’s no
particular surprise. Let me fill down and of course we finish up with the same values.
The third option is the use of the Trend function, which we use an array function and therefore
we can apply an array formula.
So if I want to predict the values from C15 to C19, so that’s Y values corresponding to X=13 up
to X=17. If I select the range of Y values that I wish to calculate and use the Trend function the
Trend function uses a set of known Y’s, so in this case C3 to C14, a set of known X’s, so B3 to
B14, and then finally the new X’s, so this is all of the X’s that I want to calculate. So that’s
basically B15 to B19. And then we have a value, a constant value of B. Now sometimes when
you’re fitting a line to some data it’s a requirement the intercept, the C, is a zero. Now if you
want to set it to zero then you would set this final value to false, but if you want it calculated in
the normal way as an intercept you set it to true. And of course because this is an array formula
in order to complete that I do Control-Shift-Enter. And there is my full set of values.
So there are three options for doing straightforward linear regression with a single dependent
variable and a single independent variable. In the next section we’re going to look at some more
powerful functions that cannot only do this type of prediction for us but can also tell us how
strong the relationship we are using as the basis of predictions are. I’ll see you then.
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Video: Statistical Functions for Forecasting – Part 2
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to continue looking at forecasting and we’re going to be looking at linear regression,
but in this case we’re going to use the Linest function.
Now the Linest function offers a number of advantages and the first of them that I’m going to
concentrate on is not only can it forecast values for us but it can also indicate how likely it is that
those forecasts are going to be good forecasts. It does this by evaluating how close the model that
it’s using is to the observed values that we’re providing it with. The second advantage is that the
Linest function can be used in multivariant regression.
In this section I’m going to demonstrate the Linest function with a single independent variable
and a single dependent variable. And then in Exercise 04 you’re going to do some multivariant
regression. But don’t worry about that too much at the moment because hopefully you’ll find it
more straightforward than it sounds.
Now on the very subject of it being a little easier than it sounds although I’m going to explain
quite a few aspects of this as we go along I’m also going to refer you to a page in the Excel 2019
Help that explains what’s going on in quite a lot of detail.
Now if you’re not particularly interested in statistics or your math is not quite up to scratch you
really don’t need to worry too much about all these details. What we really need to be able to do
is apply the method and the Help sets up pretty much how to apply that method.
Now referring back to the preceding section the first method that I showed you there involved
finding the slope and the intercept for the best fit straight line through some pairs of values. And
pretty much that’s what Linest does as well. It gives you a slope and an intercept. But it can give
you multiple slopes based on the use of multiple variables. So I could have, for example, a
number of independent variables and there will be a slope associated with each of those.
Now when we actually use the Linest function we apply it as an array formula. And before I use
it I need to know how many rows or how many columns I need to select.
Now the number of columns will be the number of independent variables plus one. So in this
case X is my independent variable and therefore I need two columns. The number of rows I
need, well I would need one row for the slope value and then if I want all of the additional
underlying statistics I need four rows for those. I’m going to look at those statistics so I’ll need a
total of five rows, one for the slope and four for the statistics. So I’ll need to select an area that
has two columns and five rows so I’m going to select E3 to F7. Now I’m going to use the Linest
function.
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Now the first value that I put in there are the known Y’s. So that is C3 to C14 and we’ll make
those absolute. Next I put in the known X values. So that’s B3 to B14. The third value is the one
we talked about in the previous section and if we expect to have a non-zero intersect we set this
to true. And the fourth argument indicates whether we want the additional regression statistics or
not. Now we are going to look at those additional regression statistics so that’s going to be true
as well. Having entered Linest and bearing in mind that this is an array formula we need to do
Control-Shift and Enter and there are my values.
Now the first thing to note is that E3 and F3 hold the slope and the intercept. So if all I want to
do is to predict the value of Y when X is 13 I can use one of the methods that I showed you in
the preceding section. And fill down.
And once again the same values have been predicted but what’s particularly helpful and useful
here are the other values, the ones in the range E4 to F7. And in order to understand particularly
the contents of E5 we’re going to go and look at the Help for the Linest function.
Now there are quite a few things I want to point out about the Linest function as it’s a very useful
and important function in Excel 2019. And the first thing to point out is that you can use it with
other functions to model relationships that are not straightforward linear relationship.
So as it says there you can include polynomial, algorithmic, exponential, and power series
relationships. Now this has to be done in a particular way and there is more information about
this in this Help topic. I’m not going to cover that in this course but you may be in a situation
where you have a relationship that is not a simple linear one, where there is some element of it
that includes one of those other types of relationships. Well Linest can cope with that kind of
situation as well.
Now in the preceding section we looked at the straightforward Y=MX+C. It’s normally denoted,
although in the Help here it’s Y=MX+B but B is the intercept. Well the situation with Linest is
that you can make Y dependent on many X’s. And if you do make it dependent on many X’s
then for each X there will be a slope. So for example, in Exercise 04 I’m going to give you some
data with two independent variables in it, two X’s, and you’ll get two slopes. But more on that
later on.
Now when you use the Linest function, I’ve already talked about the syntax and you’ve seen one
use of it already. There’s a further explanation of it there and in particular it covers an
explanation of the multivariant situation which is going to be particularly important in Exercise
04.
Now also there’s a list of statistical terms, which are very familiar to statisticians but probably a
mystery to most other people. So terms like F Statistic or the number of degrees of freedom. If
you are a statistician or you understand these terms they’re pretty well explained in the Help.
And related to that block of numbers that I referred back to in our sheet Regression Functions 04.
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Well what I really want to look at here is R2, the coefficient of determination. And what happens
with the coefficient of determination is that it compares estimated and actual Y values. Now the
closer to one the better the correlation. And by correlation we mean in simple terms how well the
line fits against the data we first provided. If the provided data was an absolute straight line
already then the coefficient of determination would have a value of one. If all the values seem
random and unrelated the coefficient of determination will have a value of zero or close to zero.
So what you’re looking for, for a good match is a value that is near to one. Now with these other
statistics you may or may not be interested in them.
The sum of squares, the regression sum of squares, again I’ll come back to that in a moment just
for information as I think it’s something worth knowing about. But in terms of identifying what’s
in that array of numbers this little diagram is the important one because it shows you what goes
where. Now in our case we only had one independent variable so we only had two columns. And
column A in that diagram, that’s our slope value in row one and the value in the third row in
column one is R2.
Now below there is a whole load of remarks about how this works and how you can interpret
things and so on. So if you are interested it makes a very useful and interesting read.
Now let’s look again at that diagram because we are interested in the first column, middle row.
Now the value we have in there is 0.89 and the value of 0.89 is pretty good. That’s a relatively
high correlation. So what we’re being told there is that there does seem to be a reasonable
relationship between the Y values and the X values. It’s not brilliant but it’s about 90%, which is
pretty good.
Now there is one point I said I would come back to and that’s the sum of squares. I’m not going
to explain this in any great detail. There’s actually quite a bit of detail on that Help page but one
relatively straightforward way of thinking of how it works is as follows.
If you look at each of our X values here, so one, two, three, four along the horizontal axis and
with each of them go up to the graph and the dotted line, which is the best fit straight line. For
each value of X you will see there is normally a slight discrepancy between the value on the blue
line, which is the observed Y value and the value on the dotted or best fit line. If you work out
what the discrepancy is between the Y value, so that’s the blue line and the dotted line, and you
square that amount and you add all of those discrepancies up the way that the best fit is worked
out is to make the sum of those square as small as possible. So you’re basically working out how
to fit a straight line through those points such that the sum of those squares is as small as possible
and that’s how the dotted line finishes up where it is.
That’s a somewhat oversimplified explanation of it but it will give you some idea of how the best
fit line is arrived at and it will also explain how, for example, this coefficient of determination is
calculated because it’s calculated using a formula based on that sum of squares.
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Now in fact all the documentation you will see that sum of squares referred to as R2. Statistically
it’s more accurately referred to as R2 and in the case of linear regression R2 is actually the square
of the correlation coefficient. And basically you want R2 to be as close as possible to one.
So that’s it for this section, please join me in the next.
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Video: Exercise 04
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
I’m setting you Exercise 04. And in Exercise 04 you’re going to do some multivariant linear
regression.
There are two independent variables, month and rainfall in columns B and C, and in column D
we have the dependent variable, the number of umbrellas in store.
So basically what I need you to do is use the Linest function to come up with a prediction for
how many umbrellas will be sold in months 13, 14, 15, 16, and 17, dependent on the rainfall
figures for those months that you can see in column C.
My answer for that is in the workbook Exercise 04 Answer. As you can see I have a coefficient
of determination there of 0.87, so about 87% which is pretty good.
One thing I didn’t mention earlier on in this course which is actually quite important, when you
are creating the array to put the array formula for Linest into it doesn’t matter if you select an
area that’s too big because any cells that Linest doesn’t need or use just get an N/A put in them.
So although you can calculate, as I explained in the course, exactly what area you need, in this
case I’ve selected F3 to H7, if you select an area that’s too big it really isn’t a problem.
So that’s Exercise 04. With any luck you’ll end up with the same predictions as me for the
number of umbrellas sold. I will see you in the next section.
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Video: One Click Forecasting
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at one of the newer features in Excel 2019 and this follows on really nicely
from our sections looking at forecasting because the new feature is what’s called One Click
Forecasting. Now it’s not really one click forecasting. It does take a few clicks, but it is pretty
impressive, a fairly straightforward facility for forecasting time-based data. And what I’m going
to do in this section is give you a run through of a very straightforward example and also refer
you to the Help section which runs through the main features of this one click forecasting.
Now first of all let me just emphasize the point that this is intended for time-based data. And in
theory the dates for the data you can see in column B there in the sample I’m going to use, the
dates should be evenly spaced. So I have January the 1st, February the 1st, etcetera. And these are
sales figures. And for each date there are, so for instance for February 1, 2015 the sales figure in
column C is the total of the sales for the preceding month. So you can see that over time sales for
this particular company are increasing.
Now this is typical of the sort of data we were using earlier on for doing forecasting but with one
click forecasting you can get an awful lot of information for a very small amount of effort.
Now I talked just now about these dates being evenly spaced. These are spaced out month by
month. You can actually have gaps in the data. They need to be fundamentally evenly spaced,
but you could have a month or two figures missing. In fact you can have up to 30% of the date
points missing and this will still generally do a pretty decent job.
So let’s do a run through now of one click forecasting with that data.
Note the last month I’ve got there is June 1, 2016. Let’s say I’m to forecast sales up until the end
of August. So we’re looking at the sales figures on September 1, 2016.
First of all let me select the data. And now on the Data tab in the Forecast group there is a
Forecast Sheet option. And that brings up a dialog, the Create Forecast Worksheet dialog.
Now you have a couple of basic choices to make here. If you want to see a line graph or a
column chart and basically if you look at the column chart first the blue columns indicate the
actual data and the orange columns indicate the forecast values. You can probably just about
make out the little vertical lines through the top of each column which indicate the range in
which the forecast might fall. And in fact if I go back to the line graph you can see this sort of
funnel effect there, the lower and upper thinner lines here representing the lower confidence
bound and the upper confidence bound for the sales.
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Now I just said I’m going to forecast up until September the 1st. So I’m going to set the end date
for the forecast just here. And then I also have a number of other options. Let’s take a look at
those other options.
So I’ve already set the forecast end date. I can also set the forecast start date, by default it’s using
the final date in my actual historical data. And it is well worth reading the notes in that Help page
I referred you to on forecast. Refer to the forecast start date as there can be some advantages to
setting a start date before the end of the historical data. And then you can see how well those
predictions match your actual measurements, and they should match them very well.
Having said that obviously if that reduces the number of historical data points that you’ve got
then it may in turn harm the prediction. So it’s a matter of achieving a balance.
The confidence interval is next. You can switch this off and if you look at the line graph while I
do that there’s now no confidence interval. Now what that confidence interval means is that in
this context 95% of predicted values will fall within that funnel. If you reduce the percentage you
would find that that ban would get narrower and narrower. And with a narrower band to aim at
less values would fall within the predicted range.
The next important option is seasonality. If you’re dealing with seasonal data then you can either
tell Excel 2019 to detect seasonality or you can set it manually. Now what we mean by
seasonality, for example, is if we’re dealing with monthly data and over the course of a year
there tends to be a monthly pattern then we would consider our cycle in this case to be a year and
the number of intervals in that cycle to be 12. So we would manually set a value of 12 for
seasonality. On the other hand on a yearly sales cycle if you believe that you basically follow the
four seasons of the year you might set that value manually to four instead. Generally speaking
when it comes to detecting seasonality you really need two complete cycles for that to work
successfully. Obviously in this case we only have 18 months worth of data so it’s ability to detect
seasonality is going to be severely restricted.
Finally on the left hand side of the options we have Include Forecast Statistics. If you check this
box in the resulting forecast worksheet you’ll have a lot of very technically advanced statistics.
So again if you’re not a statistician and you’re not particularly keen on dealing with things like
exponential smoothing algorithms then you might want to bypass the forecast statistics. But if
you are interested check that box and you’ll get some very interesting statistics on the forecast
worksheet as well.
On the righthand side of the options you have the timeline range and the values range, and then
again two more important options. If you have missing points you can either ask Excel to
interpolate those values, so if you say had a months worth missing it would look at the values
either side of the missing month and work out its best guess. Or you can replace them by zeros.
Now obviously in the case of our sales replacing with zeros would pretty much confuse things,
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but there are situations where you’re measuring over time where replacing a value with zero
might be more appropriate.
And then finally you can in certain situations have multiple readings on the same date. And this
may, for example, happen in meteorology when you are taking measurements of rainfall in
different sources. In that case where you have multiple values for the same date you can average
the values. Average is the default, or you could process them in any of these ways. For example,
you could use the Max or the Median or the Sum. We’ll stick with the default which is Average.
And there we are. As I mentioned before you couldn’t really call it one click forecasting but it
didn’t involve too many clicks and you get not only that nice graph but you get a table showing
the historical data and the predicted values. Note the first forecast is June the 1st which is also my
last historical point. And you have the values in the lower confidence bound and the upper
confidence bound as well.
Note that the contents of this sheet can also be formatted in the normal way. So if I wanted to do
some work on the chart I could select it and do all the normal kinds of formatting.
So that’s it one click forecasting. We just have one more section now on statistical functions and
that’s statistical functions for inference. Please join me in the next section for that.
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Video: Statistical Functions for Inference
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. So far in these
sections on statistical functions we’ve looked at descriptive statistics where we summarize
statistical data. And we’ve also looked at prediction or forecasting. In this section we’re going to
look at statistical functions for inference. And typically when we’re looking at inferential
statistics we mean that we take a sample of some sort and on the basis of that sample we make
statements about the population from which that sample has been taken.
Now I’m going to base this section on a very straightforward example and in this example a
doctor surgery have taken the heights of a number of female patients. The heights are shown in
inches in column B and what we’re going to do is use that sample to infer some properties of that
population from which the sample was taken and also to infer the likelihood of women having
particular heights within the population.
Now in doing this I’ll be making quite a lot of assumptions and if you have a reasonable
knowledge of statistics you may be familiar with some of those assumptions and some of the
issues that arise. But one of the main assumptions I am making is that given a particular doctor’s
practice and the area that it covers that sample is big enough to represent the population of all
female patients. And the second major assumption I’m making is that within the population as a
whole the heights of females are normally distributed. So that’s the familiar bell shaped curve for
distribution of heights.
Now if you don’t have a solid background in statistics you may listen to both of those
assumptions and say, “How can you be certain that those two things are true?” Well there’s very
rarely certainty when you’re dealing with statistics but there are tools and techniques that we can
apply in a situation like this one to establish with sufficiently high level of certainty that both of
those assumptions are true. And although I’m not going to go into those now we are going to
proceed on the basis that both of those assumptions are reasonable. So that’s a big enough
sample to represent the population and the population from which these heights have come from.
Now the sort of question I’m going to ask is this. What proportion of females within the range of
this doctor’s practice would be less than five feet tall on the basis of this sample data? Now
we’re going to use one of the other statistical functions to do this. And in order to apply the
statistical function we need the mean and the standard deviation of this sample. So you know
how to calculate those but I’m just going to do those again.
So there’s the mean. And for the standard deviation we’re dealing with a situation where we’re
going to use a sample to estimate the standard deviation of the population from which the sample
was taken. So we’re going to use the STDev.s function, as I explained earlier on. So there we
are. That’s our mean and standard deviation.
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We’re now going to calculate the probability that a woman chosen at random from this
population will be less than five feet tall.
Now the function we’re going to use to calculate this is one of the normal functions. And if you
look at the list of normal functions there are eight of them. And the first four are the ones that we
normally use, whereas the old four are the ones with the yellow triangles. These are the ones that
the new four have replaced.
Now the function we need is the very first one and we specify first of all the value of X, the
value that we want to find the probability that a member of the population chosen at random will
be less than. And that will be five feet, which is 60 inches. The mean height is in E2, the standard
deviation is in E3, and that just leaves us with two functions, true or false. True uses the
cumulative distribution function and false uses the probability mass function. Now there’s a very
important distinction between these two and the true cumulative distribution function is the one
that we use for continuous variables like height. If we were dealing with a discreet variable
where you could have exact values, so these are things that are accounted rather than measured,
we would specify false here. So in our case this is a continuous variable so we would need the
cumulative distribution function. So the value we need here is true. And we find that on the basis
of our sample the probability that a woman is less than five feet tall is 0.2, which is 2%.
Just as an item of technical information with a continuous variable like height as far as statistics
is concerned the probability of being exactly five feet tall is zero. So if you said what’s the
probability that a woman is less than or equal to five feet the answer will be the same figure.
So what about the probability that a woman is more than five feet tall? Well given that all
women will either be less than or more than and I ignore the equal to for reasons that I just said,
then if 2% of women are less than five feet tall 98% must be more than five feet tall. So
expressing this as a probability, a number between zero and one the probability that a woman is
more than five feet tall is actually one minus E5. And the answer is 0.98 as you would expect. So
on the basis of one probability less than we can work out the probability of greater than.
What about the probability that a woman is less than six feet tall? So we’re going to use the same
function again. This time the X value is six feet and that is 72 inches. And we find that 95% of
women are less than six feet tall. And of course you know now how to work out the probability
that a woman is more than six feet tall.
Now what about the probability that a woman is between five and six feet tall? Well the way that
we work out probabilities between two values is by subtracting one from another. If we know
that 95% of women are less than six feet tall and 2% are less than five feet tall then the number
between those two will be the 95% figure minus the 2% figure. So the probability that a woman
is between five feet and six feet tall is going to be equal to E8 minus E5. That gives us a figure of
0.93 or 93%.
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Now there is a different sort of question that we can answer using these functions and the
question I’m going to ask this time is what is the height that 25% of women are less than? In
other words what is the woman’s height lower quartile? Now when I chose the Norm.dist
function just now you might have thought to yourself, “Well why did you choose that one and
not one of the others?” Well we’re now going to choose one of the others because the Norm.dist
function finds a probability when we know in this case a height.
The Norm.inv function is the one that gives us the height when we know the probability. So
essentially the inverse. So we want equals Norm.inv. Now the probability we want is 0.25, the
mean is E2, and the standard deviation is E3. So the lower quartile height is 64.4 inches.
Now let me do the same thing for median and upper quartile. And there we are. Lower quartile is
just under 64.5 inches, the median is just over five feet six-and-a-half and the upper quartile is
just under five feet nine.
So the Dist function gives us the probability from in this case the height. Inv gives us the height
from the probability.
There were two other functions, Norm.s.dist and Norm.s.inv. These basically do the same job but
for what’s called a standardized normal distribution, which is a special case of the normal
distribution in which the values are scaled down to be in the range zero to one but we certainly
don’t need to use that here. If you’re going to look further into statistical inference it’s very
likely that you will come across that special case. In the mean time Norm.dist and Norm.inv are
going to do the job for you.
Now if statistical inference is new to you then you will probably be mainly dealing with normal
distribution cases but in fact Excel 2019 now can deal with a number of different types of
distribution and there are Dist and Inv functions for a number of different distributions. For
example, you can see here Binom.dist and Binom.inv for binomial distributions. And there are
various other distributions that you might want to look into, but for now that’s it on statistical
inference and statistical functions in general. So I will see you in the next section.
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Chapter 9 – Connecting to External Data
Video: Connecting to Other Workbooks
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. So far with
everything we’ve covered on the course we’ve been dealing with self-contained workbooks,
workbooks that have their own data within them. And even when we’ve needed to add data from
outside we’ve imported it into the workbook that we were using. But there are occasions where
you want to be able to have access to data from outside but on an ongoing basis. So rather than
import the data into a worksheet we want to be able to link to it from one or more workbooks.
And in some of those instances we may even be depending on what is in effect a real time update
from outside.
Now I’m going to cover three different scenarios here. In this section I’m going to look at
accessing data from another workbook, then we’re going to look at accessing data from an
Access database, and then in the third of these sections we’re going to look at accessing data
from the web.
Now as I said, in all three of the scenarios we’re going to be looking at situations where the data
is held outside of one of our workbooks. And in effect we’re not importing it. We’re leaving it
outside but we’re going to set up a mechanism whereby our workbook can get that data and
potentially be updated in real time with that data from the outside source.
Now in this first example that I’m going to use I’ve got some sales data from two South
American divisions of a company. One division based in Bogota and one based in Lima, Peru.
And for each division I have their sales figures for 2015. Now Bogota sales are on one sheet and
Lima sales are another sheet. And what I’m going to do is put together a summary sheet which
will combine these two sets of figures. At the moment all of the data is within a single workbook
and we are going to separate this into different workbooks a little bit later in this section.
So first of all let me put in the framework for this summary sheet.
Okay my framework is in place so what I’m going to do now is copy the figures from the Bogota
worksheet and the Lima worksheet. So for the Bogota sheet I’m going to select the sales, copy
them to the clipboard, Control-C, go back to the Summary sheet and paste into place, Control-V.
I’m then going to go to the Lima sheet and do the same thing. I’m going to copy, Control-C, the
Lima sales, back to the summary sheet but this time instead of paste I’m going to do a special
kind of paste, a Paste Link.
So if I go to Paste Special you’ll see right at the bottom we have a Paste Link. Now of course I
see the same numbers but now if I click on say cell D4 I don’t get the value 83 in the formula
bar. What I see in there is a link and the form of that link is the name of the worksheet it’s
referring to followed by an exclamation point or a bang as I like to call them. And all the bang
© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved.

Learn Excel 2019 Advanced
does is it separates the worksheet from the cell reference. And then finally we have the cell
reference C4. So that’s referring to cell C4 on the Lima worksheet.
Now I should point out that if a sheet name or a workbook name has a space in it the name of the
worksheet will have quotes around it in order to identify it as a single entity. So what I have there
is the standard format of link within a workbook. And when we separate this out into different
workbooks later on you’ll see the more complex link that arises.
Now as you may or may not be familiar with the effect of these links let me quickly demonstrate.
And the way I’m going to do this is to go to the View tab and I’m going to say New Window.
I’m just going to increase this up to 160%, then I’m going to go back to the View tab and select
Arrange All. I’m going to select vertical and OK. Now on the left hand side I’m going to go to
the Bogota sheet and again let’s just increase that up and on the left hand side I’m going to go
Bogota sheet and I’m going to change where it says 92 to 93. Just watch what happens in C4 on
the right. And of course nothing happens. It doesn’t update. But if I go to the Lima worksheet
and go to the first cell where it says 83 and change that to 85 look what happens to the Lima
entry on the right. Of course that has become 85 as well because we have that link in there. So
there you’ve seen how updating one cell on a different sheet in a workbook can update a linked
cell on a different worksheet in the same workbook.
Now I am going to split these into separate workbooks in a moment but one or two other things
to quickly show you which you may or may not be aware of. Let me just go to the summary
sheet on the right and clear out those Lima values. Let me make the same select on the Lima
sheet on the left and if you hover your cursor over the left edge of the selection but don’t left
click, right click instead and drag and drop that selection. And I can drag it across to the
worksheet on the right and when I release the mouse button I get a little menu and one of the
options is Link Here. So that’s a drag and drop way of setting up those links.
And one other little trick you may not be familiar with. If I copy the Lima sales figures as before
just using the keyboard shortcut Control-C, go over to the summary sheet and do a Control-V to
paste them you get a little menu down in the bottom right there. And of course you can access
your Paste Link button there as well.
So what I’m going to do now is to split this into three workbooks. The first workbook will
contain the Bogota figures, the second one the Lima figures, and the third one will be a summary
workbook and that’s going to use the figures from the other two workbooks but it’s going to use
them by linkage not by copy and paste. So let me just do that.
Having created those three separate workbooks what I’m going to do is open the Bogota
workbook and the summary workbook and paste link the values between the two.
So I have the two workbooks open so let’s select the Bogota sales figures, copy to the clipboard
and we’re just going to paste link those in. now notice the reference here from C4 in the
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righthand window. You can see that I’ve got the name of the workbook in square brackets, then
the name of the worksheet, then the bang or exclamation point, and then the C4 reference. So
with each of these cells I have a reference to a cell in a different workbook. If I make a change in
the February sales where I find that this number is maybe wrong, so I’m going to change that to
94, that will also be updated in the summary sheet on the right.
Now what I’m going to do now is close the summary workbook and with the Bogota workbook
still open I’m going to make another change. So I’m going to say that my March figure is also
wrong and I’m going to change it from 94 to 91. Notice I am doing this when the summary
workbook is closed and now I’m going to close this workbook.
Now what happens next is very important. What I’m going to do is open the summary workbook
without the Bogota workbook already open. Now the first noticeable thing there is that you get a
security warning. The reason you get the security warning is that as far as Excel 2019 is
concerned you’re opening a dangerous workbook because it’s a workbook that has a link to the
outside world. You’re probably fairly familiar with the dangers of opening workbooks that have
programming code in them but opening a workbook that has links to the outside world can be a
dangerous exercise as well. The good news is that in this case you know it’s not dangerous. And
the other good news is that once you’ve trusted this document you won’t get this warning again.
So we’re going to trust this document by saying Enable Content.
So what I’m going to do now is to close this workbook yet again and reopen it yet again. Now
this time instead of the security warning we get the regular warning. This workbook contains
links to one or more external sources that could be unsafe. If you trust the links update them to
get the latest data. Otherwise you can keep working with the data you have. So now you get a
choice of updating or you can say don’t update. So we’re going to update. And if you saw there
the March figure changed from 94 to 91 now that we have updated that link.
However this does raise another issue. Perhaps the whole point of this summary workbook is to
produce a management report and you want to be able to send this workbook to various people
but they won’t have the individual workbooks, the Bogota workbook or the Lima workbook.
You just want them to see the summary figures basically at a point in time. But what you can do
is set up this summary workbook so that it doesn’t prompt for those updates.
So on the Data tab in the Queries and Connections group you have an Edit Links button. Notice
the links are listed and the link we’ve got here is the Bogota workbook. There’s a small button in
the bottom left hand corner called Startup Prompt and there we have three options. So what
action do we want to take when this workbook is opened? The three options that we have are let
users choose to display the alert or not, don’t display the alert and don’t update automatic links
and don’t display the alert and update links. So if you don’t want the alert and you want the
updates to happen anyway you could choose that third option and you won’t get the alert. It will
just happen. The option we want though is the middle one, Don’t display the alert and don’t
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update automatic links. And click OK. Now I’m going to save this version, and of course if I
open this version I won’t get those alerts and I won’t get a security warning. If you have any
doubts about that then I suggest you use the files in the course files folder, perhaps put in the
Lima link as well and try going through those security steps I’ve just described to you to make
sure that everything works the way that I said it would.
So that’s about it on connecting to other workbooks except for two important points. One of
them is if you look at this particular link in the formula bar it’s a very long link, most of which is
taken up with the folder name. You can edit and type in link names. You don’t have to establish
links in the way that we’ve said. Note in this particular case those single quotes though. Because
there are spaces in those folder names it needs those quotes in order to be able to identify it as a
single entity.
And the other important point is that links when created automatically usually contain folder
names, a reference to a particular location of a workbook. And if you move workbooks around
that can really mess things up. So if you’re going to use linked workbooks it’s important to
either, for example, keep all of them in one folder and remove the folder names, just have the
workbook names in those links so that if you move everything around together they are still in
the same workbook and therefore don’t need the folder names to keep the source workbooks.
So those are a couple of things that you need to be aware of.
That’s about it for connecting to other workbooks. Join me in the next section where we’re going
to look at connecting Access databases.
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Video: Connecting to Access Databases
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. Now just in
case you’re thinking you may have stumbled into the wrong course here you’re actually looking
at part of an Access database and in this section I’m going to show you how to connect to data in
Access databases. If you don’t use Access, perhaps you don’t have any interest in it at all, you
may want to skip this section but several of the tools and techniques we use do apply to other
databases that you can connect to from Excel. So you might find this useful anyway. The
database we’re looking at is the Esprit de Tour database and it’s a tour company database that
was created as part of our basic Access 2016 course. If you haven’t studied that course I can
explain the Esprit de Tour database to you very quickly in terms of what we need in this section
of the Excel course.
Basically the hypothetical company, Esprit de Tour, run a number of trips and you’re currently
looking now at one of those trips, the Grand Canyon Family Rafting Adventure. And apart from
a description of the trip and information about it, including the countries visited, the level in
terms of comfort and luxury of the trip and specific tour dates there’s a dossier of information
and various other items related to that trip.
Now bearing in mind that many of you might not be Access users what I’ve done is just to open
up the Navigation pane on the left and that gives me a list of most of the objects that appear in
this database. These objects include tables, queries, forms, reports, and macros. The information
contained within this database is held in tables and each table is very much like an Excel
worksheet. So for instance, when it comes to a trip there is a table called TBL or TBLTrip and
the TBL prefix indicates that it’s a table. And if I open that up it looks just like an Excel
worksheet. And if you want to you can from an Excel workbook access this data in situ. So in
other words we can link to information that is actually held in an Access database from an Excel
workbook. One option of course would be to import the data into the workbook but in this
section we’re going to concentrate on connecting to the information in the database and creating
a live connection between the two.
Now amongst the tables in the Esprit de Tour database we have this one which gives information
about trips. We have another one here, TBLTour, and if I open that you’ll see that this holds
information about specific instances of trips. Then we have another one such as TBLCountry and
Trip Type and so on.
Now an Access database is an example of what we call a Relational Database. And the reason
why it’s called a Relational Database is that you can create relationships between the tables. And
I’m going to show you now a graphical representation of the relationships within the Esprit de
Tour database.
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So if I go to Database Tools one of the options there is relationships. And that shows the
structure of the database in terms of the tables. Now let me quickly explain this diagram, explain
what we’re looking at.
One of the key elements of this database is the first table I showed you there, the Trip Table,
TBLTrip. And notice there is a line between TBLTrip and TBLTour and it says one at one end
and infinity at the other end. What that means is that for each trip there may be many tours. Each
tour is an instance of a trip. Each tour will normally be that trip starting on a particular date, so if
you go into a travel agent and book a trip you would need to decide which instance of that trip
you were doing. Normally that would be the start date of the trip. And we are referring to that
particular instance as a tour. Now it’s also the case that for each trip it can visit one or more
countries. So we have a line from TBLTrip to TBLTripCountry and through TBLTripCountry to
TBLCountry and this relationship says that a trip can visit many countries but also for any
country it can be visited by many trips.
Now don’t worry too much about the meaning of all of these relationships. I’m pointing this out
here because it’s a subject that will come up when we are looking at connecting to Access
databases from an Excel workbook in a few minutes time.
So now I’ve created a new workbook in Excel and I’m just going to access one of the tables in
that database first of all. So I go to the Data tab and in the left most group on the ribbon is Get
and Transform Data and I’m going to click the dropdown arrow underneath Get Data, I’m going
to select From Database and I’m going to select From Microsoft Access Database. Now I need to
locate that Access Database we were just looking at.
Now when you’re looking for Access databases the file extension that Excel 2019 will be
looking for is the .mdb file extension or .mde file extensions. These are the extensions associated
with older versions of Access and the ACDB and the ACDE that you see there are extensions
which are used with the newer versions of Access.
In this case it’s a relatively new file so we have the ACDB file extension on the end of the file
that we want to open. So I’m going to select the Esprit de Tour database and click the Import
button. And I’m offered a list of queries and tables. You can actually open Access queries in
Excel as well as tables.
Now for the moment I’m just going to open a single table and I’m going to open the Country
table. And click on Load. And there it is, a list of countries that are available in the Access
database. If I make any updates in the Access database they will be reflected here as well. So
basically I’ve got a live link here.
Now let’s look at one aspect of this connection. You can see here the list of countries. They start
in the second row with Antarctica and go all the way down to row 18 with Zimbabwe. Let me
quickly open the Access database again and this time I’m going to open the Country table and
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there are those same countries. Let me add a new country into the bottom. So I’m going to add
the UK. Let me close this database and go back to my Excel sheet and one of the options we
have here on the Table Tools Design Ribbon is Refresh. Let me click on Refresh and you can see
that the UK has now appeared at the bottom of that list of countries on the Excel sheet with a
connection to the Access database.
Now I’m going to talk a little bit more about refreshing workbooks when they’re connected to an
Access database in a moment.
Right. Now let’s run through a more advanced example. I’ve created a new worksheet, Sheet 2,
and I’m going to go back to the Data tab, I’m going to click on Get Data, from Database, and
from Microsoft Access Database again. I’m going to select the same Access database and click
Import. Now this time I’m going to select a number of tables. And in order to do that I need to
enable the Select multiple items checkbox. You’ll see once I’ve checked that I now get a set of
checkboxes where I can select multiple different tables and I’m going to choose TBLCountry,
TBLTour, TBLTrip, and TBLTripCountry. And this time I’m going to click the dropdown next
to Load and select Load To. Now automatically if I select more than one table this checkbox,
Add this data to the data model, is checked. And the default when I select multiple tables is to
get a pivot table report. But on this occasion I’m going to stick with the table option. And click
on OK.
Now one important thing to highlight before we continue on is this Queries and Connections
pane in the righthand side. You can see here we have our database listed at the top. And I just
want to highlight to you some of the properties. If you right click on your database and go to
Properties this brings up the Connection Properties dialog box and there’s lots of options in here
which will prove useful to you. So let’s run through a few of them.
One of them is that you can have Excel automatically refresh data on a timed interval. By default
that is 60 minutes but say if I wanted to have an automatic refresh of data every five minutes I
could go in and modify that. And what that means is that every five minutes it would check the
data in the Access database and see if it needs updating in the Excel workbook.
I also have another option here with this checkbox, Refresh data when opening the file. So I can
specify that every time I open this workbook I want to refresh the data from the Access database,
which is usually a pretty good idea.
There is a third checkbox here which is checked by default, Refresh this connection on Refresh
All. You’ll quite often once you start using external connections finish up in a situation where
you have the external data in a number of different locations and rather than go through and
refresh them one by one you have the Refresh All option up here in the Connections group on the
Data tab. So I’m going to leave those checked and I’m going to click on OK. And what I find is
that I now have a whole batch of new sheets and each of those sheets has one of the tables of
data in it. And it’s worth noting that in this case the data is held in tabular form.
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So having set up this connection I can investigate this connection further. For example, I can go
on to the Data tab and I can click Queries and Connections and you’ll see a pane open on the
righthand side. Let’s just make that a little bit bigger. And this pane gives me a list of my
workbook connections. So let me just select the latest one I’ve made here, TBLTripCountry,
right click and select Properties. I’m going to switch off the automatic refresh but I’m going to
leave on the Refresh data when opening the file. So let me just click on OK.
One final thing before we finish up. Let me just do one little update. So I’m going to go back to
my Access database and I’ve chosen the first GCA Tours entry there and you can see the price is
$4,080 and I’m going to make a very noticeable change. So we’re going to change this to $6,500.
I’m going to switch back to Excel and there’s the first of those GCA tours in Excel. Let’s do a
refresh and then you can see the updated price for that tour.
So that’s it on Access database connections. In the next section we’re going to look at getting
data from the web so please join me for that.
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Video: Connecting to Web Data Sources
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at connecting to data sources on the web. This has been a facility that has
been available in Excel for a little while now but over recent versions not only has it changed in
the sense that there have been some new ways of doing it introduced but the power and
flexibility of these approaches has also greatly increased.
So what I’m going to do in this section by way of an example is to get some live stock market
data and put it into an Excel workbook. Now there might be various reasons you might want to
do this. For instance you may be developing an application in Excel where you need to get the
latest value of an index or maybe the latest exchange rate. Maybe you’re doing something related
to travel and exchanging money. But it is a pretty straightforward thing to do. And as I said, the
main problem is finding suitable websites where you can get the indexes, exchange rates, that
you need without too much trouble.
So I’m going to click on the Data ribbon, the Get Data dropdown and I’m going to go to From
Other Sources and select From Web. And this will bring up the From Web dialog box which will
allow me to enter in a URL where the data resides. So basically the data that I want to bring in to
my Excel workbook.
Now I’ve already gone off and found a website that I want to bring in so I’m just going to paste
it into the URL box so you can see it’s Yahoo.com and it’s given me the world indices or the
indexes and I’m going to click on the OK button. Sometimes this can take a few moments to
connect but you can see now that it’s connected. And underneath the URL I have a couple of
items here and I’m going to click on the one that says Table Zero. And you can see there it’s
pulled through those world indexes. So I’m happy that that’s the information that I want to pull
into my Excel workbook and at the bottom I have a Load button and I’m going to click the
dropdown and select the Load To option.
So now Excel is asking me how I want to import this data. Do I want to import it into a table, a
pivot table report, a pivot chart, or do I want to only create the connection? Now in this instance
I just want to pull it into Excel and I’m fairly happy for that to come in as a table. So I’m going
to leave that default option selected. I’m going to select Existing Worksheet and you can see
there it says cell A1. And if you look on my worksheet you can see the marching ants are now
around cell A1. So that is where my data is going to go. And I’m going to click on the OK
button. And after a moment or two you can now see those indexes in my worksheet in a table.
So I have here in column B from the FTSE 100 and if I do Control-down all the way down to the
Nifty 50. And it’s pulled through all of those values that were available on that website.
Now having done that a number of things happen and one of the things that happens is that Excel
sets up a connection. And if you cast your eyes over to the righthand side of the screen you’ll see
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that we now have a pane running down the side which shows those queries and connections. And
you can see there it says Table 0, 35 rows loaded.
I also now have a Query Tools contextual ribbon. So if you cast your eyes up to the top of the
screen and click on Query you’ll see I have numerous different options that will allow me to
control this query.
Now one of the cool things when you set up a connection like this is that it does live updates. So
when these market prices change they will be updated live in my worksheet. And if you want to
force that change you’ll see that on the Query ribbon you do have a Refresh button. Now if I
click the Refresh button to refresh that background query you won’t see too much of a change.
And the reason why is that I’m doing this on a Saturday and all of the markets are currently
closed. But if this was a weekday and I clicked the Refresh button any updates that have been
made to those market prices will automatically feed through to my worksheet.
But I could go a step further than that and I could actually set this up so that they’re
automatically updated for me so I don’t have to come in and click that Refresh button. And that’s
what I’m going to do next.
So from this pane on the righthand side I’m going to right click on Table 0 and I’m going to
select Properties. I’m going to give this query a much more useful name. So I’m going to call it
Market Data and I’m going to set a couple of refresh values, one of which is to do an automatic
refresh on a timer. Now normally you’d set this according to how up to date you want these
values to be but for the purpose of this exercise I’m going to set it to a very small value, just two
minutes. And I’m also going to check the box that says Refresh data when opening the file. That
will ensure that whenever I open this file I will have the latest updates in my data. So let’s click
on OK. And you can see that change to the title has now taken affect in the Queries and
Connections pane on the righthand side. It’s now labeled as Market Data as opposed to the rather
innocuous Table 0. So again if this were a weekday you would see that after two minutes these
prices would update themselves.
Now I want to show you what happens if I come back to that workbook at a later time. Now I’m
going to open that same workbook again. So let’s click on File, I’m going to select Open and in
my list of recent I can see my file. I called it Connect to Web Data. So let’s open it. And when I
open it again Excel issues a security warning. Bear in mind we have external data connections in
this workbook so as usual it’s always worth giving some thought to this. So are you happy with
the content? And of course in this case I am.
Now because I changed the settings to Refresh on open, again if this was a weekday and those
markets were open it would have refreshed that background query and I would have the latest up
to date figures in my worksheet.
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Something that you do need to be a little bit wary of is that if you have a slow or intermittent or
indeed expensive internet connection you do need to be a bit wary of importing large complex
data feeds. The slowness or expense of your internet connection can sometimes make it an
impractical proposition. I’ve seen situations where somebody has tried to get large volumes of
data from the web updated every minute or two and it’s basically ground their internet
connection to a halt. So you do need to tailor your use of this feature according to the quality of
your internet connection.
That’s it for connecting to web data sources. In the next section we’re going to look in at an
example of Get and Transform, so please join me for that.
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Video: Get and Transform
Deborah: Hello again and welcome back to our course Excel 2019 Advanced. In this section
we’re going to take a look at Get and Transform. Now to some extent Get and Transform is a
progression from the earlier facilities to get data from the web.
The facilities from Excel 2010 to 2013 became known as Power Query and now Get and
Transform has really superseded Power Query in Excel 2016 and 2019. But it’s not just about
getting data from the web. Get and Transform enables you to get data from many different
sources, including many of the ones we’ve seen so far, such as getting data from Access or a
CSV file and transforming the data to suit your particular requirement. So that’s an overview of
Get and Transform.
And there are two subsequent steps which are combined when you create a data model and you
can combine multiple data sources. So you can maybe get some data from the web, such as the
current exchange rate, maybe get some data from an Access database, such as the cost of a trip,
and then combine them both to provide some additional insights into the underlying data. And
there is a fourth step in this process which is generally described as Share, where you can share
the data or perhaps use it in reports.
Now as I say, in this section I’m going to concentrate on Get and Transform. And following on
from the preceding section what I’m going to do is get some web data and transform it to make it
a little more suitable to my requirements.
Now in the next I’m going to set you Exercise 05 and in Exercise 05 I’m going to ask you to Get
and Transform some specific data related to the weather. In this particular section I’m going to
Get and Transform some sports data and just to make it a little more interesting for you, if you’re
going to work along with me you could try your local sports data. For example, this is a section
of the NFL table and I’m going to process some English Premier League results. But if you’re
interested in neither the British Premier League or the NFL then try some other tabular data from
somewhere on the web and you’ll probably find it will present some of the challenges I’m going
to face in this section and probably a few different challenges as well. But if you don’t
particularly want to use your own data you can just follow along with the English Premier
League data that I’m going to get and transform.
So we’re now looking at the Premier League table as it is today on the BBC website. The BBC
website is not known for moving things around too much so I hope that by the time you come to
follow this course the Premier League table will still be where it is, although of course the
position of the teams and the statistics will have changed. And what I’m going to do here is I’m
going to set up a regular feed from this table into Excel. Now fundamentally we’re doing a
similar thing to what we did in the preceding section.
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So having identified the page that contains the data that I want I’m now going to grab the URL.
So I’m just going to select it and copy it to the clipboard, Control-C. I’m now going to switch
back to a new Excel workbook and I’ve already called this workbook Get and Transform.xlsx.
I’m going to go to the Data tab and to the Get and Transform data group. I’m going to click Get
Data, go all the way down to From Other Sources and select From Web.
Now when I click on From Web it comes up with a dialog and it’s in that dialog that I paste or
type the URL containing the data. So I’m just going to do Control-V to paste and click on OK.
Now I’m going to warn you that when I do this if Excel successfully finds the page it will do an
analysis on that page and this can sometimes take a little bit of time. This isn’t only related to the
speed of your internet connection. Excel sometimes has a lot of processing to do to work its way
through the page. But we seem to be good here.
So when it’s finished analyzing the page this Navigator dialog box shows you what it’s found
and in this particular case underneath the URL you just have Document, which is some basic
document information about the page.
And then it lists another entity, Table 0. And you can see here in the preview pane on the
righthand side we have the English Premier League table listed underneath that Table View tab.
If you switch to Web View it will show you that webpage in that little preview pane as well. If
Excel picks up more than one table you will have the additional tables listed underneath the
URL. But we’ve only got one in this instance.
Now one thing you might notice here is that there seems to be some data that I didn’t see before,
like this column here where it says Team hasn’t moved. So this is I guess just an update on the
status of that particular team. That’s not actually listed on the webpage that we pulled the data
from. But if I scroll across you’ll see that the rest of the information is basically what I’m
looking for.
Now if you were getting data from a very large, very long page it may only show you part of it in
the preview, but in this case if I scroll across it looks like it’s got pretty much all of the
information that I’m interested in and some additional things that maybe I’m not so interested in.
So all I need to do is click on the Load button at the bottom and you can see now that that’s been
loaded into my Excel worksheet.
Now again it may take a moment or two to do that but when it’s finished you can see that the
data loaded, and there are some very important aspects of what you can see. One of them is that
it’s loaded into a table. So once again if you haven’t dealt with tables before you may need to
come back to this.
And it’s also created a query. If you look over on the righthand side you’ll see in the Queries and
Connections pane we have a little Query pane there. And also if you cast your eyes up to the top
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of the ribbon you can see a Table Tools set of tabs, the Design tab, and also Query Tools there as
well with a Query tab. And we’re going to look at that in just a moment.
But over on the right it’s also created a Workbook Query and this query is one that I can rerun at
any time in order to get updated results. So I could right click and select Refresh.
Now generally speaking Premier League matches happen at the weekend, occasionally during
the week but there wouldn’t really be much point to doing a regular update of this query, but I
might want to update it say once a week or I might want to go in and update it whenever I want
to look at the table. Fundamentally this facility has the ability to update this for me either
automatically or subject to manual operation by me.
Now apart from what you can see here in front of you, again if you cast your eyes over to the
righthand side, to the Queries and Connections pane, you can see we have our query listed here,
Table 0. If I right click and go to Properties you will see that familiar Query Properties dialog
box with its three tabs at the top, Usage, Definition and Used In. And what I’m going to do on
this occasion is not to set up an automatic refresh but I’m going to say Refresh data when
opening the file. So that means that every time I open this workbook I will try and do a refresh
and of course I’ve always got the option of doing a manual refresh anyway.
And one other interesting checkbox here is one that’s immediately below that one. If you’re
processing a large amount of source data and as part of the transform and combine operations
you are only finishing up with a small part of that data you can actually tell Excel that each time
it saves the workbook it can remove the external data. It doesn’t need to include those in the
workbook. And then the next time you load it you can reload the updated external data and you
will still finish up with everything being processed in the way that you want. That can drastically
reduce the size of your saved workbooks. On this occasion though the amount of data here is not
that great so we have no need to do that, but it is very useful if you are dealing with large
amounts of data.
So that’s Connection Properties. That’s my Connect or Get stage of Get and Transform. The next
thing I’m going to do is transform this data and in particular I want to get rid of some of the data
in that table that I don’t need and also fix one or two potential problems in the rest of it.
So as I pointed out just now the results of that query are in a table and we have the Table Tools
Design tab option there if I wanted to format the table or perform other things on it such as
removing the banding of the rows, etcetera. But if I click on Query and then Edit I can go into
the Query Editor which allows me to basically change what is produced by the query.
Now there are a number of things that I can do and one of them is to remove unwanted columns.
So let me select that first column and I can either right click and choose Remove or if you look
up on the Home ribbon we have a Remove Columns option. And I’m also going to remove the
Final column just here as well. I’m not so interested in that.
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So if I were to save this query as it is now and run it again next week that series of steps would
be carried out for me automatically because the applied steps are all being stored over here with
the query. If you look over on the righthand side you can see underneath Applied Steps it’s
showing me that I just removed columns. So that’s all being saved within this query.
So essentially as I perform each step if I change my mind about that I can click on the Delete, the
little cross just here, and that will undo those changes. And you’ll see that if I do that those
columns are back again. I’m going to remove those columns once again. If you want to remove
multiple columns at the same time just click to highlight the first one, hold down the Control
key, and click to highlight the Second one and then just remove those columns.
Another typical problem is that I may have something in a column that I don’t want but I may
not want to remove the entire column. I might just want to remove something from it. So for
instance here. I don’t particularly want the expression “Team hasn’t moved” in that first column.
So if I select the column one of the options I have on the Home ribbon is Replace Values and
that brings up the Replace Values dialog and I can say what I want to replace. So in this case it’s
the expression “Team hasn’t moved” and I’m going to replace it with a space or nothing in this
case. And you can see that’s applied that to that first column.
Now another thing I can do thing is change the sort order, for example. Now there’s a Sort group
here with Ascending and Descending options. If I select the Position column I could do a
descending sort to sort those teams or an ascending sort.
Now one other thing to be aware of when you’re dealing with data in the Power Query Editor is
that Excel 2019 will assign a data type to each of your columns. And you can see at the top here
most of the time it picks up the correct data type. So where we have Team you can see with this
little icon Excel has picked up that that is text. For these other columns you can see that it’s
picked up that they’re numerical values in those columns, which as I look across I can see that’s
all pretty much correct. However occasionally Excel will detect the wrong data type. So it’s very
important that you go through and check to make sure that the data types are all accurate. And if
they’re not you can just go up to the Transform ribbon and you can select the correct data type
from the dropdown.
There are so many different changes or ways that you can transform your data in the Power
Query Editor and I’ll leave that for you to experiment with another time.
Now when I finish making any other changes I want to make and click on Close and Load I will
have my updated transformed data. So that was an example of Get and Transform.
One of two things to emphasize there, that is of course the editing we’ve done doesn’t change the
source data in any way. It only affects the transformation that is performed on the source data as
part of this workbook query. And you can actually perform some incredibly complex
transformations and combinations, etcetera.
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And there is even a purpose built language called M that is used by the Query Editor that you use
yourself to do even more sophisticated transformations if you wanted to.
So that’s it for this section. We’re coming up now to Exercise 05 and I’m going to give you an
exercise a bit like this one, so please join me for that.
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Video: Exercise 05
Deborah: Hello and welcome back to our course on Excel 2019 Advanced. In this section I’m
going to set you Exercise 05 but Exercise 05 is going to involve getting some live data from the
web.
Now the way that I have done this is certainly not the only way you can do this and you may
well want to adapt this for your own location. But what I’ve done is to set up a workbook,
Exercise 05 Answer, and it’s got two sheets in it. The first sheet is called My Weather and in it
I’ve got some information about the weather in London. You can currently see it says Sunday 44
minutes past midnight and the conditions are passing clouds, quite cool and we have a
temperature of 5o Celsius. I’ve then got a couple of rows down from that what the highest
temperature worldwide is right now and what the lowest temperature worldwide is now. Now
those temperatures refer to world cities so there may be higher or lower temperatures away from
those cities.
This is going to be updated live. Now hopefully you will see the tick over. I’ve got it on a five
minute timer. And if the temperature in London changes you should see those changes on this
worksheet without me cheating by touching the keyboard at all.
Now where did I get this data from? Well I used a website called TimeandDate.com. And I used
data on world capitals.
Now I’ve edited that data so I’ve done a Get and I’ve done some basic editing on the query. And
I’ve edited the data for a number of reasons. One of the reasons is to do with temperature and the
other reason is to remove extraneous pieces of information. So if you have a think back to the
last section of the course you’ll get a good idea of exactly what I’ve done.
What I’m going to do in a moment is to show you the webpages that I got this source data from
but as you can see within the table we have capitals of the world, the day and time, columns four
and eight show the current weather conditions and columns five and nine show the temperature
in degrees Celsius. Let me go back to the first worksheet.
And what I have done is used some of the functions we saw earlier on in the course to locate the
weather in London from the table that’s created by the Get and Transform. The connection is set
on a five minute refresh and amongst the functions I have used there let’s look at the highest
temperature worldwide. So I’m going to click in cell F5 and you can see that I’ve used a Max
function. The Max function is applied to two ranges. Each range is a column in the weather table.
Now if you’re not used to using tables in Excel we’re actually going to start looking at tables in
the next section. So if you’re not comfortable with tables you can maybe do this exercise after
the next few sections on tables. If you are familiar with tables you will know how easy it is to
refer to a column in a table. And of course one of the biggest advantages of referring to a column
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in a table is that you don’t need to know exactly how many rows in it and you don’t need to deal
with changes in the number of rows.
So that is where I get the max temperature from. And of course a similar principle applies to
getting the Min temperature. And in terms of finding the time in London, the conditions in
London and the temperature I used VLOOKUP functions.
So let’s switch over and take a look at that website TimeandDate.com. There are a couple of
selections I have made there. So I have said sort by city and I’ve said show capitals. So this is the
capital cities of the world. And as I said, I had to do a couple of edits to this query and one of
them was to remove at least one extraneous column. And the other one is that when you import
this into Excel the temperature doesn’t come in as numbers. It comes in as text. So for instance,
the temperature in Abu Dhabi at the moment is 19o Celsius. So in order to find the highest one
we need to deal with converting that temperature from a text string to a number, the number 19
in this case. But based on what we covered in the previous sections you shouldn’t find that too
much of a problem.
Now if you wanted to try something as a bit of a further challenge you may want to try
something like making a list of the capital cities that have the highest temperature at a particular
time, and also maybe the lowest temperature at a particular time.
That’s the end of this section. I will see you in the next one.
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Chapter 10 – Tables
Video: Introduction to Tables
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to start to look at tables. And if you’ve not come across tables in Excel before you
might be a little mystified as to why we have tables at all in Excel as Excel data by nature is in
tabular form. But the advantage we have when we work with tables is that we identify a range of
cells on a worksheet as a table and that gives us additional features and functionality. The
additional features include the ability to be able to style a table using standard styles or indeed
modifying them to a style you need. And then amongst the additional functionality you get are
the ability to filter on columns, to very easily be able to change the number of rows in columns
and do things like auto totaling of columns.
Now in this first section I’m going to show you how to create tables from existing ranges on
worksheets and also introduce you to some of the features and functionality.
Now if all you want to do is create a table, if you click on the Insert tab and Table this brings up
a little Create Table dialog. And by default when you have no selection when you do this a table
will be create the single cell A1 which isn’t really going to be a lot of use to us. So let’s select a
range on the worksheet. So I’m going to select A1 to H17. I’m going to select my tables has
headers and click OK. And now I have a table created.
Each of the columns has a header. So you can see there column one, column two, column three,
etcetera. And I can start to put data into my table. But on this occasion I’m not going to create an
empty table like this. I’m going to take some existing data and show you how to change that into
a table with very little effort at all. So I’m going to close this workbook without saving it and
instead we’re going to take a look at the invoice we started working on earlier in the course.
Now one part of this invoice is suitable to become a table and that’s the Order Details section.
And if I did what I did just now and inserted a table by selecting the rows that make up the line
numbers I could create a table on that basis. But actually Excel is a bit cleverer than that and all I
really need to do is click somewhere within the range that I want to make into a table. And now
if I click on Insert and Table Excel has tried to work out what I want to make into a table.
Now if you look at the marching ants there you can see it’s got B6 to H11, which is a pretty good
try at that table. Notice that it hasn’t included the totals row. And in fact I could include that if I
wanted to but I am going to cover that in just a moment. So I’m going to stick with what Excel
has worked out for me. And now I have my table.
And notice that while you see it’s kind of grayed out there and note also the row numbers on the
left which are highlighted, 6 to 11, whilst the table is selected you’ll see the Table Tools Design
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tab up there on the ribbon and I’m going to look at some of the functions on the Design tab a
little bit later on in this section, but for the moment let’s just look at the table itself.
Now let’s look at some of the specific features of this table. First of all in the header row there is
a filter dropdown on each column. So if I only wanted to show items with a 10% discount I can
select the dropdown, deselect everything and just select 10%. So that can be a useful feature,
although to be honest when dealing with an order the ability to apply a filter is perhaps not quite
so impressive, but you’ll see a situation where it is a little bit more impressive in just a moment.
Now I mentioned just now the Table Tools Design tab. Let’s click inside the table and look at
some of the features on that tab.
The table is automatically given a name and I can change that name. So I don’t particularly like
Table 1 so I’m going to change this to Order, Order Details Table, and press Enter to confirm
that. That’s now the name of my table and if you look on the righthand end you’ll see a Table
Styles gallery. And I’m going to look at styling tables in more detail in a later section but for the
moment you can see that a style has been applied and it’s the one highlighted, the third one along
in blue.
And of course this is a live preview so if you hover your mouse over any of the other styles you
can see them applied in the worksheet below.
To the left of the Table Styles note the Header row. If I want to turn the header row off I can just
by unchecking that box and that doesn’t look particularly great so let’s turn that back on again. I
also have banded rows. That determines whether the style is banded rows or not. And sometimes
banded rows make it easier to read across a table. You can if you want to have banded columns
as well. It can get a little bit complicated if you turn those also so let’s turn those off. You also
have an option here to toggle off or on the Filter button and I’m going to turn that off because we
don’t really need it in this particular example.
Now one thing that isn’t switched on is the total row. Let’s have a total row in this table. Now
that doesn’t mean that it includes the total row that we had before. In fact I’m going to get rid of
that total row in a moment. But in the total row now note the word Total in the left most cell. I
can have a number of different types of total and some of the columns will have no total. For
instance there isn’t too much point in totaling the unit price of the discount column. But if I did
want the total price I can click in the cell and you can see a little dropdown to the right. And that
gives me alternative totals that I can include in an item in the total row in a table. Now at the
moment I have Count selected but I could also do a sum. And of course that gives me the same
number that I had before, $199.59. And if I wanted the total number of items in the quantity
column I could do a sum there as well because of course it’s a sum of the number of items and
that gives me the eleven that I had before.
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So now I feel fairly confident that I can just get rid of the old totals row by just right clicking and
selecting Delete.
Okay I’d just like to change the table style a little bit because it’s not really apparent to me just
looking at that table that the totals row is part of the table. So let me click on the dropdown in the
Table Styles gallery and select one that include a totals row.
One other thing to point out here is you notice the column headers on the Excel sheet. So A, B,
C, D, etcetera. And you notice the column headings in the table. If you have a very long table
what can happen is that the header can disappear and all you see is B, C, D, E, F. But actually
that’s not what happens at all. And what actually happens is pretty clever. So let me scroll down
here. Watch carefully and you’ll see that the B, C, D, E column headers have been replaced by
the actual names of the columns within the table until of course I scroll back down again. So
that’s a pretty good feature as well.
Now one of the things to point out about tables is that you generally use tables when each row
represents a record of something, which in this case is a line item. So when we’re dealing with
tables we’re dealing with ranges where each row in the range is some sort of record. Apart from
of course potentially the top row, the header row, and the bottom row where we have the totals
row.
Now there is another candidate for a table in this workbook and that’s the catalog. So let’s jump
across to the catalog sheet and I’ve selected a cell within the catalog. I’m going to go up to Insert
and select Table. Just make sure that the range selected by Excel is correct. So I can see here A1
to C85, which looks correct to me, select my table has headers and then click on OK. So I’m just
going to do the same thing and change the name on the Design tab here. So instead of Table 2
we’re going to have Parts Catalog and press Enter.
With this table of course the filter is a lot more useful. So if I wanted to find out which items we
sell that cost more than $20 I can click on the Filter dropdown, go to Number Filters, Greater
Than, and I’m going to say $20, and click OK. And the filter tells me that we just have one item,
Combination Padlocks.
And another useful feature here is the Remove Duplicates, because if you have data in a table
then you can remove duplicate rows very easily. So you’ll find Remove Duplicates on the Data
ribbon and Remove Duplicates in the Data Tools group. And you’ll see it gives me a list of the
three columns in the table, part number, description, and price. And it says to me what do you
consider to be a duplicate? Do all three of those have to be the same in order for it to be
considered a duplicate? Well, I have a suspicion that I may have a part with a specific part
number duplicated in this catalog, but I can’t be certain that the price is the same or that the
description is the same. So what I’m going to do is to say just see if you’ve got a duplicate part
number anywhere and click OK. And you can see that one duplicate value was found and
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removed. So somewhere in that table I had the same part number twice. Click on OK and that
duplicate has gone.
And while we’re looking at those tools there on the Table Design tab note this one, Convert to
Range. If you want to convert a table back to being a range again you can use that option. So
that’s how you sort of delete a table or remove a table and it won’t remove the data. It just leaves
the data there but no longer in a table.
So there we have some of the basics of working with tables. In the next section we’re going to
look at changing the shape of a table and some other features related to working with tables.
That’s it for this section. I’ll see you then.
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Video: Working with Tables
Deborah: Hello again and welcome back to our course Excel 2019 Advanced. In the previous
section we started looking at tables and we saw how to create tables either from scratch or from
existing data. And we also saw how to change a table back into a range and we looked at some of
the functions or some of the things that you can do with tables in Excel and in particular we
looked at some of the advantages of using tables.
In this section I’m going to look in some more detail at working with tables and I’m going to
start by looking at how we can make a table bigger by adding rows, removing rows, adding
columns, etcetera.
Now I’m going to continue looking at the Order Details table on the invoice that we’re
developing and just before I make this table bigger I want to just click in a couple of the cells in
the last row. So this one contains the part number, this one contains a formula which is a lookup
to find the particular part in the catalog sheet and we have various other formulae for looking up
the price and so on.
If I want to add rows to this table I have a number of ways of doing it and one of the simplest
ways is by dragging it. Now if I hover over the corner of the table you’ll see I have that familiar
double headed arrow and it’s diagonal, which means that I can drag it horizontally or vertically.
But when you’re working in tables in Excel you can do either but you can only do either vertical
or horizontal in one operation. Vertical will add rows and horizontal will add columns. So let’s
start by adding a row or two to this table.
I’m going to click and drag and let me just drag it down one row. Now what happens when I
click and drag down one row is that I appear to get an empty row, which is great. And if I click
in cell C12 you’ll see it’s empty. But if I click in cell D12 it’s not empty at all. And what Excel
has done is to fill down the formula for me. And in fact in all of the columns where there are
formulas Excel automatically fills that formula down for me. So it does quite a bit more than
insert an empty row. So that’s a pretty easy way of inserting a row and I’m sure you won’t be
surprised to learn that there are several other ways of doing so. For instance, if I click in cell
H12, so that’s the last row in the body of the table, if I hit the Tab key I get the same behavior
that I do in say an application like Word. I get a new row added automatically. And of course in
this case Excel fills down the formula for me as well.
And in fact there is another way that I can do this. Let me switch off the Totals row for just one
moment and what I’m going to do is click in the first empty cell here underneath the final row.
Now if I start using these cells, so supposing I put in here two of something that automatically
becomes a row in my table. Now that only works if I’ve switched off the Totals row. But having
added a row that way I can switch the Totals row back on again and everything will be fine.
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Now what has happened in this case is a feature of AutoCorrect and you can disable this feature
if you want to, but if you look at that little lightning bolt you’ve got an Undo for table auto
expansion. You can also say that if you want to stop auto expanding tables and in fact you can
control it a little bit more permanently than that by going into the Excel AutoCorrect options
because the features whereby the extra row is added automatically when you start typing in it is
part of AutoCorrect on the AutoFormat as you type tab. There are two checkboxes there so
Include new rows and columns in a table and Fill formulas in tables to create calculated columns.
I’m going to leave those switched on but it is easy for you to switch them off if you don’t want to
use them.
Having said that I’m actually going to clear the number two that I just added into this table and
I’m going to switch the Totals row back on.
Now something else I’m sure you won’t be surprised by is the fact that you can also insert a row
by selecting a row in the table. And with a right click one of the options is Insert and you have
two options, Table columns to the left or Table rows above. So let’s select that last option and
there you go. You have another row inserted into your table.
Another very important option on the Table Tools Design tab is the Resize Table option. This
brings up the Resize Table dialog which actually lets you completely change the size of the table
quite dramatically if you wish. Now having said that there is a very important note. The headers
must remain in the same row. And the resulting table range must overlap the original table range.
So you can’t change the row that the header is in and there must be an overlap. For instance, you
couldn’t specify within that range box there that the first cell is J6 because then you wouldn’t
have an overlap with the existing table and you couldn’t put the top row in any row other than
row six. But subject to those restrictions you can use this to make a very dramatic change to the
size of the table. So the use of the Resize Table option is one way of adding a column to a table.
Of course there are many other ways.
I’m going to cancel this and of course another very straightforward way is to click immediately
to the right of the column. And I’m going to type the heading In Stock. And of course that
automatically becomes part of the table. Once again you’ve got that lightning bolt there to
control that behavior and of course just as we did before you have the right click submenu. And
if you go to Insert this time you can select Insert columns to the left, to the right or Table rows
above again.
Just one small word of warning here. Sometimes when you’re inserting rows and columns in a
table in Excel and you have a particular style of table, sometimes the insert can upset the border.
So sometimes when you expect a thin border you get a thick border. So occasionally you have to
do a bit of manual repair work to get the border consistent again, but it’s usually pretty
straightforward to do that.
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When it comes to deleting rows and columns that’s also pretty straightforward. If I click
somewhere, so let’s say in this new In Stock column and right click one of the options is Delete.
And I can choose from here to delete table columns or table rows. So in this instance we’re going
to say Table columns. And of course I could do the same with rows. So I’m going to highlight
two, right click, Delete and I’m going to say Delete table rows this time.
When it comes to making selections in a table it’s pretty straightforward to do the regular kinds
of selection that we’re all used to but you can also do some very specific selections as well. I
have a single cell selected here, so cell D12, and if I right click and go to the Select submenu
you’ll see I have two options related to the column. I have Select the table column data, so let’s
try that. And this will just select cells between the header and Totals row but not the header and
Totals row themselves. If I say Select entire table column of course it selects the entire table
column. And of course the other option is table row, and that selects the entire table row.
Another useful point here is that for example if I have a whole row selected like this and I right
click and go to Select I get the same option. And if I was to click on Table column data I’ve got
all of the columns for the data part of the table for all of the rows. So it’s everything in the table
except the whole of the header row and the whole of the Totals row.
Now there are keyboard shortcut equivalents. I’m not going to go into those now but if you do
use keyboard shortcuts, so keyboard shortcuts like Control-Space will cycle you through the
options.
In terms of using the mouse, if I hover my mouse over the left hand edge of a row you’ll see I get
a little black arrow. And if I click it will highlight the entire row. I could do the same for
columns. So I’m going to hover over column D, get my little black arrow and click and I get to
highlight that column excluding the header row and the Totals row. If I hover my mouse in the
top left hand corner you’ll see I get a diagonal arrow. And if I click it will highlight the main
body of data within the table, again excluding that header row and Totals row. Click again and I
get the entire table, inclusive of the header and totals row. Click once again and I’m just back to
the data part. So those are some selections that you can make using your mouse.
So that’s it on the main features of working with tables. What I want to move on to in the next
section is table references, so please join me for that.
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Video: Table References
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In the last
couple of sections we’ve been looking at tables and apart from creating tables we’ve been
looking at inserting columns, deleting rows, inserting rows, and so on. And it’s quite often the
case that when you’re working with tables, in particular with a table like this Order Details table,
that many of the cells within the table will be occupied by formulae. The formulae might be
involved in a calculation such as this one in H11 where we’re multiplying a quantity by a price to
give a total price. And it may involve things like a Lookup function, such as the Lookup
functions used in cell D11. When we’re doing this we can make the cells in a table and the
associated formulae much easier to understand by using some of the features of table referencing
because you can refer to the elements within a table using a very convenient and easy to follow
referencing system. So for instance, in the column that’s headed Quantity it can actually refer to
as the quantity column. And in a formula such as the one in H11 instead of putting B11 all I
really need to do is refer to the quantity column.
Now the way that I do that is to just replace B11 in the formula with Quantity. I’m going to put a
square bracket, and as soon as I type that square bracket Excel knows that I’m referring to a
column in this table and it gives me a list of the columns in the table. And you can see that there
are seven of them. And I just choose the one that I want. So I’m going to double click on
Quantity and close the square bracket. Obviously my result is unaffected, but I have a formula
now which is a little bit easier to understand. Let’s click back on it and review it.
And what I could do to make it even easier to understand a little bit further is go to G11 and do
exactly the same thing. So G11 is Discounted Price, so let’s replace that as well. Square bracket,
double click on Discounted Price, square bracket and Enter. I could even do the same for the
check in my formula, so where we have E11. So E11 is going to be Discounted Price. So let’s
switch that out as well. Double click to highlight, square bracket, and this time we’re going to
say Unit Price, double click, and close the square bracket.
So this basically makes my formula a lot easier to understand. So let’s read through it. I do a
check to see if there’s something in E11. So basically say have I got a price which indicates that
I’ve actually got a part in this row? And what my formula now says is this. If the unit price is
empty, so there is no unit price, then the total price is empty as well. If unit price isn’t empty
multiply quantity by discounted price to give the total price for this line in the order. Note that
with this approach you don’t need to put row numbers because Excel assumed that you are
referring to cells in the same row as the row containing this formula.
So what I’ve done now is to go through each of the columns in the Order Details table and
replace each cell reference by the correct reference within the table. So I’ve basically used the
column names within the table instead of specific cell references. I only have to do that once for
each formula and then Excel automatically fills that down to the other rows in the table.
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If I want to refer to something in the table from outside that’s pretty easy as well. Suppose I want
to put a little tag down here in cell D16 that thanks the customer and perhaps confirms the
number of items in the order. Now in order to do this I’m going to create a reference from
outside the table to a specific cell inside the table. And there is a set of rules for how to create
such references. I’m going to refer you to the relevant page in Excel Help in a moment but I can
demonstrate this first with an example to give you an idea of how it works.
Now I want to say in cell D16 something along the lines of “There are 11 items in your order.
Thank you for your business.” Now of course I’m not going to make eleven a fixed figure. I’m
going to use the total from the quantity column in the table.
So first of all this is going to be effectively a formula so we’ll start with an equals. And I’m
going to concatenate some text strings. The first text string is, and then what I want to do is get
the total of the quantity column. Now in order to do this I’m going to need to refer to the Order
Details table. This is the name we assigned to the table earlier on in the course. So if at this point
I type in an O Excel intellisense brings up a number of items that begin with O and one of them
is Order Details table. So now I start putting in my reference.
If I want my reference to be the total of the quantity column it’s actually going to be two parts.
The first part will specify that I’m looking at something from the totals row and the second part
will specify that I want it from the quantity column in the totals row. So I do a square bracket to
start the whole process off, then a second square bracket to specify the first part, which is the
totals part. Close off my square bracket, comma, open square bracket, and now I choose the
column which is Quantity, close square brackets. Now that’s the completion of my reference to a
specific entity in the Order Details table, so I need to close square brackets again. Then I need to
type in the rest of my text string. So it will end up saying “There are 11” or whatever the quantity
is “items in your order. Thank you for your business.” So I want to add that additional text string.
So let’s do another ampersand, quote marks and we want a space in there, “items in your order.
Thank you for your business” and close quotes. Let’s press Enter and there you can see. So,
“There are 11 items in your order. Thank you for your business.” And of course this will adjust
depending on the total in that quantity column.
So I’ve shown you there a specific example of referring to a total in an Excel table from outside.
There’s a very good page in Excel 2019 Help that explains structured references and how to use
them. It is quite a long page but it also has quite a lot of examples in it and you should find it
interesting to work your way through there to find the many ways that you can refer to things
like totals.
We will be seeing a few more examples of this and in fact Exercise 06 will involve you working
out one of these examples yourself, but I do recommend that you have a good read of that
particular page in Excel Help.
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So that’s it on table references. I want to spend a short period of time looking a little bit more at
table styles so that’s up next. I will see you there.
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Video: Table Styles
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. Earlier on in
the course we looked very briefly at table styles and in this section I’d like to take a bit more
time looking at table styles in more detail.
I’m still looking at the Order Details table on the invoice and the style we’ve got there is one of
the standard ones and it’s highlighted in the Table Styles gallery up there on the ribbon.
Now once you’ve selected a style you have the Table Style Options group where you can make
some fundamental changes to the style, such as banding of rows or banded columns if you want,
but you can also make some much more detailed changes to an existing style as well as creating
our own style. So let’s start out by customizing this style first.
Now as a general rule if you’re starting from an existing style and you want to customize it for
your own purposes I think it’s always a good idea to make a copy of the one that you’re going to
customize rather than dive straight in and change the original. And this is very easy to do in
Excel 2019. All you need to do is right click on the style that you’re starting with and select
Duplicate. Now my duplicated style gets a default name of Table Style Medium 9 2, which was
the original name of that style. And I’m going to change that name to make it a lot easier to
identify it as mine. So I’m going to add my initials on the front and I’m also just going to remove
that 2 as well. We don’t really need that. And click on OK.
Now if I look in the gallery you can see my style up there at the top and you’ll see my name as I
hover over it. And that’s the style that I’m going to apply to this table. But first I’m going to
customize it. So let’s right click and select Modify. And there are a whole load of table elements
that I can customize. And I think it’s a very good idea if you’re interested in styling tables to just
work your way through all of those elements and just see what each of them does. What I’m
going to do here first though is just demonstrate one or two of them just so you can get the
general idea.
So for instance the first column stripe. The stripe is currently set to one. So if I set it to two and
click OK and then let’s apply our style to our table, so you can see what effect that change has
had. The darker stripe is two columns wide and in fact the vertical banding is dark two, light one,
dark two, light one, etcetera. So let’s do another one. This time we’ll select the total row and
we’re going to format the total row. And I think what I’m going to do is choose a very, very dark
color for the total row. So let’s go to Fill and I’m going to select this dark navy color here and
click on OK and OK again and now that total row is much darker. So I think from that you get
the general idea of how this customization can work.
Now if in fact what you really wanted to do was start from scratch on a style, again if you go
back up here to the Table Styles dropdown and you’ll see right at the bottom one of the options
is New Table Style. And you basically start with a completely empty style. So you can go
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through and you can format colors, striping, etcetera. So as I said just now if you’re interested in
this sort of thing I do suggest that you go through and experiment with this as it’s really quite a
flexible and powerful system.
Now just one more thing I want to show you before I get to the end of tables and I set you
Exercise 06 and that is if you’ve been working on a table and you’ve been doing some
calculations and some styling and so on one of the things you may want or need to do at some
stage is to convert the table back to being a range again. And I did mention this earlier on,
Convert to Range, it’s this option here on the Design tab. Let’s see what happens if I do Convert
to Range because a couple of very important things do happen.
One of the things that happens is that you don’t lose the styling that you’ve applied. So if you’ve
used table styling notice the darker totals row here, that stays exactly the same color. And the
thing to note is that Excel converts the references to other cells in the formulae back to cell
references and away from table references. So converting back to a range which you may need to
do is fine. It works, of course, and maintains any styling you may have done.
So that’s it on tables except for Exercise 06 which I’m going to cover in the next section. So
please join me for that.
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Video: Exercise 06
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. It’s time now
for Exercise 06 and in this exercise it’s pretty straightforward really. I’ve done most of the work
for you.
In the Order Details table in the invoice we’ve been developing I’ve been through and in all the
formulae I’ve replaced cell references with table references. We’ve also got that text in cell D15.
“There are 11 items in this order”, etcetera. The only thing I need you to do here is put into cell
H3 the due date for the invoice payment.
Now the one slight complication is that the invoice is due for payment either 15 days or 30 days
from the date in C2. And if the invoice value is less than $100 then the terms are 15 days for
payment. And if the total value of the invoice is $100 or more than the client has 30 days to pay.
My answer looks like this. And you’ll notice there is 30 days there because the value of the
invoice is almost $200.
That’s Exercise 06. I will see you in the next section.
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Chapter 11 – Pivot Tables
Video: Introduction to Pivot Tables
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to start to look at Pivot Tables. Now many of you might have used pivot tables
before but I’m sure there’s many of you out there who haven’t. And for the benefit of those of
you who haven’t I’m going to spend this first section explaining the basics, including explaining
the situation in which you would use pivot tables.
Now if you haven’t used them before and you really want to look at some of the more advanced
features, in particular some of the new features, the updated features in Excel 2019, then you
might well skip this first section.
Having said that I do find a lot of people who use pivot tables aren’t necessarily all that
comfortable with them. And I’m going to try and explain in some detail the situation in which
you would use them, why you would use, and really what pivot tables are all about. So even if
you have used them before you might well benefit from working your way through this section
anyway.
Now you may or may not be aware that pivot tables really are one of the great strengths of Excel.
They’ve been a part of Excel for many years and they continue to be improved in Excel. And
even in this latest version in 2019 there are further enhancements and improvements to existing
facilities.
Now first of all what sort of data do we use in pivot tables? Well pivot tables are suitable for use
with what we call transactional data. And transactional data isn’t necessarily to do with financial
transactions but it’s any kind of data where each record corresponds to a measurement of
something or a count of something. It could be a record of a sale in a store or it could be a
measurement for the amount of rain we’ve had on a particular day, for example. Now these
individual records need to be recorded in rows in a worksheet. If you actually have records
recording columns you would need to transpose them and each row must correspond to one
record. You mustn’t have any empty rows and you also mustn’t have any missing or empty
columns.
The particular data we’re going to use for the first example is data on sales in a café within a
convenient store. And we’re keeping four pieces of information on each sale. So the date on
which the sale was made, the branch of the convenient store, the value of the sale, and the
department.
Now there are quite a few different departments. You can see some there for the sale of breads.
And if we scroll down we have lots of different other departments. So things like grab and go,
we have general, and if I scroll down even further we have juices, so on and so forth.
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Now there is actually quite a lot of data on this particular worksheet, over 30,000 records.
Control-Down will jump me to the end and you can see there we have 34,109 records. So
essentially over 30,000 transactions. And this is the kind of situation where you might use a pivot
table.
Let’s suppose you have a lot of data and you want to report on that data and somebody says to
you, “Well, can you actually do a presentation on this data?” And you might say, “Well okay but
what am I trying to show? Am I trying to compare these branches with each other or am I
showing which department is best? Or am I trying to show if sales are increasing or decreasing
over time?” So working out what you’re trying to show is very important before you start to
construct your pivot table.
Now one of the great things about using pivot tables is that using a pivot table you can pretty
much answer all of these types of questions because you can do any comparison between any of
the entities. And you can also do things like show trends over time. So pivot tables give us a
great way of reporting on transactional data.
Now before we get started there are a few things I want to point out. You do need to have
column headings and those must be different. As you’ll see they’re very important when it comes
to using pivot tables. I’ve already mentioned previously not having any blank rows and columns.
Also if in any numerical column you have a value of zero it must be shown as a zero and not just
left as a blank or a space.
And one other quick warning, if you’ve been using pivot tables for a long time if you have any
old pivot tables, say one from Excel 2003, that’s not going to work in Excel 2019. So you’ll have
to recreate the pivot table.
So let’s get started on a pivot table. The data here is actually in a table already and if I click
inside it you will see that I access to the Table Tools contextual ribbon at the top with a subribbon shall we say, a Design sub-ribbon.
I can use the keyboard shortcut of Control-Asterisk to select the whole of my table. And having
selected the whole table you can see the Quick Analysis button just at the bottom there. And if I
click it and click on the Tables tab I’m offered two alternative pivot tables. One of them will
show the branches. Again the sum of the value of sales for each branch. And the other one will
show departments for the sum of the values of sales for each department. I’m going to start with
branches and let me just zoom in and there you can see my first pivot table. I have the branches
in column A and I have the value of sales in each branch in column B. And in fact what I have in
column B is the sum of the value of sales in each branch.
Now if you look over on the right, and I’m just going to expand this ever so slightly, you will see
we have a very important panel which at the moment we will think of as being in two sections.
The top section is the Pivot Table Fields.
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In the top section we have the Pivot Table Fields which show which of the fields in my data are
currently shown. So you notice here that the branch and the value is shown. Branch is shown by
name and value is actually shown by the sum of the value or the total value. Date is not shown
and also department is not shown.
The bottom half of the panel is made up of what we call the drop zones and there are four drop
zones. There’s a filter drop zone where we can filter the data we are seeing and then we can set
the data out in rows or columns. At the moment we have our branches. They’re represented by
rows. So in each row we have a branch. We don’t have any classification by column at the
moment but we will in just minute. The values that are shown are the sum of values. And that
represents the sum of the value column values for each branch.
Now the reason this is called a pivot table is that when a simpler version of this came in a long
time ago one of the main advantages was seen to be the fact that you can pivot the X and Y axis.
So you can swap something that is in rows and put it up to columns. So I could grab Branch and
drag it up to columns and you can see how that changes the data because I still have the same
information. The difference is that each branch is a column and the sum of the values is shown
against each of the branches. If I had more things plotted horizontally or vertically or things
plotted in both directions then I can easily pivot them. Let me just for a moment put Branches
back to rows.
So to round off this section let me just demonstrate the pivot element and the power of analysis
using pivot tables.
I’m now going to enable the department in the pivot table fields part of the panel on the right.
And when I do that you’ll be able to see a breakdown of sales by department. So I’m going to
click Department. Note now that in the rows drop zone I now have Branch and Department
showing in there.
But suppose I grab Department and move it up to become a column. Let’s see what happens. So
I’m going to grab Department, drag it to columns, and drop. Now my analysis gives me a row for
each branch and a column for each department. Not only that but let’s suppose I’m not really
interested in all of those departments. Let me click on column labels and you’ll see I have
filtering capabilities. Let me switch off all of them and we’re going to say that we’re just
interested in coffee, hot teas and juices and click OK. Now my pivot table is filtered to show just
three departments and here I’ve got all four branches. But if I wanted to I could filter on
Branches and only show it for say Atlanta and Houston.
So as you can see this gives you a very powerful reporting facility and we haven’t even started
looking at dates yet.
That’s it for this section. We’re going to go into more detail in the next one so I will see you
there.
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Video: Working with Pivot Tables
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at creating pivot tables in a little more detail than we did in the preceding
section. And I’m going to create another pivot table from the same starting point but I’m going to
take it step by step and take a look at the other options that are available.
Now the first thing I’ve done is convert the table with the source data in it back to being a range
again. So it’s no longer a source table. I already mentioned that it’s a good idea to use a table as
the basis of a pivot table so I am going to turn it back into a table again but I’m only going to use
part of it. So I have over 30,000 rows of data and I’m going to use roughly 15,000 of them to
create my pivot table from.
So, let’s go up to the Insert ribbon and go down to Table and now the Create Table dialog
identifies the range. And what I’m going to do is just use the first 15,000 rows. So I’m going to
edit this and remove those rows and say I just want the first 15,000. My table does have headers
so I’m going to click OK. So now I only have a little over half of that data in the table and I’m
going to change its name to Sales, underscore, Table (Sales_Table). And now I’m going to insert
my pivot table. So back to the Insert ribbon and Pivot Table. And that gives me the Create Pivot
Table dialog.
Let’s start at the top. Excel has given me the table I have selected. So in this case Sales_Table,
which is fine. Note the alternative is Use external data source. Now I might choose one of my
connections and get data from one of my connections. You can in fact turn any appropriate
transactional data into a pivot table and use that as the source of your pivot table.
You can also choose to use this workbook’s data model. I mentioned the data model in a much
earlier section. And if you are, for instance, combining various data sources and building a data
model you may in fact use a data model as the source of the pivot table. That’s outside of the
scope of what we’re doing here but it is a very important option if you’re combining data from a
number of different sources.
The second set of option buttons there let you choose whether to put the table on to a new
worksheet, which is what I normally do or you can add the pivot table to an existing worksheet.
Also note the checkbox at the bottom which will let you add the data to the data model. And
again we’re not really dealing with the data model in this course so I’m going to stick with the
data from the table and it’s going to go on to a new worksheet.
Now what you can see here is the bear bones of a pivot table. There isn’t actually a pivot gable
there at the moment, just a space for one. But until I select at least one field I won’t have a pivot
table.
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I’m going to rename this sheet. And one thing to point out here is that this panel on the right, if
you click on the header you can actually move it around, drag it and drop it to wherever you
want. And of course you can expand it, collapse it, do whatever you like with it. I prefer to have
it docked over on the righthand side but just be aware that you can float that panel out as well.
Now when you’re dealing with the fields of data in a pivot table they can vary greatly between
different sets of data but there are certain defaults that apply and well worth knowing about.
The first field I’m going to add to this pivot table is a date field and date fields by default are
added as rows. So you’ll see as I select the dates here it goes into the rows section at the bottom.
And note that it picks up a default categorization of months. So the dates there are divided into
the months of the year. Note here that we only have four months covering the data.
Note also that values by default occupy the values drop zone.
So now we have the sum by month over those four months that cover all of the data from the first
15,000 rows.
Now if we return to the dates for just a moment, if I click on the month of March and expand it
you see each individual day for the month of March. And with that day the sum of value of sales,
and that is of course covering all of the branches. Note that if I hover over each of cell I can see
the figure for that cell. So the sum of the value. And it says it’s in row March and I’m seeing data
for the 5th of March. If I didn’t want that month categorization I could just turn it off in my pivot
table fields but then I finish up with all of the days in sequence. Now that’s not normally
something I recommend as an option but it is as easy to do as that.
I could also switch off date and then all I have are my month totals, but without the ability to
break down into individual days.
Now let me introduce Branch. Branch is a text field, so by default it will be added to the rows.
Watch where it goes in the rows. It goes below Date. And now if I were to expand say January
under each day in January I can see the figures for the four branches. Note the hierarchy now,
under rows, months, dates, branch.
How do you think it would look if I dragged branch up to the top? Now of course we have the
four branches and under each branch we have the month’s figures that we can break down into
daily figures.
Now let’s add department. It’s another text field so it will get added as a row, but what I’m going
to do is drag Department over to columns. Now you can see that the table gives us a much more
detailed breakdown by department, by branch, and by date as well. And of course we can pivot
these in any way that we want.
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So if I wanted to put Branches in the columns and Departments in the rows that’s fine as well, so
let’s do that. I’m going to put Branches in the column, Department in the rows and I get a
different display.
Note that for the period of the data covered by the reduced version of the table we only have
some of the departments. Let’s go back to the store data and just change that table at this point.
So the Table Tools Design tab has a Resize Table option. Notice it’s got to have 15,000 rows, so
let’s set it to the maximum figure of 34,109 and OK. Let’s go back and take a look at our pivot
table. Now on the Analyze tab in the Pivot Table Tools contextual ribbon there is a Refresh
button. Click on Refresh and now of course we can see for all departments and the figures for the
whole period of time covered by our data because we now have all of that data in our table.
Now I want to look briefly at one or two examples of ways that you can control the data in a
pivot table and also how you can control the formatting of the pivot table. Let’s start by looking
at date.
When I added the date into the pivot table we had days and months and there is a reason for that.
Notice I have the month there selected, January, and on the Analyze tab, which is available under
the Pivot Table Tools contextual ribbon there is a Group group and in there I have different
options. Group Field, Ungroup, and Group Selection. So I’m going to click Group Field and for a
date field or a date and time field there are a number of standard ways of grouping those and this
is set up to provide days and months, which is what you’ve seen so far. If instead of providing
days and months I only wanted to be able to work in months I could uncheck Days and then only
Months would be available. Note also that Excel has detected the start of the period covering the
data that is included in this pivot table. So now I only have the dates in months. I can’t break
them down by down by day anymore. I haven’t lost the data. I could just go back into that Group
Field option and switch the days back on again but sometimes you either want to change the high
level grouping or sometimes as here you may well say, “Well I never want to look at the
individual days as I’m looking at the overall figures.” So grouping is another very important
aspect of how to present the data.
One or two other features on here, such as Slicers, we’re going to look at in the next section.
Now let’s look at a couple of aspects of formatting. You now that these are amounts of money
but you may actually want to indicate that they are amounts of money. What you don’t want to
do is select all of these fields in the body of the pivot table and format them as currency because
as soon as the data changes they would all be thrown out. There is in effect a styling approach to
this. So all you need to do is select one of the values and on the Analyze tab one of the options is
Field Settings. What you’ve got in here is the sum of value. That is you have the sum of the
value, so in this case the breads that were sold in Phoenix in January.
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Note that whilst what we have here is the sum of all the transactions I could replace it by the
count or the average or the max or the min. Now I’m going to stick with sum but you could
actually change how you summarize that data from here.
What I’m interested in doing is going into Number Format and for these I want to show as
currency with no decimal place. And click OK. And OK again. And now those amounts are
shown in whole dollars.
And I’m sure by now you’ve seen the power of pivot tables, but of course there’s still a lot more
to find out about them.
But one other thing, you may have been looking at this pivot table and looking at the totals and
not everybody likes to have their totals at the top of each section. So if you look here for breads I
have my totals for Atlanta in B5, Detroit, Houston, Phoenix, so on and so forth. So those are the
totals but they’re showing across the top. Personally I like to have them under my data. So you
can again change that in pivot tables.
Looking at things that way doesn’t always suit everybody so on the Design tab in our Pivot
Table Tools ribbon we can change the layout or the design of the overall report. What we have
now is what we call the Compact Form. I could say show this in Tabular Form. And in Tabular
Form you have the more conventional layout whereby the totals are at the bottom of each
column.
So that’s it for working with pivot tables. In the next section we’re going to look at Filters and
Slicers, so please join me for that.
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Video: Filters and Slicers
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to focus on filtering pivot tables and specifically we’re going to look at the use of
Slicers, which actually present some particularly straightforward ways of filtering in pivot tables.
Before we do that I have a few things to point out that I haven’t pointed out so far, one of which
is that if I want to refresh a pivot table, you’ve already seen the Refresh button on the Analyze
ribbon. And to the right of that there is a Change Data Source option. And if I click on that it
takes me to the source of the pivot table and allows me to make changes there. So that can be
very useful.
And the other thing about a pivot table is that over on the left here you have the Options
dropdown. And there are some very useful options within Pivot Table Options. In particular I’d
like to look at the Data tab. And one of the options on the Data tab is Refresh data when opening
a file. It can be quite useful to have that set, particularly if your pivot table depends on data
which is being refreshed from outside of itself. It’s well worth going through the tabs in the Pivot
Table Options and setting your options as you would like them.
And also on the Analyze tab over on the right you have a Show group. And one of the options
there lets you switch on and off the field list. There is also an option here that switches on or off
the plus or minus buttons. So that allows you to collapse and expand the items in the pivot table.
And there’s another one that displays the field headers for rows and columns.
Something else I haven’t used so far that’s actually very useful is the right click menu. When you
right click you have a whole host of options within that menu, so don’t forget that they’re there.
So for example, I have B6 currently selected. I’ve got the month of February selected. And when
I right click on that it directly gives me access to Group and Ungroup. So ungrouping the month
there takes the data right back to the original dates from the source data. And if I right click again
and go to Group and group the dates by month it takes me back to how we were.
And as far as the data itself is concerned we’ve already seen the effect of being able to hover
over each cell and being able to see in this case the sum of the values. One of the other options
you have here is to right click and go to Show Details and it takes you through to all of the
source rows in the source table that relate to that specific combination of field values. And you
notice there that Excel creates another sheet with the data on it. Now another way to access that
information is just to double click, so essentially you’re drilling down into that particular data.
And another thing to point out is if I go to the Pivot Table Design tab I can choose my Pivot
Table Style from the dropdown. So if I wanted something a little bit more intense color-wise I
could hover over and make any of these selections. So let’s go with this one. Styles work pretty
much the same way they do in tables in Excel but you just have a few less options. But basically
it works the same.
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Let’s turn our attention now towards filters. I’ve swapped or pivoted the department and the
branch field. In each row in the pivot table I have potentially two filters. I have a date filter and I
have a branch filter. So for instance if I click on the Branch dropdown here I’ll get the
appropriate filters. For instance I could decide to just show the Houston and Atlanta figures just
by selecting Houston and Atlanta. Note the effects on the totals of each of those departments of
course. And of course I can easily clear a filter at any time just by clicking Clear Filter from
branch.
Similarly with dates not only can I choose which months I show but I can click on date filters.
And I have the normal date filter options. Things like next week, last month, last year, and so on.
If I deselect all of the months and just select January and February and click on OK watch what
happens. Of course I only see data for two departments. And of course the reason there is only
data for two departments is that we only recorded sales in those two departments in January and
February.
Now this returns to a point I mentioned earlier on. Sometimes when you apply filters it can be
deceptive. So somebody looking at this table might not know that you filtered on January and
February. They may think that you have filtered on breads or coffee. So you need to be careful
that you don’t make assumptions on the filters that have been applied purely on the basis of what
you can see in the column headers and row headers. Now of course the filter symbols are a clue
but you need to be careful people don’t jump to the wrong conclusion.
Now another very useful feature when you’re filtering is this and what I’m going to do is remove
the date filter just by clicking Clear Filter from Date and I’m going to right click on February and
go into Group and I’m going to group by months and quarters and click OK. And I’m going to
move the quarters field up into the filters drop zone. So I’m going to drag and drop. Now what
you can see is that I have my pivot table with quarters as a separate entity up here on the left. So
if I just wanted to show Quarter 2 I can select it from the filter and click OK. Note that with this
type of filter I have the option of selecting multiple items here. So I could select multiple
quarters if I wanted to.
And one other thing before we move on to Slicers, if you have a field that has many different
values you may find it hard to find the particular value you want to filter on. So in the case of
department I have about 15 departments. But say I had 100, 200, 300, there is a Search facility
here as well. So if I wanted to look for Tea I could type in Tea and it will return back to me all of
the results that contain that particular word. So you see here I have Hot Teas and Tea.
So let’s move on to Slicers. Slicers are a very useful way of filtering. They are very good in
presentations and they’re also very good if you want to keep track of exactly what has been
filtered. Now one of the problems of Slicers is that they do take up quite a lot of space on the
screen. So what I tend to do is leave some space around the side of a pivot table and also
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sometimes across the top, depending on what I’m doing, which will give me room to add those
slicers in.
So I’m going to click somewhere inside the pivot table and now one of the options that I have in
the Filter group is Insert Slicer. Now that brings up the Insert Slicers dialog and I can decide
which slicers I want. So I’m going to have slicers for branch and department and click OK.
Now these slicers basically work like filters. And sometimes you get in situations like I have
here where there sort of isn’t really enough room for them without obscuring part of the pivot
table, but the sort of thing you can do for instance here is use the sizing handle. So let’s move
these over. This is why I like to leave a little bit of room. And as you can see it’s kind of
obscuring part of my pivot table but I can just drag that resize handle in and also drag that one up
a little bit and it’ll pop the other one in underneath and do the same thing. We’ll just resize that
in. So you can sort of adjust them so that they fit nicely next to your pivot table.
Now you’ll also note that if I click on one of the slicers I get the Slicer Tools contextual ribbon
tab at the top and underneath there I have a whole host of options which I can use to control my
slicer, so formatting options. But what I also have is I can adjust how many columns I’m
viewing. So currently I have it set to one but if I put it up to two, if you look at the slicer now
you can see I have two columns and I could carry on if I wanted to. It gets a little bit crazy so
let’s just break it down like so. And that gives me a little bit more room because I can then resize
and I can move the next one up and I could do the same thing just to keep things consistent. In
fact let’s just do two for that one and drag it up slightly. So you do have formatting options for
your slicers as well. So now let’s do some slicing.
Let’s suppose I want a slice to show the figures for Atlanta. So if I click on Atlanta my results
are filtered just for Atlanta. If I want to apply the Coffee filter then in the department slicer I can
click on Coffee and I only see coffee for Atlanta. Of course it’s quite often the case that you
might want to see multiple items, which you can again do very easily. So if I wanted to see
coffee and hot tea I’d just need to hold down the Control key and make my second selection and
the pivot table will update so it’s now showing coffee and hot tea for Atlanta. And if I want to do
the same thing in my branch filter I could click on Detroit whilst holding down Control and there
we go.
So that’s the basic use of Slicers. Note that with a slicer selected on the Slicer Tools Options tab
you have the Slicers Styles gallery. So if you’re trying to match something in a presentation you
have a number of slicer styles there to choose from.
To remove a slicer all you need to do is select it and hit the Delete key. Note that in this case
although the slicer is removed the filters that were specified on it are still in force but of course I
could click on the department filter here and say Select All and click on OK to bring back all of
that information.
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And one other point, with the Pivot Table Tools selected to the right of Insert Slicer there is an
Insert Timeline. And Insert Timeline is a special type of slicer and it’s related to date. So if I
select Date and click on OK I get a date slicer. Let me click on August and you’ll see that I’ve
now sliced for the month of August and there is nothing to show for that particular month and I
can drag my timeline slicer out, and let’s try and drag it out so that we get some data in here.
Let’s drag it back and there we go. So depending on where your data is you might have to adjust
this slightly but this is specifically for filtering or slicing on dates.
So I can use what is in effect a visual date slicer to filter on a date. And again you might have to
leave a little bit of room for this type of slicer so I’m going to drag mine down a little bit and just
reposition this across the top like so, and drag it all the way across so it’s easy to see. And with
all the slicers you have a Clear Filter option as well.
So that’s it on slicers. Please join me in the next section.
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Video: Pivot Charts
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In the last few
section we’ve been looking at pivot tables and in this final section on pivot tables we’re going to
be taking a look at pivot charts, which are an excellent way of presenting the kind of
transactional data that we build into pivot tables.
Now creating a pivot chart from the pivot table is simplicity itself. I’ve got a subset of the store
data here. I’ve just got the figures for January, February and March. And if you click anywhere
inside the pivot table there is an Analyze tab. And one of the options in there is Pivot Chart. And
when you click on Pivot Chart you get the Insert Chart dialog box.
Now the first thing that happens here is that you choose the sort of chart you would like to draw.
Now there is whole selection of standard of Excel charts there, not all of which are suitable for
use with pivot style data but what Excel will normally do is present a recommended chart. And
in this case it’s given us a clustered column chart as the recommendation. So I’m going to go
with that. And by default the chart is created on the same sheet as the pivot table. So I’m going to
move it to a separate sheet in just a moment but first of all I’m going to resize the chart and just
make it a little bit bigger so that it’s easy for us to see.
So now let’s look at the controls on this pivot chart. The first thing to know is that we have
effectively three filters, a date filter facility, a branch filter facility, and a department filter
facility. And you can see which of these currently has a filter applied.
Now again we’re in a situation where we can only see the figures for five departments there. And
there’s actually no department filter applied at the moment. There is however a date filter
applied. We can only see the first three months of the year. And there is no branch filter applied.
We’re seeing all of the branches.
The point is though that we can now filter as much as we like. So if I didn’t want to see the
figures for Phoenix I could deselect Phoenix, click OK and the chart will update. And if I just
wanted to see the figures for coffee and tea, and I don’t think there actually are any for tea but
we’ll deselect everything and just select coffee and tea and click OK. And there we go. There are
no figures for tea for this time period so we’re just seeing the figures for coffee.
Notice the filter symbols here indicating that there is a filter applied. Let’s remove those filters
again.
One other feature that’s interesting is a new filter that enables you to drill down into the data. So
where we’re looking at the horizonal axis here, which is basically the months of the year and
within each month the four branches, if I click the minus sign I will lose one level of structure on
the horizontal axis. So I’ll only see three months of the year. And of course I will see the
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aggregated sales in any department where any sales have been made without seeing them broken
down by branch.
So what I’m going to do now is move the pivot chart to its own sheet and move it away from the
pivot table data. So I’m just going to quickly create a sheet and we’ll call this Pivot Chart. I’m
sure you can come up with something a little bit more meaningful than that. And all I need to do
is select it and Cut and then Paste it on to my new sheet. And I can just drag and drop that to
move it and I can make it a little bit bigger by using those resize handles if I want to.
Now what I’m going to do is take a look at the Pivot Chart Tools and I’m going to start with the
Analyze tab.
Now if you look over to the left of the group in the Pivot Chart group it includes the pivot chart
name. So you can give your chart again a meaningful name. I’m not going to do anything too
meaningful here. I’m just going to call it Pivot Table 1, which is fine for the moment.
Note also under there you have an Options button. The Options button gives you access to set
and change some of the options. And we did look at some of these earlier on. So it’s definitely
worth having a little look through there to see if there’s anything that you do want to change
within those options.
You also have the option here to insert slicers. So if you were doing a presentation where you
didn’t particularly want to use filters that are available on the axis here you could use slicers. So
let’s insert some slicers for branch and department. And again you can reposition these by
dragging them over and I’m going to make mine look a little bit neater just by resizing them
using the resize handles. And let’s put department underneath and do the same thing, like so.
We also have the option to insert timeline and we have a couple of useful buttons over here on
the right. We have Field List which will pop back out that pivot chart fields. And that’s just a
toggle button. So if you want that back you can just click it and click again to remove it. And we
also have Field buttons. And this has a top part and a bottom part. So let’s look at the bottom
part.
Now in the bottom part you can decide on some of the tools that are available in the chart itself.
So for instance having added the slicers for branch and department and maybe also deciding to
insert a timeline slicer as well you might turn off the axis field buttons. And you might also turn
off the value field buttons. And finally on the right there for department we could also turn off
the legend field buttons if we wanted to. So that makes the chart look a lot cleaner. Obviously we
still have the legend there but we can do any filtering now using the slicers instead.
Now it’s also important not to forget that pivot charts are charts. So therefore in amongst the
Pivot Chart Tools you have two other tabs, a Design tab that is appropriate to a chart. So you can
set your chart style, add chart elements, and so on. You also have a Format tab. And this is pretty
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much a normal format tab for a chart. And also to the right of the chart whilst it’s selected you
have the standard two buttons, the Chart Elements button that let’s you add, remove or change
chart elements, and below that you have the Chart Styles button. So you can of course treat a
pivot chart very much as being a standard Excel chart, although of course where it gets its data
from compared to most charts is a very complex business indeed.
Now there is just one other thing I would like to show you here or start to show you at least. So
let’s jump back into our store data and let’s pretend we haven’t created that chart at all. I’m
going to click somewhere within the table and I’m going to go to the Insert tab. And one of the
options is the Pivot Chart and Pivot Table. And if you really want to start from scratch with data
you can start at that point and it will take you through the whole process of creating the table and
then creating the chart and making various decisions as you go along. So if you would like to
have a bit more control over the creation process that’s a great route to follow.
That’s it on pivot charts, which just leaves us with Exercise 07 and I’m going to set you that
next.
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Video: Exercise 07
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
I’m setting you Exercise 07.
The starting point is a set of transactional data in the workbook Exercise 07.xlsx. The data is not
quite the same as it was in the last few sections. In order for Exercise 07 to achieve a very
different kind of presentation I’ve changed the data to remove some of the extremes and
anomalies that would have made some things seem a little bit strange. So don’t worry about that
because basically it’s exactly the same sort of data, although there are a few important
differences in your presentation.
Now to start to point out these differences. Here is the pivot table that I created from that data.
The East and West row labels on the left correspond to the fact that I have divided the four
branches into an east region and a west region. The east region includes Atlanta and Detroit and
the west region includes Houston and Phoenix. And instead of showing the total value of sales
I’m showing the number of sales, the count of sales for each of the departments, for each of these
offices. And then within an office we’ve broken down the sales by quarter. And of course you
can drill down further into each quarter if you wish to. So that’s the pivot table.
In the pivot chart we have a nice simple pivot chart. As you can see I have a Bar Chart. I have
the departments in a slicer on the right. So we can choose, for instance, to look at the sales for
chocolate. And of course using the Expand or Collapse buttons I can drill into or out of this data.
So a combination of the drilling facilities, the filter here, the slicer on the right all helped by the
legend which is obviously showing us which of the departments corresponds to which color in
the Bar Chart. We can use this pivot chart as the basis of a presentation of how well the east and
west are doing in comparison to each other.
That’s Exercise 07. I will see you in the next section.
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Chapter 12 – Data Analysis
Video: What If Analysis
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to start to look at What If Analysis. This takes us into an area of data analysis in
Excel which has always been a very important aspect of its use. Now in order to demonstrate
What If Analysis I’m going to go back to one of the earlier examples in the course when we were
looking at financial functions. And you may recall that calculated the monthly payments on a
$5,000 loan with assumptions about an interest rate.
Now one of the things we did a couple of times was just to experiment with changing one or two
of the values that we used in the calculations. For instance, the number of payment periods.
Now although we did this manually and I used it to demonstrate the use of the function there is
actually a great demand to be able to do this on a much larger and more flexible scale. So I was
working for a loan company and I was doing these calculations for somebody I would like to
have a nice big worksheet where I can just plug the relevant values in and come up with the
payment terms and periods of payment and so on.
Now this approach can now be developed to the point where we can actually aim for a particular
outcome, such as the level of payment we want to make and then we can look at alternative ways
of achieving that. So essentially we can look at different ways of achieving a particular goal. And
in this section and the next few sections we’re going to look at What If Analysis tools. So Goal
Seek and the use of Solver.
Now we’re going to start with an example of What If. Now before we do I would just like to
remind you of something we did earlier on.
Now I have there in column C a set of values. There’s the annual interest rate, the number of
payment periods, the principle value which is basically the amount of the loan, and in row six in
column C we have the type of payment. And of course the type of payment determines if we’re
paying at the beginning or at the end of the payment period. And in cell C8 we have the
payment. And it’s calculated using the PMT function. And we covered that earlier on in the
course.
Now what I’m going to do first is copy the cells from C2 to C8. So let’s select them, Control-C
to copy to the clipboard. And I’m going to paste them into the equivalent position in column D.
Control-V to paste. And I’m going to change the number of periods from 120, so that’s ten years
essentially of monthly payments to 60 which is of course five years of monthly payments. So I
can now see that the monthly payment I need to make with these new parameters is $93.96. Now
of course it would be really straightforward to do the same for various other numbers of periods.
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And of course we could vary the interest rate and see what impact that had as well. But let’s look
now at What if and the power and flexibility that it provides.
So what I started to do here was set up the framework for the use of What If. And at this stage
it’s pretty straightforward. However over the next few minutes you’re going to think that
everything has gone completely crazy until you see what’s going on.
Now I put in cell C2 the loan amount and in cell C3 the interest rate. And I’m basically assuming
that those two at the moment are fixed. And I’m also going to fix the future value at zero. So
we’re paying off a loan and I’m going to fix the payment type as one. So the only variable is the
number of periods and I’m going to do a What If Analysis from 36 months down to 120 months.
Now it’s very important when we’re setting up values of the variable or variables that they are
consecutive values in sequence.
Now one simple thing to do here would be to put the payment function as part of the formula in
C5 and fill down. Now that would work perfectly well but you’re not going to learn what What
If is if we did it that way. Instead of doing that I’m going to put the payment function in cell C4.
So equals, PMT, the rate which is C3 divided by 12 to get that monthly interest rate. The next
value is the number of periods. Now what I’m going to do is choose a cell at random outside of
the table of payments that we’re putting together. And I’m going to choose cell A4. Now you
might think that A4 has nothing to do with what we’re doing, which is true, but it will be.
Now we put in the principle value or the loan amount which is cell C2, future value is zero and
the type is one. And you probably won’t be too surprised to see that I get an error there. Now
getting that error is not a problem.
Now we’re getting the error obviously because there is no value in cell A4. So what I’m going to
do now is make my data table. And my data table comprises the list of month values or the
number of periods, in this case 36 to 120, the empty cell above and the cell to the right. So I’m
going to select all of those to make a rectangular table. And when I make this selection it’s very
important that I have the period numbers on one side and the formula on the other side.
So now let’s go to the Data ribbon and over to What If Analysis and select Data Table. Now I
mentioned earlier on that you need to have your alternative values, in this case the alternative
values for the number of periods together or consecutive. And they can either be in a row or they
can be in a column but you have to tell Excel if they’re in a column or a row. And they are the
values that will be fed into the dummy cell, in this case A4. So our column input cell is A4. So in
this case what happens is Excel starts at this empty corner, we tell it to go down a column and
put the values there successively. So into a cell that we have decided is the input cell to the PMT
function and for us that cell is A4. Let’s click OK and see what we get.
And just to recap what was going on there we feed these values 36 to 120 successively into A4
and then the formula in C4 is going to feed off of those values and fill in that second column.
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Now it doesn’t look quite right yet of course. We need to do some formatting. So let’s go up and
I’m just going to highlight these cells and let’s do some currency formatting which looks a little
bit better but I’m going to go a stage further. Because these payments are negative values I want
to show them in red.
Now apart from the rather awkward looking NUM value there when you look at those results
you might think, “Fine, but was that really any less effort than just filling down a formula in cells
C5 to C12?” And of course the answer to that is no, not really. In this case the fill down would
probably have been quicker. The idea was to show you the principle of What If. And where
What If really comes into its own is not when you’re dealing with one dimension of variable,
such as the number of months, but when you’re dealing with two dimensions of variable. And in
that case we don’t need this external field, this dummy field. We can do everything in a way
which is much neater and gives us a very powerful way of computing a value in a formula with
many variations on two variables.
So let’s take a look at the two dimensional version. So again I start with the PMT function. This
time in C5. And those are my starting values, but I’m going to vary both the interest rate and the
number of periods.
So first of all I have entered a range number of periods from C6 to C13 and what I’ve done is to
enter a number of alternative annual interest rates. Now what I do is that I draw my data table so
that my formula is in the top left hand corner. And of course included in this I have rows and
columns. So let’s go to Data, across to What If Analysis and Data Table. The row is the
percentages that they’re going to replace what’s in C3 with and the columns are the number of
periods they’re going to replace what’s in C4 with. So my row input cell is C3 and my column
input cell is C4 and click OK. And there we are. That is a two dimensional analysis that
definitely saves some time.
In the next section I’m going to take a look at Scenario Manager. So I will see you there.
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Video: Scenario Manager
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In the previous
section we created this What If model. And this model shows monthly payments for various
values of two variables. One variable is the interest rate and the other variable is the number, in
this case the number of periods over which we’re paying off a loan.
Now one thing we didn’t vary as part of this model is the amount of the loan. And of course
there are other variables when we’re working out these payments, such as future value and the
type. So even with this relatively straightforward payment example we could have about five
variables involved. Now once you get beyond two variables then a flat two dimensional
worksheet is not going to work in quite the same way.
So the question is how do we deal with having more than two variables? Now one way of doing
this is to use what is called the Scenario Manager. And using the Excel Scenario Manager we can
in effect deal with a much larger number of variables. In fact you can have up to 32 variables
with Scenario Manager. We aren’t going to go through anything quite as complex as that but we
are going to extend this model a little bit. And the first step to doing this is I’m going to give
various entities involved in this model names as it’s much easier to keep track of what’s going on
with this model if you refer to names rather than cells. So let’s do that first.
Let’s start with the amount of the loan. Now you have a choice here in terms of names and
different people like to do this in different ways. One option is to use the simple default name. So
if I click Define Name is the Define Names group I could use this as the name, Loan Amount,
and Excel is picking that up from the cell to the left of where we’re currently clicked.
Alternatively you could use an informative word like Principle, as in the principle of a loan, or
you could use the term as it’s referred to in the PMT formula. So for example you could use PV
here if you wanted to. What I’m going to do on this occasion is go for that middle option. And
I’m going to put Principle.
Now the next two variables are interest rate and number of periods and we have both of those in
use in our What If table. But let’s give them both a name. So I’m going to use the exact same
process and on this occasion I’m happy to stick with those default names. I’ve got two other
potential variables as well. One of them is the future value. And I’m going to leave that for now
because once you’ve added one variable to the list you can add as many as you like up to 32. But
what I’m going to do though is put the type of payment in row three. Now having done that I’m
going to give it a name and I’m happy to stick with the default of Type.
Now if we go down to our formula in cell C6 and just look at that in the formula bar what I’m
going to do is start to replace some of these cell references with those named ranges that we’ve
just created. So let’s start with the one that we’ve done and replace this one with Type. And then
of course instead of C2 we can replace that in the formula with Principle. Just for completeness
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I’m going to add C4 and C5 as well. So C4 is the Interest Rate and C5 is the Number of Periods.
So now somebody looking at that formula in cell C6 will probably find it a lot easier to
understand using those names.
Now the Scenario Manager we access from the Data tab in the Forecast group, What If Analysis
and Scenario Manager. And it probably won’t surprise you to know that the Scenario Manager
manages scenarios. And we currently don’t have any scenarios to find so we can click Add to
add our first scenario.
Now I’m going to give this scenario a name in a moment but the first thing we need to do is to
decide which cells are going to change in this scenario. Now the basis of our calculation is cells
from C2 to C5, the ones that we’ve just given names to. Two of them vary on the worksheet and
the other two don’t. So it’s the loan amount and the type that would vary. And you need to
specify in the changing cells box there which are the changing cells. If they’re nonadjacent you
can select them just by holding down Control and you click. So in changing cells let’s delete out
what we have and we’re going to select Loan Amount, Control key, and Type. So the two cells
that are changing in here are the principle and the payment type. So I’m going to stick with the
values that are in those at the moment. That’s why I’m going to say for a name Principle $5,000
payments at the beginning of the period. And the reason why I’ve given it that name is because
the type we’re using in this scenario is one which again indicates payments at the beginning of
the period.
Now there are two checkboxes at the bottom of the dialog. One says Prevent changes and one
says Hide. If the worksheet is protected then these will take effect. One of them prevents
somebody else who cannot unprotect the sheet from changing the scenario and the other one
hides the scenario all together. So they can be useful when other people are accessing this
workbook or worksheet.
So that’s our first scenario. Let’s click on OK and this little dialog comes up with the Scenario
Values. And Excel has done a pretty good job at working out what those are in this case. So I’m
going to click OK and you can see now in Scenario Manager that I have my first scenario listed.
Now let’s suppose I want to have another scenario and this one I’m going to specify payments at
the end of the payment period. So I click on Add again and give it a name, Principle $5,000
payments at end of period. Now that the two values that we’re varying are the principle and the
payment type again. And the payment type of one indicates a payment at the beginning of a
payment period. So we have the same changing cells as before and let’s click on OK and of
course it brings up the same dialog. And on this occasion for payment at the end of the period the
type will be zero and click on OK. So now I have two scenarios listed in my Scenario Manager.
One for payments at the beginning of the period and one for payments at the end of the period.
Now if I select a particular scenario, let’s say the second one, and click on Show you’ll see I now
have the values for payments at the end of the period. If I click on the top one and click Show it
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shows me the values for payments at the beginning of the period. So you can very easily toggle
between your different scenarios that you’ve created to see those different values and those
different scenarios and situations.
Now let’s look at one or two other options in this Scenario Manager dialog. We have the Edit
option and obviously that lets you edit the selected scenario. And there’s also a Merge option.
This can be particularly useful in situations where you’ve distributed a workbook to a number of
different people and you’ve asked them to create their own scenario. So you may want to merge
those back into one workbook and you can use this merge facility to merge scenarios from
different workbooks and different worksheets, put them all together to perhaps look at a full set
of scenario options.
The final option is a very useful one because one of the things you may have realized is that
although we only have two scenarios there you can’t actually look at both of them at the same
time, which makes it hard to do a comparison. But if you click on Summary you get two options
there. One of them is the produce a scenario summary or you can create a scenario pivot table
report. And I’ll leave you to experiment with the pivot table report. In the summary you can
select one or more cells to show. So let’s suppose for example that we were looking for the least
expensive option for a ten year loan, so 120 months, at 5%. So this particular cell here, H14 is
the one that I’m interested in. That’s the one I want to show. So let’s click on OK and we get a
Scenario Summary Report. Now note our two scenarios are along the top here, Principle $5,000
payment at the beginning, Principle $5,000 payment at the end and you can see the values of the
variables for the scenarios, principle and type. And then you can see the value in the selected
cell. So in this case with the payment at the beginning it’s $52.81 a month and with a payment at
the end it’s $53.03. So if in this case I want to find the cheapest option that’s a good way of
comparing the cost.
Now that’s it on Scenario Manager. In the next section we’re going to take a look at Goal Seek
so please join me for that.
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Video: Goal Seek
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at Goal Seek and initially I’m going to show you Goal Seek with what is a
very straightforward calculation.
As you may or may not know there is a trigonometric function called the Sign of an Angle and
Excel involves a function to find the sign of an angle. Now you can look up about the sign
function in Excel Help and it will tell you it needs to look up the sign of an angle in what are
called Radians. So if I have an angle, so let’s say 30o, to convert it to radians I multiply it by pi.
And remember pi is an Excel function but it has no argument so I’ve put two empty round
brackets. And then we divide by 180 and that gives me the angle in radians. And then of course
to find the sign of that angle I use the SIN function. And the sign of 30o is 0.5 or 0.5. So really if
don’t understand trigonometry hopefully that’s a fairly straightforward calculation.
Now supposing I wanted to find the angle whose sign was 0.6. Now you may well be aware of
the fact that there is another function in Excel that essentially does the reverse of what we’ve just
done and it’s called the Arc Sign function. But for the moment we’re going to pretend that that
function doesn’t exist.
So let’s suppose that I want to try and find out what angle has a sign of 0.6. Generally speaking
increasing the angle will increase the sign. So let’s try say 40o. Now clearly that’s a little bit too
much so let me drop that down to say 38 and 0.61, not too bad. We’re getting a little bit closer
and I could carry on this way and eventually I might get to my answer, but that’s not a
particularly efficient way of doing things. It takes a little while and you may struggle to get it to
the exact number that you’re looking for. That’s where the Goal Seek function in Excel can help
you out.
So let’s go to the Data tab, across to What If Analysis in the Forecast group and we’ll select the
Goal Seek option. So first of all you select the cell whose value you want to set. So in our case
that is cell C4. And then you specify the value you want in there, which is 0.6. And then you
specify the cell you want to change, which in this case is C2. Click on OK and that’s the answer,
36.864 is the angle. Now it probably would have taken me some time to iterate to that myself so
Goal Seek has saved me quite a bit of time and trouble.
I did mention just now that we need to forget about the Arc Sign function which would have
given us the answer even quicker. Bear in mind with Goal Seek that you’re not necessarily
dealing with a single function in a formula as we are here. The answer we could be trying to
arrive at could be based on an extremely complex formula with many functions involved and
there wouldn’t necessarily be a simple way of reversing what the formula does. So Goal Seek is
particularly useful when you have a complex situation and you can’t really just reverse
something else. In effect you’re getting Goal Seek to do all the hard work for you.
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Now you notice the accuracy that we’ve got there, 0.5 and then three 9’s, 20416 as the sign. Now
we can’t always get exactly an answer with a trigonometric function. Supposing you wanted
something a little bit more accurate than that. Well you can control the accuracy using Excel
Options. So if I go to File and down to Options and on the Formulas page and on the right click
Enable iterative calculation. And I could increase the number of iterations. So I could say up to
500 iterations and that would infect increase the accuracy of the answer. Supposing I also said
that I wanted this accurate up to six decimal places and click on OK. So make a note of what
we’ve got there now as the sign and let’s do it again. Now I’ve got something that’s even more
accurate. And in theory I could make it as accurate as I want it to be.
And by the way of a second example of Goal Seek let’s return to our payment calculations. If I
wanted to borrow $5,000 at a 5% interest rate with 60 monthly payments my monthly payments
would be $93.96. Supposing I wanted to know how much I could borrow with a monthly
payment of $200. Straightforward enough. We can do that using Goal Seek.
So back to Data, What If Analysis, Goal Seek. The cell I want to set is C5, the value I want in
there is $200 and I want to achieve that by changing cell C2. So I can now see that I can borrow
$10,642.
Now one reason of showing you this example is to point out something important about Goal
Seek. I couldn’t use the Goal Seek in an array situation. I couldn’t put a whole list of interest
rates in row three here and set up a Goal Seek that worked on all those different interest rates to
tell me each of the interest rates and how much I could borrow for $200 for a month. It’s very
much a function you use in these kind of specific cases. But in the cases where it can be used
Goal Seek is a very powerful tool and it’s particularly useful when you’re dealing with complex
calculations.
So that’s it on Goal Seek. In the next section we’re going to take a look at Solver so please join
me for that.
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Video: Solver
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at the use of Solver. And before we start I just want to point out that it’s
quite possible that if you look on the Data tab on your ribbon you won’t even see Solver there.
Solver is a free add-in and we’re going to be using it in this section. So if you are intending to
work along with me you might want to enable it now.
If you go into File and then down into Excel Options and go to the Add-ins page and in the
Manage Excel Add-ins click on Go and one of the add-ins you should see is the Solver add-in. It
is free so just select it and click on OK and you should now see that in the Analysis group on the
righthand side you have Solver. You won’t actually need to click on Solver just yet but we are
going to come back to it later on.
Now let me tell you a little bit about Solver. In the preceding section we looked at Goal Seek and
I showed you how to vary one variable and let Goal Seek use what is in effect brute force to
supply the value that produced a particular answer in the use of a formula. With Solver you can
deal with much more complex situations, and in particular you can not only vary many more
input variables but you can also put constraints on the on the solution as well.
Now in order to demonstrate Solver I’m going to use a fairly practical example. Now my friend
runs a café and that café is open seven days a week, only during the day. And the number of staff
that my friend needs to employ needs to be judged so that the peaks and troughs in the business
can be catered for. So for instance the café is particularly busy at the weekend and tends to be
quieter during the weekdays. My friend has worked out how many members of staff are needed
on each day but he is struggling to work out how many staff to employ overall in order to cover
the required number of staff. I’ll explain what I mean by that a little more as I start to set up the
model that we’re going to use to solve this problem. So let’s start to build this roster for my
friend.
Now first of all you can see the seven days of the week there, Sunday to Saturday. And in row 16
I’ve put the number of staff my friend needs in the café. So 11 are needed on a Sunday, 7 on a
Monday, 9 on a Tuesday, and so on. Now these are minimum numbers. We can’t go below these
numbers on any day of the week.
Now let’s talk about some of the constraints on the solution to this problem. One of the
constraints is that each member of staff works five days a week and those five days need to be
consecutive days. One of the reasons for this is that each member of staff must have two days a
week clear as their weekend break even if it’s on say a Monday and a Tuesday or a Tuesday and
a Wednesday, so on and so forth. The five days they work are five consecutive days, nobody
works overtime and nobody works part-time. So each person does five consecutive full days.
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Now there is going to be one other constraint that I will come back to in a moment but that’s the
basic model. Now the way that we set out about solving this is first to say, okay. Given that each
person works five days we could have somebody called a Sunday person. And a Sunday person
would work Sunday, Monday, Tuesday, Wednesday, and Thursday. And in fact we could have
more than one Sunday person. We could, for instance, have two Sunday people. And if we had
two Sunday people we’d have two people on a Sunday, two on a Monday, two on a Tuesday, so
on and so forth. So if we say that the number of Sunday people is what’s in B5 then in terms of
the contribution to the staffing of the café the number we put in here is indeed B5. And the same
will be true for each of those five days of the week. So I will do a fill right. I’ll also apply a bit of
formatting. I’ll just center those to make it easier to read and with that you can see what
contribution they make to the café. I’ll do the same for each of the other types of person.
So for each of these other types of person I’ve taken into account the day of the week that their
week starts, their five consecutive days, and just to get us started I’ve assumed I’ve got two of
each and based on that I can calculate how many members of staff I will have staffing the café
on any particular day of the week. So for instance, on a Sunday the total number of staff is
equals, Sum, D5 to D11. And of course that’s ten. And if I fill across, at the moment I have ten
people on each day of the week, which is fine on Monday, Tuesday, Wednesday for example but
not so good on Friday, Saturday and Sunday.
Now returning to the iteration approach I could sit here all day and change the numbers in
column B and try to come up with the best solution which would satisfy the requirements that I
have at least the number in row 16 on each day of the week. Or I can say to Solver find out what
the numbers in B should be and the requirement I have is that overall the total number of staff I
employ should be as low as possible.
Now the total number of staff I’m going to put here in cell B12. So it’s equals, Sum, from B5 to
B11. And of course this is the number that I want to be as small as possible. So it’s time to try
Solver now. Let’s go to the Data tab and Solver. And it opens up this nice big Solver Parameters
dialog. Now the first thing we do is to set our objective. And our objective relates to cell B12
because ultimately what we’re trying to solve is to make B12 as small as possible.
Now I have three options for my objective. So my objective could be to make it as big as
possible, Max, as small as possible, Min, or to achieve a specific value. Now in this case I want
to achieve the smallest value as possible. So I’m going to leave Min selected there.
Now in order to do that which cells am I allowed to change? The cells I’m allowed to change are
these cells, B5 to B11. And the idea is that I’m going to change those to make B12 as small as
possible. Now there are of course constraints and let’s look at what those constraints are. Let me
just delete out because these are old ones and let’s start with a clean slate.
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So let’s add our first constraint by clicking the Add button. So my first constraint is that our
numbers in D14 to J14 must be greater than or equal to the numbers in D11, sorry in D16 to J16,
and click OK. That’s our first constraint. Let’s add another one.
So the next constraint is a very, very important one. And that is the numbers in B5 to B11 must
be whole numbers. So the next constraint we’re going to add is that the numbers in B5 to B11
must be integers or whole numbers. That’s our second constraint. And click OK.
Now notice another checkbox here, Make unconstrained variables non-negative. Now there
aren’t going to be any negatives here. We’re not going to have negative numbers of staff or
negative totals on duty.
And there’s also a box here, Select a solving method. For those of you with a background in
mathematics or in many aspects of business administration and management you may have heard
of linear programming. Well basically Solver used linear programming to solve these problems
and it has three options. And these three options will help you try and solve a problem. If it can’t
solve a problem using what’s called the GRG Nonlinear engine you have two other options, the
Simplex LP and the Evolutionary Engine. Now I’m pretty sure it’s going to solve it with GRG
Nonlinear without any trouble. So let’s give that a go. Click on Solve. So Excel thinks about it
for a while and it believes its come up with a solution. And you can keep its solution or you may
want to have a look at it first. You can restore the original values and you can also return to the
Solver Parameters dialog and you can even save this as a scenario if you want to. So for the
moment let’s click on OK. And let’s examine what we’ve got here.
Well according to Solver we don’t want any Sunday people, we want one person that starts on a
Monday, three that start on a Tuesday, five that start on a Wednesday, so on and so forth. And
the smallest number of people that can satisfy this requirement is a staff of 15 people. Now I can
see the main downside here is that we’re going to have far too many staff on a Wednesday but
here’s a challenge for you. See if you can come up with a better solution than Solver using
exactly the same constraints. And I’m pretty confident that you probably won’t.
So that is the use of Solver. Exercise 08 is an exercise on the use of Solver. That’s in the next
section. I will see you there.
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Video: Exercise 08
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
I’m setting you Exercise 08 and in Exercise 08 it’s a little bit unusual in that the starting
workbook just has instructions in it. And I’ll show you my answer in a moment but here are the
instructions.
A company makes specialized electronic components. They are used in medical devices. One
machine can make two components, A and B. It takes a total of 12 minutes of machine time to
make one component A and a total of 23 minutes to make one component B. The machine is
available for use for 30 hours per week. The profit for making one component A is €5 and the
profit from making one component B is €8.
The requirements of the medical devices are that there must be at least two component B’s
produced for each five component A’s. How many of each item should the company produce per
week to maximize profit? And what is the maximum profit per week? So that is Exercise 08.
Now let’s just quickly take a look at my solution.
So there we are. We should make 84 of component A and 34 of component B and that will yield
a profit per week of €692.
Good luck with that one and I will see you in the next section.
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Chapter 13 – Graphs and Charts
Video: Area Charts
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this and the
next few sections we’re going to be looking at graphs and charts and I’m going to assume that
you have pretty good knowledge of working with graphs and charts already. Not only most of
the most popular types of graphs and charts but also various different aspects of formatting them.
And what we’re going to be concentrating on here are some of the more esoteric types of graphs
and chart and in particular looking at the sort of situations in which they’re used and also aspects
of their customization and formatting that are specific to them. And we’re going to start with
Area Charts, probably a very underused type of chart and one that can be used very badly but
one that can also be useful, for example, in presentations.
Now I’m going to use this particular workbook, Team Monthly Sales, to demonstrate Area
Charts and the sheet that you can see here is the Commission sheet which shows the commission
that each member of the team earned in each month of 2015.
Now just to get us started let’s take a look at Andy Carothers, the first team member’s
commissions figures for 2015. And we’re first going to look at his figures with a Line Graph. So
let’s highlight and then go to the Insert tab and of course Recommended Charts will show us the
recommendations there. And as you can see it’s recommended a clustered column. But if I click
on All Charts at the top and go to Line I have a variety of different line charts. So let’s do that
basic line chart and click on OK. So that’s the line chart for Andy. I’m going to assume you
know how to do things like add labels to the axis, change the title, change the colors, etcetera and
that’s not really what we’re looking at here, although we will do some formatting in later
sections.
But first of all note the fundamental idea here is that you have something changing over time.
But one alternative way of representing this type of variation is to use an area chart. And of
course on the ribbon in the Design tab you have a Change Chart Type button. And if I go down
to Area one of the options, the first option there, is this one. So if I double click and that’s now
an area chart. Of course it shows the exact same information but some people find it to be a bit
more impressive in a presentation situation.
Now although it can be impressive there are problems with area charts as well.
Now what I’m going to do is change the selection of the data for this chart. So let me move the
chart out of the way slightly and I’m going to pull this corner down so that I select all of Team
A. And you’ll see that immediately the chart updates. And what I get now is this rather baffling
two dimensional area chart which I personally find is all a bit confusing. It’s not all bad news
though. In some situations this type of area chart can be made to be quite useful. So for instance,
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let’s go up to the Change Chart Type again and let’s change it to a 3-D Area Chart. And with a 3D Area Chart everything becomes a little bit clearer. Now in 3-D it’s a lot easier to see the
different sales performances. And something else you can do to help this, let’s choose Andy’s
figures and what I’m going to do is right click and select Format Data Series. And you’ll see I
get a panel pop out on the right. I’m going to go over to the Fill, I’m going to go down to Color
and select More Colors. And one of the options under More Colors is Transparency right at the
bottom. Now at the moment Andy’s slice in the area chart has zero transparency so I’m going to
give it let’s say roughly 30% transparency and click OK. And now you can see quite a lot of
what’s behind Andy’s area chart. You can still make out the detail of Andy’s chart but the
transparency can often help you to see the chart or charts immediately behind it.
So the use of Transparency in any of these charts that have a solid element, particularly the 3-D
ones, can be very useful. Now let’s look at one other option for area charts that I think can be
useful in a presentation situation.
So let me deselect Andy and go back to the Change Chart Type. And this time I’m going to go
for a 3-D Stacked Area Chart. And again this may look quite baffling but in a presentation
situation it can be quite useful. And the way in which it can be quite useful is this. As you look at
each month for the year, so say for February, you can see what proportion of the commission
was earnt by each member of Team A. And if you hover over Andy’s figures for February you
can see that his commission was relatively low and you can see that Michael’s figures for
February were very good in comparison. Douglas’s figures somewhere in between, Jeff
somewhere in between, and Shu Ito has been quite disappointing as well. So you can not only
give a good impression of the overall performance of the team for each month of the year but
you can see relative performances quite clearly as well.
So that’s area chats. Let’s look next at Surface Charts.
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Video: Surface Charts
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to take a look at Surface Charts and surface charts are used to show the relationships
between three variables. And I’m going to talk about a particularly good example of a surface
chart in a moment.
But the example I’m going to use here is one that plots a mathematical function. It’s a function
of X and Y. The values of that function are in cells C3 to M13, the values of Y are in column B,
the values of X are in row 2. So let’s select all of that data, click on Insert and I’m going to click
on the little dropdown in the corner to see all charts and I’m going to select Surface and OK. And
there it is. You have the X and Y values plotted on the floor of the chart and the Z values, the
values in the body of the table are plotted vertically.
Now when you use surface charts one of the problems with the three dimensional nature of a
surface chart is that it’s not at all unusual for one or more of the axes to be the wrong way round.
So you can’t really see this surface chart very well. But if we change the Y axis to be the other
way around it might be a little bit easier to see.
So what I’m going to do is select the axis, I’m going to right click and say Format Axis and
you’ll see the first option I have underneath Axis Options is Series in reverse order. And now my
surface chart is much easier to see and understand.
There are some other things you could do as well. So for instance if you look at the Z values on
the right, so where it says 5,000, 10,000, 15,000. Watch what happens if I make the chart taller.
Excel uses the dimensions to change not only the intervals on the axis but also the color scheme
that’s used on the surface itself.
I mentioned just now that I would point out a very useful application of surface charts and one
application that I’ve seen used a number of times is one that shows temperature over the surface
of the earth. So mean temperatures, where for instance in this case the Y axis might be the
latitude. So if a lower latitude is closer to the equator, in this case you will have generally higher
temperatures. And in that case X might represent the seasons of the year. So you would see how
although mean temperatures vary with the seasons of the year generally speaking they are higher
closer to the equator.
Now in that case you might want to change the coloring of the surface here.
Now in that case let’s go to the very highest range, right click, and select Format Band. We’ll
open up Fill and we’ll select Color and I’m going to make that a dark red. Then I might select the
next band and make that a slightly less red red and I could work my way down all the way to the
bluest colors for the coolest temperatures. And in that way I can very much customize the
surface chart to the specific application to which I’m applying it.
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Now there are some other very good options with surface charts. Let me just deselect the band
there and go back to the Change Chart Type. And there is a Wireframe 3-D Surface. So in this
case you lose the filled in color but you can see the wireframe. That’s often very useful when
you want to see what’s behind the surface chart.
And another very useful options is the option to see it from above. So a contour chart essentially.
And the contours indicate the height of the Z values, a bit like looking at a map with contour
lines on it.
So those are some of the options for surface charts. In the next section we’re going to look at
Radar Charts so I’ll see you then.
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Video: Radar Charts
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to take a look at Radar Charts which are a very good way of comparing a relatively
small number of things against a relatively small number of metrics.
Now in this case the things we’re going to compare relate to employee performance at work.
And a particular company measures performance against six categories and those are the values
in column B. So Customer Focus, Critical Reasoning, Adaptability, Creativity, Responsiveness,
and Loyalty.
Now the company’s standard score for each of these, the benchmark score, is a four and
employees are measure against a number four. And if they fall below four then they’re
considered to be underperforming in that particular category. If they go above four that’s
considered to be an exceptionally good performance. And who knows? It could lead to a pay
rise.
Now we have the scores for two employees here, Jenny Murray and Steve Dupont. And what
we’re going to do is draw a radar chart to represent these two employees’ performance.
Now even if you’ve not used radar charts before you can certainly appreciate other options for
comparing their performance. You might not first think of a column chart where the categories
along the horizontal axis are those six categories and then you could have three sets of blocks,
the company standard, Jenny and Steve and you would very soon see that Steve’s performance is
generally short of the company standard and Jenny’s, well Jenny’s isn’t. So that would be a
pretty good way of representing this data. But a radar chart is a very good option for doing this
kind of comparison as it very often flags where people are doing particularly well and where
people are doing badly.
Now in order to demonstrate radar charts what I’m going to do is first just draw a radar chart that
covers the company standards. So I’m going to select cell B2 down to C8, click on Insert, we’ll
click on All Charts, and we will select Radar, and click OK. And there it is. Now you notice the
six categories outside of the radar chart. You could have more than six or less than six. Radar
charts are generally used for relatively small numbers of categories. Once you kind of get to 12,
15, 20 it does start to become a little bit unmanageable so just be aware of that.
As you can see it’s drawn concentric hexagons starting from zero in the middle, one, two, three,
four. It’s probably human nature to assume that the max score you can get here is five. Excel
doesn’t really work in that way. The highest score it’s seen is a four for company standard so it
stops at four. And the blue line very much represents the company standard.
So let’s change the selected data and instead of stopping at C8 we’re going to stop at D8. So
select Data and we’re just going to change C8 to D8 and click OK. Now we have Jenny’s score
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as well. Notice how you can immediately see that generally speaking she is outside. That is
better than the company standard, except in the area of loyalty where she gets a score of three
and therefore drops inside that blue line.
Let’s now include Steve. Now Steve’s score on the other hand is generally speaking all inside the
blue line. In creativity and loyalty he scores a four, so he just about achieves the company
standard but in other areas he falls well short of it, particularly in adaptability.
So you can see how visual the representation of the relative performance of those two employees
is not only to each other, so for instance Steve’s score in loyalty is actually better than Jenny’s
but that is the only category of performance of which he does better than Jenny. But you can also
see how each of them does against the company standard.
So that’s radar charts. You have all the normal formatting options such as legend to indicate
which color of line corresponds to the employees and the company standards. There are some
alternatives, such as the radar with markers and there is a filled version as well. But that’s it on
radar charts for now. In the next section we’re going to take a look at Bubble Charts, so please
join me for that.
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Video: Bubble Charts
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to look at Bubble Charts and bubble charts are another way of dealing with three
variables.
In the example that I’m going to use here these aren’t actually three independent variables
because the third variable is actually a function of the other two. And what we do in a bubble
chart is in what was the Z access in the surface chart in another section we now represent not by
a vertical axis but by the size of the symbol that represents the third variable.
Now in order to demonstrate bubble charts what I’m going to use is this data. This is 2015 data
and it relates to the population of some of the major countries in the world and their GDP per
person, and also the implication of these figures in terms of that countries overall GDP.
So first what I’m going to do is plot the population against GDP using a regular scatter chart. So
let’s select our data, go to Insert, and we’re going to insert a scatter chart. Let’s just make that a
little bit smaller so we can see and there it is. You can see the plot. Note that the points at this
stage are not labeled but the GDP per person which is in U.S. dollars is on a scale of up to
$60,000 per person on the left. And the populations are plotted horizontally. That’s the Y axis.
Now you probably won’t be surprised to see that there isn’t some straightforward linear
relationship between GDP and population. In fact it seems quite random. But we can add to the
information provided by this chart by adding the information in the third column. And that is that
given the six countries GDP and population figures what is the implication in each case for the
overall GDP of the country? Which countries have the biggest overall GDP? Is it the ones with
the highest GDP per person or the ones with the highest population? I think if you had to have a
guess at it you would say it’s probably both but it would be much more helpful if you could get
an overall representation of the GDP on the chart as well. And that’s one of the things a bubble
chart does for us.
So what I’m going to do now is draw a bubble chart and I’m going to include the third column of
information and the values in the third column will be represented by the size of each bubble.
Now in a way of course this is a very easy thing to do but you do need to be a little bit careful
when you are creating a bubble chart. And I’m going to do this one wrong to start off with.
So I’ve deleted my scatter chart and let me select the three columns of data, including the
headers. And we go to Insert and Bubble Chart. And there is my bubble chart, but it’s actually
wrong. The vertical values, the GDP per person values, are fine and the size of the bubbles
actually are representing the overall national GDP for each of those six countries. But the
horizontal axis rather than showing the population is just showing the values one, two, three,
four, five. It’s basically taking the population figures as a sequence of numbers.
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Now the way to get it to draw the bubble chart correctly is that when you’re drawing it do now
select the headers. So let’s delete this out and try that again. So this time I’m going to make my
selection but I’m going to exclude those headers. I’m going to go to Insert and select my bubble
chart again. So now I have the GDP figures correct, the population figures correct and I have the
overall national GDP represented correctly by the size of the bubbles.
Now of course when building this I haven’t included the header row from the data. If I want to
put axis labels on I’ll need to put those in. You might also have noticed that the column B labels,
the names of the countries are not included against each bubble. Now there isn’t a
straightforward automatic way of doing that so if I want to label the bubbles as well there is a
sort of semi-automatic way of doing that that I’m going to show you in just a moment.
Now once again I tend to use bubble charts in presentation situations. So sometimes it’s nice to
make them look pretty smart and there are various different charts styles of bubble charts, such
as this one.
Note also there are various different kinds of bubble charts to choose from. So if we go back to
Change Chart Type you’ll see there is a 3-D Bubble Chart there as well which can look really
impressive. And of course you can format the axis.
One of the things that you may well want to do is label those individual points and there are a
couple of ways of doing it. If I were to click on that bubble and then right click and select Add
Data Labels and Add Data Callouts you notice the callouts there have some default content. And
the default content they have is the three values which are from our data selection from each of
the countries. What I can do instead is if I right click on that and say Format Data Labels and you
will see the label option on the right, X value, Y value and bubble size. Let me turn off X and Y
value and what I’m going to have instead is use value from cells. So I need to select the data
label range. Well the labels I want to use are in cells B3 to B8 and click on OK. And I’m going
to switch off bubble size as well. And that just leaves the country names in there. And of course
they could be formatted as well if you wanted to.
Also notice how Brazil overlaps with Russia. Well I can sort that out and I can just grab it and
move it around if I want to.
So that’s bubble charts. I will see you in the next section.
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Video: Sparklines
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this and the
next section we’re going to look at a couple of different types of chart that are very often used in
financial applications. Having said that these two types of charts are very different indeed. And
in fact the one that we’re going to look at in this section, the Sparkline, was introduced quite
recently. It cam in in Excel 2010 and Sparklines are unlike any other type of Excel chart.
Amongst the main differences are that Sparklines are not actually charts in the same way that
area charts and column charts are. These are tiny little charts and each chart fits into a worksheet
cell. Now in fitting into a cell a Sparkline can have other cell content in the cell as well but the
key thing about Sparklines is that they are simple visual indicators.
Now we’re looking at a page here from Yahoo Finance. Obviously this will be out of date by the
time you come to look at it but you’ve got some tiny little charts there at the top. And very often
in sources of financial information these tiny little charts are used to show the overall trend of
something. So let’s take a look at how we can use Sparklines in Excel 2019.
So in order to demonstrate Sparklines I’m going to go back to the Team Sales 2015 data and the
Commission sheet. And I’m going to draw in some Sparklines to show how each team members’
commission has progressed over the course of 2015. I’m going to put the Sparklines in column B
so let me just open up a spare column and then on the Insert tab to the right of the Charts area we
have a Sparklines group and there are actually three types of Sparkline, Line, Column and
Win/Loss. Let’s start with Line.
Now that brings up the Create Sparklines dialog and we basically have two selections to make.
The first selection is for the data that we want to represent in the Sparkline. Now in this case
that’s going to be the data in C4 to Q8. And where do we want the Sparklines to be placed? Well
we want them to go in B4 to B8 and click OK. And there are our Sparklines.
Now if we look at Andy Carothers Sparkline that gives you pretty much the same message you
get if you work methodically through the twelve months of commission that he’s had and that is
that overall his performance during the year had deteriorated. It was a little bit up and down but
overall the tendency is downwards. In fact the team in general aren’t doing so well. Maybe Jeff
Hay is not quite so bad but overall there isn’t any improvement showing. So that’s an example of
the clear visual representation you can get using Sparklines.
For Team B I’m going to use another type of Sparkline. I’m going to use a Column Sparkline.
And you may have noticed just now when I inserted the Sparkline Excel assumed that the range
that I had selected was the destination. So let me just select the destination for the Team B
Sparklines. So that’s going to be B11 to B15. I’m now going to click on Column and notice that
the location of the Sparklines is correctly set by Excel. So I just need to choose the data which is
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going to be C11 to Q15 and click on OK. And now I have a column style of Sparkline for each
member of Team B.
Now there is a third style of Sparkline, the Win/Loss Sparkline and we’re actually going to cover
that as part of Exercise 09.
Now while it’s not mandatory for Sparklines to be in groups such as these they very often are.
And if you imagine a situation where you had inserted say 20 or 30 Sparklines if you want to
change the formatting, so for example you could change a Sparkline Style it would be pretty
tedious to go through and do that to 20 or 30 separate Sparklines. So if I try to select a Sparkline,
for example Andy’s Sparkline when I select it it automatically selects the other Sparklines in the
group. And by default the group is the group that was created when it was inserted. It is possible
to ungroup Sparklines and when you’ve got one or more Sparkline selected you have a Sparkline
Tools ribbon at the top and a Design tab. And at the right end of the group there is an Ungroup
Sparklines option. So I could ungroup Andy and that essentially removes Andy from the group
he was just in. Let me just put him back again. If I want to ungroup all of the members of the
group you just need to select the whole group and click on Ungroup. And now each of those is a
separate Sparkline and I can format them separately. So for instance I could choose a completely
different style for each one of the Sparklines if I wanted to.
Let’s look at one or two other features on the Design tab. There is a Show Group and in the
Show Group you can select certain entities to show on your Sparkline. So for instance you can
check markers and on the line style of the Sparkline you can see those little markers. So I might
want to put in the high point, the low point, maybe the first and last points as well. If instead of
the lines I selected the columns and selected High Point what happens is the highest columns get
a different color. Now let me switch the high point off here and let me concentrate for a moment
on the Team B scores.
What I want to do is go back to the Group group and click on Axis and just explain that at this
moment the heights of those columns are set for individual members of the team. So for instance,
Scott’s are scaled according to Scott’s overall performance, Laura Steele’s are scaled to her
overall performance and so on. Those column heights are not in some way related to the
performance of the whole group. Now if you look at the dropdown button on the Axis button
you’ll notice that in the middle section, the Vertical Axis Minimum Option Value is Automatic
for each Sparkline. That’s what’s setting the Sparkline so that each min and max block size is
according to the individual member of the team. If I wanted to set them to be the same for all
Sparklines those Sparklines would also indicate to me not only how individual team members
performances changed over the year but also how they compare to each other. So let me change
both of those to Same for all Sparklines. Now what we can see, for example, is that Laura
Owen’s blocks are generally speaking a lot higher than say Eric Parkinson’s are. And Laura Steel
particularly in earlier parts of the year, her performance was significantly worse than say Laura
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Owen’s. So with this not only can visualize the performance over the year but the relative overall
performance of the team.
Just a couple of final points on Sparklines. One of them is that on the left of the Sparkline Tools
Design tab you have an Edit Data button. And that brings up the Edit Sparklines dialog so that
you can change the data range or the location range of the Sparkline. And at the righthand end of
the Group group you have a Clear option as well so you can Clear selected Sparklines or Clear
selected Sparklines groups.
And the very final point here is that a Sparkline can refer to data not only in rows but also in a
column.
That’s it on Sparklines. I will see you in the next section.
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Video: Stock Charts
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
we’re going to take a look at Stock Charts. In order to cover Stock Charts in detail I will need to
explain quite a bit to you about the way that the pricing works in certain exceptional situations.
Now it’s really not going to help you learn Excel for me to spend too much time going through
that but I am going to explain one or two aspects of this because they are fundamental not only in
understanding certain types of charts and terminology but you’re also going to need to know a bit
about this to do Exercise 09.
Now I’m looking here at stock prices and when you look at stock prices from various sources
surprisingly the prices are presented in really quite a consistent way. And the prices you see here
are pretty typical of what you will see.
So we have here a day by day price. There’s an opening stock price, a high reached during the
day, the low or the low point reached during the day, and the closing price. And then to the right
you have the volume, so that’s the volume of stock that was traded. And you also have
something called the Adjusted close. Now one thing I need to explain is this Adjusted Close
because as time goes by what happens is that certain events occur in the life of a stock. So either
maybe a dividend is paid or that a split occurs.
Now if a dividend is paid that means a company decides it’s doing well enough to pay a dividend
to its shareholders. But the stock market says, well if you’re doing well enough to pay that
dividend that means that your stock price was overpriced before you paid the dividend. And if I
scroll down this page to the most recent dividend, if you look at the close price on the day after
the dividend and the close price the day before the dividend was paid the price after the close and
the adjusted close are the same, but the price before the close and the adjusted close are different.
And what happens is the dividend has been deducted from the close to give the adjusted close.
So that is the overpricing element that I mentioned.
Another thing that can occur is that a company may decide to issue more stock, effectively by
splitting the stock that’s already there. So maybe there are a million shares in a company and
they decide that they want to issue another million so that there are two million in total. That
effectively halves the value of the existing shares in the company. Now I’m not going to spend
any time going through an example of a plot here, suffice to say that when we are looking at
stock prices in most situations it’s the adjusted close we use rather than the close. But usually
when you look at stock prices you’ll see both of them.
Now there is quite a bit more to it than that. For example, when this kind of adjustment is made
the high and low are adjusted as well, but they are adjusted by a factor. It’s actually a factor
adjusted close dividend. So it starts to get a bit complicated and for the purpose of understanding
this chart we don’t really need to go that far.
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Now if you’re looking at historical data on stocks there is usually some kind of Download button
or a Get Prices button that will enable you to download the data to your computer. You can often
do it by copy and paste if you want to do but I’m going to click the Download Data button.
So here’s some data I downloaded earlier today. If I want to insert a stock chart, if I go to the
Insert tab, open up my charts, go to All Charts and select Stock I basically have four options,
High/Low Close, Open High/Low Close, Volume High/Low Close, and Volume Open High/Low
Close. Now the important thing is whichever of those charts you’re going to draw to make sure
that you have the columns in the relevant order. And of course the first column in each case is
going to be the date.
Now the one that I’m going to start with is the Open High/Low Close which is the second one
just here, but I need to select my data first. So let’s just cancel out of here and I’m going to select
my data in columns A to E. Let’s go back and select our stock chart and click OK. And there is
my chart.
Now in showing this first stock chart I need to explain to you some of the symbols on stock
charts and they’re going to be quite difficult to see with the current vertical axis. So what I’m
going to do is select that and I’m going to click Format Axis. And I’m going to make the
minimum not a zero. I’m going to make it 150. Now it’s a bit easier to see those symbols and we
have what is called a Candlestick Chart.
First of all each candlestick has what I’ll call the wick, the thin line that goes through the middle
of it and that shows the range of a price on a particular day. So if you look at this particular
candlestick here the highest it reached during the day is the top of the line, the low point is the
bottom of the line. Now the candle bit or the wax bit shows the variation from open to close. If
it’s a white candle then the bottom is the opening price and the top is the close price. So in this
particular case the price closed higher than it opened. And these are referred to as you can see
there by Up Bars. And the closing price is at the top of the Up Bar and the opening price is at the
bottom of the Up Bar. If the price went down during the day and that it closed lower than it
opened the opening price is at the top of the candle wax and the closing price is at the bottom of
the candle wax. So it seems a little bit complex but that is how you can read those candlesticks.
White ones are good and the black ones are not so good.
So the next job is to create a Volume Open High/Low Close Chart. So I’m going to move this
Volume column over to be to the left of Open. So there it is and let me select all of my data. I’m
going to go back to Insert and into my charts and there is my Volume Open High/Low Close
Chart. Let me adjust the size of this a little. So I’m just going to drag it out and it’s not unusual
with this type of chart to run into a little bit of trouble with the two sets of axis, the two vertical
scales. It’s not actually wrong what’s showing there but the two do tend to crash into each other
and of course in this case because the variation in price was over quite a narrow range you can’t
really see the candlesticks very well anyway.
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There are a couple of ways that you can deal with this. One way is that you could change that
vertical axis there to make the volume bar smaller or you could change the righthand axis to
make it easier to see the individual candlesticks. So let’s do that here. And now I can see the
candles more successfully as well.
So that’s it on stock charts and now it’s time for Exercise 09. So please join me for that.
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Video: Exercise 09
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. It’s time now
for Exercise 09 and the source data for Exercise 09 are the Microsoft stock prices back to I think
to the date when Microsoft first started.
Now this information is freely available on the web, so on places like Yahoo Finance, etcetera.
So you’ll be able to download all of those prices. If in case you can’t find it or you don’t have the
facility to be able to do that the file Exercise 09.csv actually is the data downloaded and I’ve
included that in the exercise files for the course.
And just looking at this data it’s showing me day by day stock price data, adjusted closes on the
right of course, and interestingly allowing for various dividends and splits. When you go back to
the earliest of the adjusted close price they are a tiny fraction of a dollar. But we’re only
interested in about the last 20 working days. You may want to experiment with more than that.
You may want to group the data into weeks, months, etcetera and it’s a good idea to get plenty of
practice working with these various types of charts.
Now Exercise 09 actually has two parts to it and the first part is to produce a Win/Loss
Sparkline. Now I’ve got my Win/Loss Sparkline there and basically it’s plotting the difference
between adjusted closes on consecutive days. With Win/Loss if the price has gone up it’s
positive, so that’s good news. It’s a win block. If the price has gone down that’s bad news and
it’s a negative block or a loss block. And one of the things I want you to be careful of when
you’re doing this is to note the sequence because the sequence in C1 there is left to right. So the
oldest values are on the left and the newest values on the right. If you just insert a Sparkline with
the data in the normal reverse chronological order it will be the other way round. Now you could
reverse the data but I would rather you look at the Sparkline Tools Design tab options and realize
that you can actually reverse the order in which it interprets that data. So that’s the Win/Loss
Sparkline.
The final part of Exercise 09 is to plot about the last 20 workings days. Plot the prices on one of
those stock charts. Again notice it’s been a bit of an up and down story. Format it to look as
much like this one as possible but note that I have labeled the axes and also put a title in.
So that’s Exercise 09 and you’ll find my answer in the Exercise 09 Answer worksheet. But if you
would like a bit of an additional challenge you could look at the extent in which you could
automate the production of this chart and keep it up to date with the Microsoft stock price. You
could even apply the same principle to trying to keep the Sparkline up to date as well. Both of
those tasks are worth spending some additional time on.
That’s it for Exercise 09. I will see you in the next section.
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Chapter 14 – Excel Web App
Video: Introduction to Excel Web App
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In this section
and the next one we’re going to look at the Excel Web App. This is actually quite a difficult part
of the course to cover because the Excel Web App tends to change at an alarmingly quick rate
and whatever I show you in this couple of sections of the course is likely to have changed by the
time you actually come to this part of the course yourself, possibly several months after I’ve
recorded it.
So the first thing I need to explain is what the Excel Web App actually is. And that is that it’s a
facility available from Microsoft where you can edit workbooks using an internet browser rather
than using the Excel desktop program.
Now the Excel Web App does a pretty good job, as I’m hoping to show you, but the important
thing to remember is that it is a really quite restricted version of Excel. Whatever you may have
read about the Excel Web App and bearing in mind that it has improved greatly in recent times,
as you’re going to see it is still quite restricted in what you can do with it. Having said that, even
for some very advanced uses of Excel you may find it a very useful facility.
Now this is an Excel 2019 course and not an Office 365 course but you may well find that you
have access to OneDrive, Mail, Calendar online through a personal Microsoft account. So if you
have a Hotmail account or maybe a Live.com account it will give you access to the web versions
of your applications. And also a lot of the time they come with a certain amount of free
OneDrive storage. I’m not really primarily dealing with OneDrive itself, although I will be
referencing it from time to time and I will of course be storing some workbooks in it. The
important thing here is going to be Office 365 and in particular the Excel Web App.
Now at the moment I’m logged in to my Office 365 personal account and I’m looking at
OneDrive. And I have here a workbook that I created a little while ago and it’s called Opening
Hours 2018.xlsx. Now if I open that document up you’ll see that I’m now viewing it in a web
browser.
Once my spreadsheet has been opened up in a browser I have the option of making minor edits in
here. Alternatively I could click on the Open in Excel button which will open my spreadsheet in
my desktop version of Excel, the full 2019 version. I’m going to stick with editing in the browser
for the time being.
So now I can see my workbook and I can also see the ribbon that is available in the Excel Web
App.
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You’ll notice that there are less tabs on the ribbon than there are normally. One or two tabs such
as the Review tab really has quite restricted options in comparison to the desktop version. And
the View tab is also relatively considerably reduced compared to the desktop application. The
Data tab again considerably reduced. And as far as Insert is concerned there are some notable
omissions but you can for example do things like Insert Charts. And please always do remember
to bear in mind that you have this Open in Excel button that you can click on at any time if you
need to utilize functions that are not available in the web browser version.
Let’s continue to move left through the tabs. The Home tab has quite a few options on it. So we
can cut, copy and paste, we have some formatting options, AutoSum, and some reasonably
comprehensive facilities for formatting cells and so on. Where we see a big difference though is
on the File tab, the equivalent in the desktop application of Backstage View because we have an
Open facility with a list of recent documents. But if I click Save As the first thing I see is
where’s the Save button? Click here to learn about saving in Excel online. So where is the Save
button? Well there isn’t one in Excel online because your workbook is being saved
automatically. It’s actually saved at very frequent intervals. Obviously you’re working online.
There is a danger that your internet connection could get broken so it’s saved at frequent
intervals. It’s also saved with a default name. And what you can either do is use the Save As
facility to save it as a different name or you also have a Rename facility as well which will allow
you to just rename the default name of this workbook. Generally speaking you will use one or
the other of those facilities when you’re saving online.
You might also want to download a copy. So you have that option there as well.
Now the other options you can see in Excel online’s version of Backstage View is a Print option
and a Share option where you can invite other people to view or edit your workbooks. And then
you have information such as information contained in About and of course you have access to
Help here as well.
So we’ve had a little bit of a tour around the Excel Web App interface and we’re going to create
a workbook and do some work on it in the next section, but there are two or three things to show
you now.
Earlier on we looked at the View tab on the ribbon and one of the options there is Reading View.
If you switch to Reading View you no longer see the ribbon and this is the view that other users
would see if you shared this workbook with them but without giving them the ability to edit this
workbook. So they will essentially be in Read Only mode. For people who do have access to edit
this workbook we can use the Edit Workbook button and choose to open in the desktop version
of Excel or continue to edit in browser. And when you select that option you’ll see that you get
the ribbon back there with full access to the commands and functionality.
So let’s suppose I’ve been working on this opening hours 2018 workbook and I do decide to save
it to my PC. So I’m going to click on File, Save As, and I’m going to select Download a Copy.
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And if you look down in the status bar at the bottom you can see it’s downloading. And when it’s
doing that it’s essentially saving it to my Downloads folder on my PC. Of course you can move
that after the fact if you want to but that’s where it goes by default. So if I want to now open it I
can just click on my download and it will open in the desktop version of Excel. I’m going to
click Enable Editing so that I can make changes and there we go. My document is essentially
saved to my Downloads folder on my PC and I now have access to Excel’s full functionality to
make any edits to this workbook.
So you’ve just seen how to download a workbook from Excel online to your computer and open
it in Excel 2019. Let’s do the opposite now. This time I’m going to start with a workbook on the
desktop that’s got pivot tables and charts. And the thing is it’s a pretty complex workbook this
one and what I’m going to do is I’m going to save it into OneDrive. So I select File, Save As,
and then I select the OneDrive folder I want to save it into. So I’m saving it into my OneDrive
Personal and I’m going to quickly amend this name very slightly, just remove the Copy Of, and
I’m going to click Save.
Now bear in mind that when you’re saving this to OneDrive you’re not actually going to open it
in the Excel Web App automatically. And you may well just be going to save this workbook
there without any intention of opening it using the Excel Web App. But what I’m going to do
here is just close this desktop copy of Excel and I’m going to go back into my OneDrive and
when you go back into OneDrive sometimes you might need to do a refresh of the browser but it
doesn’t look like I need to do that because I can see my file sitting there in my files list in
OneDrive.
And let’s check to make sure that we can open our stored data file by clicking on it. And there is
the workbook open in the Excel Web App.
Now just because you can open it that doesn’t mean that all aspects of a workbook will work.
Some will and some won’t, depending on the current facilities available in the Excel Web App.
You certainly can’t run things like macros in the web app. So no VBA code will work. But you
can very easily save workbooks from your desktop Excel to OneDrive and from OneDrive you
can open those workbooks and subject to what the workbook contains and what you want to do
you may very well be able to work on that workbook in the web app.
So that’s a bit of a tour of the web app. In the next section we’re going to create a workbook and
just get a feel of how you work on a workbook in Excel online. That’s the next section. I will see
you then.
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Video: Using the Excel Web App
Deborah: Hello again and welcome back to our course on Excel 2019 Advanced. In the
preceding section we took a look at the Excel Web App and in particular we looked at using
workbooks that were created in the desktop version of Excel and also saving workbooks,
uploading workbooks, downloading workbooks, and so on. In this section I’m actually going to
create a workbook in the Excel Web App and talk about some of the facilities, some of the
features, as well as some of the limitations.
Now first of all I’ve logged into my Office 365 account. This is my personal one that I got with a
Hotmail account. And I’m at the login page. And the page you get when you first log in seems to
also change on a fairly frequent basis. So this is what it looks like when I log in today. Bear in
mind that depending on when you access this course what you see may look slightly different.
And one of the things that I see when I log in at the moment is this set of icons along here under
the heading Apps. And one of these icons will take me directly to Excel. So if I launch it it will
take me into Excel online with the option of creating a new workbook.
Now just before I do that let me just go back to my home page here just by clicking on the tab at
the top of my browser and note that I also have a link to OneDrive. And once I’m in OneDrive I
can open any existing workbooks but note some of the options up here on the toolbar. I have an
Upload option. So I can upload any existing documents, including an existing workbook. And I
also have some New options as well. So I could create a new folder, a new Word document,
Excel workbook, PowerPoint presentation, so on and so forth. So there are a number of ways of
getting to that point where I can create a new Excel workbook from Office 365. So let me go
back to Excel and I’m going to start with a new blank workbook.
So let’s start exploring how we can add some data into this spreadsheet and then rename our
workbook and make sure that everything is saved.
So I’m going to add some basic sample data. Having entered that data I’m now going to make a
selection. So I’m just going to drag my mouse over my data, I’m going to go to the Insert tab and
I’m going to insert a column chart. So let’s have a 2-D column chart. And there it is. Now having
created that chart you can see on the ribbon there is a Chart tools Chart tab and that gives me
many of the standard chart formatting and customizing features. So I can do things like add a
chart title, I can rename the axes, I can remove the legend or add a legend if I want to, change the
data labels, so on and so forth. You don’t get as many options as you do in the desktop version of
Excel but you get quite a few and it’s perfectly possible to make reasonably good charts through
the Excel online Web App.
Now just one other thing to do before I move on to a second workbook. Note the name of this
workbook. It’s imaginatively titled as just Book, which isn’t particularly meaningful. Now Excel
will have been regularly saving copies of this workbook as I work on it but if I want to save it
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with a more meaningful name I could go to the File tab, click on Save As and I could choose the
Rename option. And I’m going to call this Fruity Chart and click on OK. And you can now see
that my workbook has been named up at the top there.
So I’ve finished with this chart for now and I’m going to close that tab and if I go back to
OneDrive and click on the Refresh button in the browser there of course is Fruity Chart.
I’m now going to create another Excel workbook and what I’m going to do this time is to create
a workbook that uses one of the financial functions and take you through one or two of the other
key features of working with the Excel Web App.
First of all I’m just going to zoom in a bit more. So I’m going to hold down my Control key and
just use my mouse scroll wheel just to zoom in. and what I’m going to do is just put together a
little loan affordability calculator. So let me first of all type in the text prompts for the values that
need to be entered. And I can of course adjust the width of these columns.
It’s worth noting that in the Excel Web App you don’t get dialog box launchers. You do however
get contextual menus. So if I right click here I get all of my contextual menu options such as Cut,
Copy and Paste.
Now what I’m going to do is show you a little bit of cell formatting. The annual interest rate is
basically going to be a percentage figure. So in the number group here on the ribbon one of the
options is Percentage. So let’s assume that the percentage here is going to be 5%. And again I
can use my ribbon to take down those decimal places if I want to. The monthly payment we’re
able to make is €200 and I’m going to use pounds. So I’m going to go for Currency format. And
again you can modify those decimal places if you feel the need to. So we’re going to say that we
are prepared to €200 a month. The number of months, well I’m going to borrow it over five
years. So that is 60 months. And now all I need to do is calculate the amount of the loan. And the
function I’m going to use in this case is the PV function. So on the Insert tab select Function.
Now although many of these things are visually different to what you see in the desktop app very
often the function is very similar. And although you might not have quite as many options very
often things are arranged in a very similar way. So I’m going to go in and find my PV function. I
know that it is a financial function. And I also know that the functions are organized
alphabetically so I’m going to use the scroll bar to scroll down to the P section and there we have
PV. Click OK.
So let’s start entering our options. So the first argument here is rate, so we want the annual
interest rate and this is going to be a monthly loan so we do divide it by 12 as we’ve seen before
in this course. And note that you do have the familiar prompts there to remind you of which
argument to enter next. Now the number of periods that’s going to be D6 and the payment is in
D5. The future value is going to be blank so we’ll put a zero in there and it’s payments at the
beginning of the period. So a one goes into the type. Close it off and hit the Enter key and we
find that I can borrow €10,642.30.
© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved.

Learn Excel 2019 Advanced
Okay that’s almost it for me on the web app but just a couple of important things to add. One of
them is that when we uploaded the workbook with the pivot table and the pivot chart in it you
probably thought that that wouldn’t work because it appears in the Excel Web App that you can’t
actually process pivot tables and pivot charts, but there are many features in Excel that will work
in the web app but you can’t initiate in the web app.
The second thing to bear in mind is the facility to share a workbook. So for example this loan
affordability calculator I might want to share it with other people. And I can choose down here
where it says Recipients can edit, I can choose the level of access I want to give the people that
I’m sharing the workbook with. So I might just want them to be able to view the workbook or I
might want them to be able to edit that workbook.
And the third point is that if you would like a little exercise to do using the web app one very
good option is a survey. If we go to the Insert ribbon you see you have the Survey option just
here where you have the ability to create a new survey. This is one of the features of the Excel
Web App which came in very early and it’s really quite an impressive feature. So it’s definitely
giving that one a try. I’m not going through that in this course but it is a good one if you want to
experiment a little by creating your own survey and try running that on the web as well.
So that’s it for me on the web app. I will see you in the next section.
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Chapter 15 – Course Conclusion
Video: Closing Message
Deborah: Hello and welcome to this closing section in our Excel 2019 Advanced course. We’ve
covered quite a lot of features of Excel and as part of doing that hopefully I’ve given you plenty
of ideas of other aspects of Excel to continue to experiment with and explore. Excel continues to
become a bigger and bigger product and with the stretch into the Excel Web App for example it
seems to be reaching farther and farther and becoming an even more impressive and powerful
product.
I hope you enjoyed this course as much as I’ve enjoyed preparing and delivering it to you and I
hope I see you online soon.
My name is Deborah. Bye for now.
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